


Orchid EFT Processing

Getting Started
EFT Processing streamlines payment and collection processes. It transfers Sage 300 receipts and pay-
ments through to the electronic funds transfer functionality of your banking software and lets you print
and/or email remittance advices to A/P Vendors and A/R Customers.

Orchid EFT Processing includes a number of system defined file formats for a variety of banks. Additional
bank formats can be added in a user defined file.

To get started with EFT Processing, you need to install, activate and enter license details.

You can then configure EFT Processing.

Note:
EFT Processing includes a French translation if the Sage 300 user is set to French language. You don't
need any other configuration in Orchid EFT Processing.

Traitement TEF (Transferts Electroniques de Fonds)

Refer to EFT Help for more details and training guide: https://help.orch-
id.systems/sage300addons/Content/Product-Home/EFT-Processing.htm

Review details below:
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Installing EFT Processing

INSTALLATION STEPS
EFT Processing is installed by executing the EXE program downloaded for installation. InstallShield will
execute and guide you through the installation steps, including whether to install documentation.

Before you Start
Download the program installer for the version of Sage 300 you are running (only available in the
Partner area of the Orchid website).
Before installing EFT Processing, ensure that all users have logged out of Sage 300.

Installing the files
Log on to the server where Sage 300 is installed as a user with full administrator rights.
Run the previously downloaded InstallShield for the module.
If prompted to re-boot, then do so.

Tip:
Programs are installed in the Sage 300 program folder, in the ELXXA subfolder, where EL is the 2-letter
code for the Orchid module and XX depends on the Sage 300 version you are running:

Example: EL72A for Version2025 , EL73A for Version 2026.

Note: REGACC is run automatically as part of the installation process. If some files are locked during
the installation, the re-boot is required to unlock all files and complete the installation.

Important! If you install Sage 300 on each workstation, as well as the server, then you must do the
same with EFT Processing. In this case, repeat the above steps for each workstation.

Installing Web Screens
You do not need to select an option to install the web screens for EFT Processing.

For details, refer to Install EFT Web Screens on page 73

Web Screens for EFT Processing are only available if you are running Sage 300 version 2024 and above.

ACTIVATE EFT PROCESSING
Activate EFT Processing in Sage 300 Administrative Services > Data Activation.
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For details on activating modules, refer to the Sage 300 System Manager online Help (choose the Help
menu on the Sage 300 desktop) or review the chapter, Setting Up Security, in the System Manager Admin-
istrator Guide

LICENSE DETAILS
To start using EFT Processing, you need a valid serial number and license file.

If you don't have a valid license for EFT Processing, you only see the License screen.

Refer to EFT Processing License Screen on page 14 for details.

Enter License Details
The installation doesn't require a serial number anymore. You enter the serial number and activation
code in the License screen.

Note: The license applies to all the Sage 300 databases for the same installation. You only
need to enter the license details in one company.

Note: This applies to Sage 300 versions 2019 and above. You need a serial number to install
an older version.

There are two options to enter the license details:

USE A 30 DAY TRIAL LICENSE FILE
To generate a 30-day trial license file, enter the serial number provided for your module and Save the
details.

Tip: If installing with a 30 day grace period, additional re-installations will not extend the grace
period.

AFTER PURCHASING A SUBSCRIPTION OR A PERPETUAL LICENSE
If you have purchased the module, enter the serial number and activation code provided by your
Sage 300 business partner.

Tip: If installing with a 30 day grace period, additional re-installations will not extend the grace period.

UPGRADING FROM A PRIOR VERSION.
1. Download the new version install program from the Orchid website (Business Partner access only)
2. Obtain the serial number and activation code for the new version
3. Backup your existing database and programs as per Sage Upgrade guidelines
4. Execute the EXE program downloaded (as above for a new install).
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5. In Sage 300 / Administrative Services / Data Activation, Activate EFT Processing
6. Enter serial number and activation code in the EFT Processing License screen. (as above)

MINIMUM REQUIREMENTS
You need to use the same version for the core Sage 300 modules and EFT Processing. For example,
EFT Processing version 2026 requires Sage 300 System Manager version 2026.

Additional specific Sage 300 modules may be required to enable all functionality. Refer to Orchid Sys-
tems's website for details ( https://www.orchid.systems).
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EFT Processing License Screen
To start using EFT Processing, you need a valid serial number and license file.

If you don't have a valid license for EFT Processing, you only see the License screen.

LICENSE SCREEN
You use the EFT Processing license screen to enter serial number and activation code.

When to use: 
After a new installation or an upgrade to a newer version of Sage 300.
After a subscription renewal, enter the activation code with the new expiry date.
View the components of the Orchid module you are licensed for.

How to use: 
Enter the license details, click the Add button to create the license file.
Restart the Sage desktop to enable the new license.

Note: If you have multiple Sage 300 databases, you only need to enter the activation code details in
one company. When the licence details are entered on the first company, EFT Processing creates the
EL69A.lic file, which can then be read by all other companies configured on the same server.

30-day Trial Licence
If you don't have an activation code for EFT Processing, you can create a 30-day trial license.

In the License screen, enter a serial number for the module, Sage 300 version and edition you are run-
ning.

Click the Add button. This create a 30-day trial license.

VIEW EXAMPLE SCREENSHOTS
Enter a valid serial number - Serial Number depends on Module, Sage 300 Version and Edition.
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Registration successful message

License screen with 30-day trial
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*

Tip: If you install a 30-day trial, enter a valid activation code before the trial expiry date to continue
using the application.

Subscription Licenses Expiry Date
You can check the subscription expiry date and enter a new activation code after a subscription renewal
is processed.

Subscription licenses have an expiry date. To continue using EFT Processing, you will need to renew the
subscription and enter a new Activation code in the module License screen before the expiry date.

Contact your Sage 300 Business Partner for details.

Note: In the four weeks before the expiry date, users receive a warning message when logging into
Sage 300 (weekly for the first three weeks and daily in the last week). If you don't renew before the
expiry date, the software will become read-only.

TROUBLESHOOTING ACTIVATION CODE
When saving the license information, the following problems may be encountered:

Activation code Invalid – verify the registered company name (displayed during installation) and serial
number entered match the details supplied to Orchid Systems when an activation code was requested.

Invalid serial number – the entered serial number is not valid for this product, Sage 300 version and edi-
tion.

Important! If the Sage 300 Version or Edition change, a new Serial Number and activation
code must be requested from Orchid Systems.

If the company name registered with Sage changes, a new Activation Code must be requested from
Orchid Systems.
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Refer to detailed troubleshooting tips in Troubleshooting Activation Code on page 185

ACTIVATION CODE AND AVAILABLE FUNCTIONALITY
Depending on the components you are licensed to use, some features described here may not be avail-
able for you to use. Some functionality of EFT Processing is only active if you have purchased the
required module component.

The license screen displays what components of the EFT Processing module are included in the activ-
ation code.
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Tutorials
In addition to getting started steps for EFT AP/AR and EFT Payroll, you can review the EFT Processing
tutorials below to enhance the security of your implementation.

Approving changes of EFT Vendor/Customer/Employee details 19
Setup SFTP Output Destination 23
Setup and Use EFT Clearing Bank 30
Steps for Setting Up BPAY (for use in Australia) 34

APPROVING CHANGES OF EFT
VENDOR/CUSTOMER/EMPLOYEE DETAILS
You can implement separation of duties when adding and updating EFT details using Sage 300 security
groups and EFT Options. Changes to Vendor, Customer or Employee bank account details must be val-
idated by a different staff member before they take effect.

The EFT Spotlight video demonstrates two ways to implement 2-step approval in
EFT Processing.

EFT Spotlight Video: 2-step approval of EFT Vendors and EFT Customers.
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https://www.orchid.systems/resources/video/spotlight-approving-changes-eft-bank-
account-details

To implement 2-step approval:
Step 1: Set the default Status to "Entered" in EFT Options.

Note:
Status needs to be Active to use the record (EFT Vendor, Customer or Employee) in the
Create EFT File process.

A/P TAB

A/R TAB
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Step 2: Create EFT Security Groups in Sage 300 Administrative Services

Create a Security Group ENTER in Sage 300 Administrative Services, for users who can only
add/edit bank account details

Create a separate Security Group APPROVE for users who can approve bank account details.

Step 3: Assign users to the security groups,

Example: e.g. SUSAN in the ENTER group and NATHALIE in the APPROVE group

How to use
When a user (e.g. SUSAN) in the ENTER group creates a new EFT Record or updates details on the
EFT Record, the status is set to Entered. The user can't change the status.
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Only users in the APPROVE group (e.g. NATHALIE) can set the record to "Active".
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Note: Approvers can use the EFT Audit Logs (Inquiries and Reports) to see what needs approving.

SETUP SFTP OUTPUT DESTINATION

Why use SFTP?
EFT Processing provides a solid process to automate the payment process. Using SFTP (Secure File Trans-
fer Protocol) offers additional advantages when it comes to EFT (Electronic Funds Transfer) Processing.
SFTP is a secure and encrypted protocol that ensures the confidentiality and integrity of data during file
transfers.

Many EFT Processing users configure an SFTP Server to save the file before uploading it to the banking
software. Some banks provide access to an SFTP server to upload the files. You can discuss this option
with your bank.

Overview Video
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The EFT Quick Tip video demonstrates using SFTP destination with Orchid
EFT Processing for Sage 300.

EFT Quick Tip Video: Upload EFT Files to SFTP

How does it work?
With EFT Processing for Sage 300, you can automate the SFTP Transfer of the file by configuring the con-
nection details in EFT Bank. The other steps to configure and use EFT Processing are the same for all out-
put destinations.

When you create an EFT File, the file is automatically uploaded to the FTP Site.

EFT Processing supports SFTP with Key file and SFTP with Username and password. You can use both if
your bank's FTP uses 2 factor authentication.

Tip:
When using an internal FTP, many companies enforce separation of duties to further
enhance security. A common scenario can be as follows: 

User 1 creates the EFT File. User 1 does not have access to the SFTP Site
User 2 does not have access to create the EFT File, but does have access to the SFTP
Site to upload the file to the Bank
User 3 has to approve the file in the Banking Software. User 3 does not have access to
create the EFT File or to the SFTP Site.
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To setup SFTP as an output destination: 
Go to EFT Setup > Banks

Set the Output Destination and enter the required details as described below:

SFTP with Password: below

SFTP with Key File: on the next page

SFTP 2FA with Key File and User Name / Password: on page 27 if your bank uses 2 factor authentication
and requires both a username and password and a key file.

Note: This applies to the Payments and Refunds, Receipts and Payroll options. Refer to Out-
put Destination:  on page 148 in the EFT Bank setup topic.

SFTP with Password:
Output Destination: "SFTP With Password"

Host Name: IP Address or name of the FTP Server

Tip: If you are not using the default SFTP Port 22, you can add the port at the end of the
hostname, separated by : (semi-colon), for example 123.123.70.70:2222

User: User Name

Password: Password

Tip: To upload through EFT, do not use characters such as: ? = * in the password.

Upload To Folder: "/" if you are uploading to the root directory, or "/xxx" if uploading to a folder on
the FTP server.

Example: enter "/EFTFiles" to upload to the folder EFTFiles on the FTP server
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SFTP with Key File:
Output Destination: SFTP With Key File

Host Name: IP Address or name of the FTP Server

User: User Name

Key File: Full path and name of the key file

Password: Enter the Password applied to the key file. This is recommended to protect
the file, but is optional.

Important! You need to use the private key

Note:
This file needs to be in a shared directory on the server that all EFT Users who use Create EFT
File must have access to. Restrict access to users who don't create EFT Files.

If the key file is on a network share, use UNC in the file path.

Tip:
When using the EFT Processing web screens, the user configured in IIS to run the web
screens needs to have access to the key file. You can copy the key file in the Sage 300
Shared Data folder, as access to the SharedData folder is required for the web screens to
work.

Copy the full file path from File Explorer to the Key File field as there is no Browse files but-
ton on the web screens.
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Upload To Folder: "/" if you are uploading to the root directory, or "/xxx" if uploading to a folder on
the FTP server.

Example: enter "/EFTFiles" to upload to the folder EFTFiles on the FTP server

SFTP 2FA with Key File and User Name / Password:
Output Destination: "SFTP 2FA"

Host Name: IP Address or name of the FTP Server

User: User Name

User Password: Enter the user Password

Tip: To upload through EFT, do not use characters such as: ? = * in the password.

Key File: Full path and name of the key file

Important! You need to use the private key

Note: This file needs to be in a shared directory on the server that all EFT Users who use
Create EFT File must have access to. If it’s on a network share, use UNC in the file path.

Key File Password: Enter the Password applied to the key file. This is recommended to
protect the file, but is optional.

Upload To Folder: "/" if you are uploading to the root directory, or "/xxx" if uploading to a folder on
the FTP server.

Example: enter "/EFTFiles" to upload to the folder EFTFiles on the FTP server
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Key file setup Tips
Note: This applies to both SFTP with Key File and SFTP 2FA

SSH keys are made up of two keys - a public key and a private key.

The file name for the public key is *.pub. You upload the public key to the FTP server (e.g. the bank's FTP
site or your FTP Site).

You upload the private key to the FTP client (e.g. the Sage 300 Server)

You need to use an OpenSSH key using the RSA format.

The Header & Footer row should look like this:

-----BEGIN RSA PRIVATE KEY-----

MIIEoQIBAAKCAQEAo962U1qVeERjyfoMIwam3h+17Ei9Ddetm8UysRNOHv3ZI3YF

....

AUx+RYObNhAZ7z54RqyOMO+YXIRob0b7JXv/XpusA+BBA1eE/w==

-----END RSA PRIVATE KEY-----
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Tip:
Using PuTTY Key Generator to generate the private key

Testing the FTP Configuration
You can use the Test SFTP File Upload button to test the EFT Bank configuration without having
to create an EFT File.

If successful, EFT Processing displays a File uploaded message.
If unsuccessful, EFT Processing displays an error message and creates a log file in the user's tem-
porary folder. The default path for the test file cannot be changed.

Review the log file and check the details you have entered.

Tip: One of the most common error when using SFTP with key file is to use the wrong key
file or a key file in the wrong format. See Key file setup Tips on the previous page
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Tip: If unsuccessful, we recommend you install an FTP client, for example Filezilla, on the
workstation where you will be running "Create EFT File". You can then use the FTP client to
test the credentials you are using, and upload a test file to the required folder. If it works
with an FTP client, but not with EFT Processing, contact your Sage 300 partner for support.

SETUP AND USE EFT CLEARING BANK

When to use a Clearing Bank in EFT Processing A/P
When posting a batch of payments in AP, the individual payments go onto the Bank Reconciliation in
Bank Services. Many banks show EFT Payments in total on the bank statement. While all the payments
can be reconciled in "one hit" using the payment reference number, it is often easier to reconcile if the
total of the payment batch is reflected on the Bank Services statement.

How does it work?

If you would like the AP Payment batch to post to Bank Services "in total", you can set up your EFT Bank
as a "Clearing" bank type, and link it to the actual bank account, as shown below.

When you post your AP Payment batch against a Common Services Bank which has been configured in
EFT Banks as a "Clearing" bank type (EFTCLEAR in the screen shot below), EFT Processing will auto-
matically create a bank transfer between the EFT Clearing bank (EFTCLEAR) and the actual bank account
(CCB in the screen shot below) and post the bank transfer.

Other scenarios to use clearing banks

While clearing bank is primarily used to post to Bank Services in Total, it can also be used to enable dif-
ferent bank settings (such as folder, file name and EFT File type) for the same bank.
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Examples:
The client is using Orchid EFT Processing to generate the EFT Direct payment file and Pos-
itive Payment file.

This configuration can be used to set up a bank for EFT and one for BPAY to set up pro-
cessing for BPAY in Australia.

Similar configuration can be used if you process domestic and international payments from
the same bank.

Clearing bank Setup

The EFT video (minute 37:56) explains how to use clearing banks in EFT Processing for
Sage 300.

EFT Tips Video: how to configure and use clearing banks

The Clearing Bank and the regular bank are both created in Bank Services.
If you choose "Clearing Bank" for the EFT Bank Type– you have to select the Bank for which this
clearing account is for on the EFT Banks setup screen. (Refer to For Bank on page 147 in the
EFT Bank Setup Screen).
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Note:
If your company uses Multi-currency, In Bank Services, Banks Options > Processing, check
that the Transfer Adjustment G/L Account is configured correctly.

If it is blank, you will receive an error message when creating an EFT file for the clearing bank
and the transfer will not be created: 

Transfer Adjustment GL Acct cannot be blank.

Processing A/P Payments:
1. When the user creates an AP Payment batch, they select the EFT Clearing Bank as the bank for the
batch.

2. When the payment batch is posted, EFT Processing automatically creates a bank transfer, making a
drawing in the actual bank account and a deposit to the EFT Clearing Bank.

3. Bank reconciliations are performed as usual using the regular Bank in Bank Services - the EFT clearing
bank account will be used for reversals or single line reconciliations only.
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Note:
EFT clearing account balance should always be 0.00.

Payments in the EFT clearing will always be available to be reversed as that account will never be recon-
ciled and posted.

Note:
Clearing bank is only available with EFT AP Payments. It is not available with AR Receipts or Payroll
transactions.

In Accounts Receivable, you can choose whether or not Deposits are posted to the bank as one entry
or individual entries. The "clearing bank" feature is not relevant for AR Receipts. You must post AR
Receipt batches to the regular bank account, and set up the EFT File Type on the regular bank account
in EFT Banks.
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STEPS FOR SETTING UP BPAY (FOR USE IN AUSTRALIA)
Note: When processing the AP payments you will need to have to SEPARATE batches for EFT pay-
ments and BPAY payments.

Your payments would most probably be a combination of EFT and BPAY payments so you will need the
following setup:

In EFT Setup > Options > AP Tab > Check the box that says “Allow multiple banks for vendors”

Save the changes

In EFT Vendors > select the Vendor number

Select the File Type to be the BPAY format

Enter the relevant details and save / add your changes
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EFT Getting Started
To get started with EFT Processing, follow the steps below

Steps for Setting Up EFT Processing 37
Steps for Setting Up EFT Payroll 38
Gathering EFT Processing Data 38
Adding Security 40
EFT Security Features 44
Assigning Visual Process Flows 48
Upgrading EFT Processing Key Steps 49

STEPS FOR SETTING UP EFT PROCESSING
This topic lists the steps for setting up a new EFT Processing system

Step 1: Gather your existing EFT Processing data.

Step 2: Add security information.

Step 3: Assigning Visual Process Flows

Step 4: Specify Options

Step 5: Add Bank setup records.

To process A/P Payments to Vendors
Step 1: Add Vendor setup records.

If using EFT Processing with A/R Customers
Required only to process A/R Direct debit or refunds to customers with EFT Processing.

Step 1: Add Customer setup records.

Step 2: Configure EFT Receipt Selection codes.

Configure Emails and forms
This is required to print and email Remittance Advices to Vendors and Customers.

Step 1: Add Messages Records.
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Step 2: Design EFT Processing forms.

Upgrade Steps
If upgrading from prior version, check the user formats and custom forms, Upgrading EFT Processing Key
Steps on page 49

Optional, If using Sage 300 Web Screens
This can be done for a new or existing implementation.

Step 1: Install EFT Web Screens. Refer to Install EFT Web Screens on page 73.

STEPS FOR SETTING UP EFT PAYROLL
This topic lists the steps for setting up a new EFT Processing system for EFT Payroll.

Note: If you are already using EFT Processing for A/P and/or A/R, some steps may have been com-
pleted previously.

Step 1: Adding Security on page 40.

Step 2: Configure EFT Options: EFT Options on page 52

Step 3: Configure Bank/banks where the EFT payments will be generated from: EFT Banks Form - Over-
view on page 60

Step 4: Configure Employee Bank details: EFT Employees on page 64

Step 5: Optionally, configure Email Messages to send advices to employees: Email Messages Setup on
page 66

Step 6: Optionally, update the EFT  Payroll Advice form. Designing EFT Processing Forms on page 71

Tip: If upgrading from prior version, check the user formats and custom forms, Upgrading
EFT Processing Key Steps on page 49

Note:
EFT Payroll does not support CP/UP "Selection List" employee level security. Create EFT File, Print EFT
Remittance Advice and the EFT Payroll Log show all employees net pay details.

GATHERING EFT PROCESSING DATA
After you activate EFT Processing in Sage 300, you must add the data about your bank, vendors , cus-
tomers and employees.
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Bank specifications for the file format.
Company specific details, such as account number and transaction references.
Determine where to save the EFT Files and how to upload.

Vendors bank details

if using EFT Processing for vendor payments.

Customer bank details and agreement to debit their accounts

if using EFT Processing for direct debit files or customer refunds.

Employee bank details

if using EFT Processing for Payroll payments (with Canadian or US Payroll).

Sage 300 System Manager Company name

used to validate EFT Processing licence.
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Importing data
You can export from your company's existing system to import into EFT processing.
You may be able to import EFT Processing Setup data. Refer to Sage 300 documentation for gen-
eral steps to import in Sage 300.
See Importing EFT Details on page 68

Security considerations
Review the security features options you want to implement in EFT Processing. EFT Security Features on
page 44

ADDING SECURITY
If your Sage 300 system requires user passwords and security profiles, you need to assign user security to
EFT Processing forms.

Assigning EFT Processing security

Using the Security Groups form in the Administrative Services folder, you can assign the following secur-
ity tasks to EFT Processing. You can then assign Sage 300 users to the appropriate Security Groups.
Details below apply to EFT Processing (A/P and A/R) and EFT Processing (Payroll).

Bank EFT Setup – add/modify/delete EFT Bank details

View Vendor EFT Details Setup – only view the EFT Vendor’s setup

View Customer EFT Details Setup – only view the EFT Customer’s details

EFT A/P transactions – create EFT Files for AP Payment batches

EFT A/R transactions – create EFT Files for AR Receipt batches

Transaction & Setup Reports – can run EFT Transaction and Setup Reports. We don't have dif-
ferent security groups for each report group.

Tip:
If you want to prevent certain users from running some reports, they can create a UI Profile
and apply it to the user.

E.g. Create a UI Profile and hide the Print Button or any other look-up field that they don't
want the user to see and apply it to the user.

User still sees the icon, but they can't run the report.

EFT E-Mail Message Setup – can maintain EFT Email Message Templates
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Approve/View Unencrypted Vendor Bank Details - set a Vendor's Bank details to Act-
ive/Inactive and view unencrypted Vendors bank account details. Can only update the Active field, can-
not update other Vendor bank details.

Approve Customer/View Unencrypted Bank Details - set a Customer's Bank details to Act-
ive/Inactive and view unencrypted Customers bank account details. Can only update the Active field, can-
not update other Customer bank details.

Options – add/modify EFT Options

View Audit Log – can view the audit log of changes to EFT Vendors & Customers details

Clear Audit Log – can view and clear the audit log of changes to EFT Vendors & Customers details

View EFT Log – can view the audit log of EFT Files created

Clear EFT Log – can view and clear the audit log of EFT Files created

Create Receipt Batch – can run EFT Create Receipt/Refund Batch

Select Remittance Advice Layout – can choose a different EFT Remittance advice at the time of
running

Edit Vendor EFT Details Setup – add/modify/delete EFT Vendor setup details.

Edit Customer EFT Details Setup – Add/modify/view EFT Customer setup details.

Receipt Selection Code Setup – can create and amend Receipt/Refund Selection Codes

Amend Receipt Exclusions – can amend Create Receipt Batch Customer/Document exclusion list

Update Invoice Due Dates – can update Invoice Due Dates

Delete Inactive Records – can run Period End Processing – purge inactive EFT Vendor and EFT
Customer records

View Unencrypted Bank Account Details – view EFT Banks unencrypted bank account details

Edit Vendor Remittance Password - can view& edit unencrypted vendor remittance password

Edit Customer Remittance Password - can view& edit unencrypted customer remittance pass-
word

EFT Payroll Security Groups
If you have an activation code for EFT Processing (Payroll), you can also select:

View Employee EFT Details Setup - only view the EFT Employees’s setup

Approve/View Unencrypted Employee Bank Account Details - set Employee's Bank details
to Active/Inactive and view unencrypted Employees bank account details. Can only update the Active
field, cannot update other Employee details.

Edit Employee EFT Details Setup - add/modify/delete EFT Employee setup details.

EFT Payroll Transactions - Create EFT Files for Payroll entries.

View Payroll EFT Log – can view the audit log of Payroll EFT Files created

Clear Payroll EFT Log – can view and clear the audit log of Payroll EFT Files created
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Payroll Transaction & Setup Reports - can run Payroll reports

Edit Employee Remittance Password - can view& edit unencrypted employee remittance pass-
word

Print/Email Payroll Stubs/slips - Security group required to be able to Print/Email paystub-
s/payslips in EFT Payroll.

Tip: If you want a user to View unencrypted details and be able to Edit details, you need to select both
Approve/View Unencrypted Vendor Bank Details" and "Edit Vendor EFT details Setup". Same with Cus-
tomer and Employee Bank Details.

Note:
EFT Payroll does not support CP/UP "Selection List" employee level security. Create EFT File, Print EFT
Remittance Advice and the EFT Payroll Log show all employees net pay details.

Recreate EFT Files

Select this option for users who can recreate an EFT File for a batch that has already been exported.

Tip: Only add a few users to a security group that can recreate files.
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Tips:
For information on activating security and setting up security groups, refer to the System Manager
online Help (choose the Help menu on the Sage 300 desktop)

If you want users to be able to change the print destination, permission to Change Print Destination
must be assigned from the Administrative Services permissions list in the Security Groups form.
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EFT SECURITY FEATURES
In addition to Sage 300 security settings, EFT Processing includes numerous features that strengthen
your payment processes.

Sage Security Considerations
Limit access to information in Sage 300 by creating Security Groups with User Authorizations.
Consider using Sage UI Profile Maintenance to customize what is visible on the Sage 300 screens.
There is also standard Sage 300 security on EFT records to prevent some users from updating bank
details. Refer to Adding Security on page 40.

Audit logging
Audit logging is enabled in EFT Processing out of the box.

Details of any changes to Vendor/Customer/Employee records are recorded in an audit log, includ-
ing the Sage 300 user who did the change.
There is also a detailed audit log of EFT Files created, including the account details in the file and if
records were skipped.

Tip: Audit log inquiries and audit log reports should be reviewed periodically.

Approving changes of EFT Vendor/Customer/Employee details:
You can implement separation of duties when adding and updating EFT details using Sage 300 security
groups and EFT Options. Changes to Vendor, Customer or Employee bank account details must be val-
idated by a different staff member before they take effect.

To implement 2-step approval, set the Default Status in EFT Options to Entered.

Refer to Approving changes of EFT Vendor/Customer/Employee details on page 19
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EFT Options
Some EFT Options relating to EFT Vendors, Customers and Employees enhance the security of the pay-
ment processes:

Bank account number encryption:
Account numbers are stored in encrypted form, and masked when displayed. By default, users only see
the last 4 characters of the account number. This applies to Sage 300 data entry screens and reports.

Only users who are in the Approve/View Unencrypted Vendor Bank Details can see the
account numbers in full, unencrypted. Same applies to Customers and Employees.

Note: The Sage 300 ADMIN user can view unencrypted values.

Refer to EFT Options Screen Guide on page 113 and Adding Security on page 40 for details.

Password protect emailed Remittance Advices
EFT Processing includes the option to password the PDF with remittance details attached to emails.

Refer to the following topics for additional details: 

Using password to protect Remittance Advices for Vendors on page 90

Using password to protect Remittance Advices for Customers on page 91

Using password to protect Payroll Advices and other Payroll PDF for Employees on page 103
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File security
File output destination
You need to use Network security to protect the file that is created. In many cases, the user who has
rights to create the EFT File in EFT Processing doesn't have access to upload and approve the file in the
banking software.

Using SFTP
Many people create an FTP site - where the person creating EFT files has no access. Only the users who
upload the file to the banking software have access to the FTP Site.

You can configure the EFT Banks to send the EFT files using SFTP, with a password or a key file.

Refer to Setup SFTP Output Destination on page 23 and the EFT Banks screen guide for details.

Note: Some banks provide access to their SFTP site, and EFT Processing can upload to the
SFTP site, without users having to upload the file manually.
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File format
Many file formats include security features, so it is also hard (but not impossible) to change the file
without the file becoming invalid. Discuss the options with your particular bank.

Examples

Control totals pertaining to the number of rows, total value of debits, total value of credits.
Other banks actually contain a hash total on the amounts. If you were to edit the file manually,
unless you knew the formula, the file would be rejected by the bank.

Note: In the latest updates, EFT Processing supports encryption using the MD5 algorithm as
well as the SHA-256 algorithm.

More recently, some EFT file formats also include ‘security question & answer’ fields that require
encryption at the time of file creation. They are also supported in EFT Processing.

Banking software security

The banking software which imports EFT files usually has levels of security and authority levels which can
be defined. Typically the cheque signatories would be given the “approval” level. So instead of reviewing
the source documentation and signing cheques, as they would have done in the past, approvers review
the source documentation and approve the EFT transfer.

This ensures that only approved payments are made and that the banking system reflects what went
through Sage 300 (Accpac).

Positive Pay for check payments:

EFT Processing supports Positive Pay files. Transitioning from paper cheques to secure electronic pay-
ments removes the opportunity for cheque fraud. Where payment by paper cheque is still required, EFT
Processing can still help reduce the risk of cheque fraud by generating ‘Positive Pay’ files for participating
banks. (The bank won’t honour presented cheques unless they match details on these files.)

Tip:
A Positive Pay Format is a file format for check payments where the bank requires a file that contains
the check number, check date, amount, and vendor name. EFT Processing supports a number of Pos-
itive Pay file formats for various banks.

Refer to Using EFT Processing in Sage 300 to create a Positive Pay file
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Advanced options
You can also consider using Extender for more advanced encryption and approval options.

Refer to EFT & Other Orchid Modules

ASSIGNING VISUAL PROCESS FLOWS
Overview

Use the Assign Visual Process Flows screen in the Administrative Services folder to assign process flows
to users.

Tip: You need to do this in all companies and for all users who need access to the Process Flows,
including ADMIN.
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Note: Only the ADMIN user and users who have the required security authorization can assign process
flows. For more information about security authorization, see "Administrative Services Security" in the
System Manager help.

UPGRADING EFT PROCESSING KEY STEPS

Install and Activate
After installing the new version of Sage 300 System Manager and relevant modules (for the version you
are upgrading to):

Step 1: Run the EFT Processing installation program for the same version as the System Manager ver-
sion.

Step 2: Refer to Installing EFT Processing on page 11

Example: If you upgrade from Sage 300 version 2025 to version 2026, you need to install
EFT Processing version 2026. This will create EL73A folder in your Sage program directory.

Step 3: Follow the prompts to confirm the file location of the Sage 300 programs and shared data dir-
ectory (these should be defaulted from the earlier Sage 300 System Manager installation).

Step 4: Activate the new version in Sage 300 Administrative Services.

Step 5: Enter the Serial Number and Activation Code in the EFT Processing License Screen.

User formats
Step 1: Transfer the custom format to the new version (or new server):

Locate the userformats.ini file in the Sage 300 programs directory, or customization dir-
ectory, in the previous version or old server.

Copy it over to the ELXXA directory in the programs directory (or customization directory if
you are using customization directories).

Example: If you are upgrading from version 2025 to version 2026, you need to copy the
files from EL72A to the EL73A folder.

Step 2: Generate a test EFT File and compare the output to a file generated with a previous version.
Investigate discrepancies.
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Tip:
If there is no userformats.ini file, then the customization must have been done in the formats.ini file. In
prior versions, it was possible although not recommended as changes can be overwritten when
installing a product update.

In the latest product updates, the formats.ini file includes a hash calculation to ensure the file is not
tampered with. If the file is amended in anyway, it cannot be used in Create EFT File and you will
receive an error message.

In this case:

Open up the old formats.ini file
Locate the file format used by your client (e.g. CAN_RBCACH)
Copy the format section into a new text file called userformats.ini
Save this file into the EL73A program (or customization) directory as required

Custom Forms
If you use Custom Forms for remittance advices, copy them to the new ELxxA>ENG folder or the cus-
tomization directory.

Test the custom layout.

Note: It is often a good idea to redo customisations to the Crystal Report forms (such as adding your
company logo) based on the latest version of the sample remittance advice reports as new versions
and product updates often include updates to the Crystal Reports. Some updated Reports include new
parameters that need to be included in your custom reports.

Emailing
If the upgrade is done on a new server, you may need to adjust the details used to send emails.

It is recommended to send a test email in EFT Options and test the emailing process.

Payroll upgrade tips
In addition to the steps above, we recommend you test the emailing payslip process based on the latest
C/P or U/P report.

In the test database:

Copy the previous payslip report to the new version's directory (or redo changes based on the new
default Sage 300 report.
Export a range of EFT Employee email address
Import a tester's email address
Run the Print Payroll Payslip process.
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Check the email subject and body , the attached PDF Content.
Confirm that the PDF password matches the formula/employee password
Re-import the EFT Employee email address
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Setup EFT
EFT processing requires to setup Bank details, EFT Vendor details to process A/P Payments, EFT Cus-
tomer details to process A/R Receipt / Direct debits and A/R Refunds, and Message templates to email
remittance advices.

EFT Options 52
EFT Processing Email Tab 56
EFT Banks Form - Overview 60
EFT Vendors Overview 61
EFT Customers Form 63
EFT Employees 64
EFT Setup - Receipt/Refund Selection Codes 65
Email Messages Setup 66
Importing EFT Details 68
Designing EFT Processing Forms 71

Warning!
After the initial setup, you can change any of the selections and information you entered in
the Options form.
Before changing any of the settings or other information in the EFT Banks form, make sure
you understand the impact the options have on processing with your Bank.

EFT OPTIONS
BEFORE YOU START

Before setting up EFT Processing (A/P and A/R), gather vendors and customers bank details and
email addresses to send advices.

Before setting up EFT Processing (Payroll), gather employee bank details and email addresses to
send advices.

Overview
On the EFT Processing Options screen, you can select options that specify how EFT files are generated
and how documents are emailed.

For details on each Tab, EFT Options
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A/P Tab
For details, A/P Tab Fields and Controls on page 114

Select whether an EFT file can be created for a range of AP Payment batches.
Allow unposted AP Payment batches to be selected.
Select whether or not payments for Vendors not defined in EFT Processing are skipped without
generating an error.
Make selective payments from an AP Payment batch.
Select whether a File Sequence Number or Batch Number is used when creating the output file
Select default EFT Vendor status
Select whether to encrypt Bank details.
Select whether and how to password protect remittance advices.

A/P Email Tab
For details, A/P Email Tab on page 116

Define the name of a SMTP server and associated e-mail user, password etc to send Remittance advices
using SMTP.

If details are left blank, EFT Processing will use Microsoft Outlook client or SMTP e-mail depending on
how Sage 300 System Manager is configured.

Refer to EFT Processing Email Tab on page 56 for details on the fields and examples of
SMTP configuration.

A/R Tab
For details, A/R Tab Fields and controls on page 118

Select whether an EFT file can be created for a range of AR Receipt batches.
Allow unposted AR Receipt batches to be selected.
Select whether or not receipts  for Customers not defined in EFT Processing are skipped without
generating an error.
Make selective receipts from an AR Receipt batch.
Select whether a File Sequence Number or Batch Number is used when creating the output file
Select whether to encrypt Bank details.
Select whether and how to password protect remittance advices.

A/R Email Tab
For details, EFT Options Screen Guide on page 113
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Define the name of a SMTP server and associated e-mail user, password etc to send direct debit advices,
refund advices using SMTP.

If details are left blank and the SMTP Details are filled in EFT Options > A/P Email, EFT Processing will use
the EFT A/P Email details.

If both A/P Email and A/R Email details are blank, EFT Processing will use the Sage 300 System Manager
configuration.

Refer to EFT Processing Email Tab on page 56 for details on the fields and examples of
SMTP configuration.

Primary File Type
For details, Primary File Type Tab Fields and Controls on page 121

Select the primary bank file type for this company.  It is used to display fields on the EFT Vendor and Cus-
tomer screens.

Using a primary bank, field names can be tailored to the bank and optional extra fields can be enabled
for Vendors, Customers and Employees.

Default Advice Tab
For details, Default Advice Fields and Controls on page 123

This tab lets you define default Crystal reports for advices and reports generated in EFT Processing,
including AP Remittance advice, AR Direct Debit advice, AR Refund Remittance Advice, Payroll Remit-
tance advice, Payroll Payslip/Paystub report, Payroll Releve 1 and T 4 reports.

If you define default reports on this tab, then when printing remittance advices, the forms will default to
those setup on this tab.  If a user does not have the security to "Select Remittance Advice Layout", then
they will not be able to override this default.

To set one of the defaults, click the browse button and browse the network to find the appropriate Crys-
tal form.

Use this tab to select the Print Directory where Payslips / Paystubs are stored if required.

Forms can be selected from the standard Crystal report forms included in EFT Processing. If required, you
can also design your own form as per standard Sage 300 functionality.

Payroll Tab
For details, Payroll Tab Fields and Controls on page 125

Select whether an EFT file can be created for a single Payroll Pay period or from a range of payroll
Pay periods.
Select whether or not payments for Employees not defined in EFT Payroll are skipped without gen-
erating an error.
Make selective payments from a Payroll Pay Period.
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Select the default employee record status for new records.
Select the default primary bank for EFT Payroll files. If blank on the Employee setup, then the
EFT file type defined in EFT Options will be used in formatting the EFT Employee screen.
Select whether to encrypt Bank details.
Select whether and how to password protect remittance advices.

Payroll Email Tab
Use the Payroll Email Tab to define the service and related details used to email payroll advices.

For details, Payroll Email Tab field and controls on page 127

Note:
If details are left blank and the SMTP Details are filled in EFT Options > A/P Email, EFT Processing will
use the EFT A/P Email details.

If both A/P Email and Payroll Email details are blank, EFT Processing will use the Sage 300
System Manager configuration.

Refer to EFT Processing Email Tab on the next page for details on the fields and examples of
SMTP configuration.

Global FSN Tab
For details, Global FSN Fields and Controls on page 125

This tab allows you to assign a Global File Sequence Number (FSN) across all EFT banks.

The Global FSN setup is used if you want to issue a single File System Number across multiple banks. You
have 10 Global File System Numbers that you can allocate to multiple banks on the EFT Banks screen as
shown below. Allocating the same Global File System Number to 3 banks (for example), will result in AP
Payment Batches or AR Receipt batches from all 3 banks being allocated a sequential number from the
same source number. 

Updates Tab
NOTIFY ME WHEN THERE ARE NEW UPDATES IN EFT PROCESSING

Users can now "subscribe" to notifications of updates.

By Default, this option is not selected for end-user serial numbers

The check is stored in the registry and it applies to this Windows user on this computer.

If selected, when starting Sage it will check if there are product updates available for EFT Processing

If there is a new update, and the user hasn't previously been notified of it, then the Options screen
will open automatically on the Updates tab and display details of the new updates.
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Tip: The “administrator” or “super user” or “owner” of Sage 300 should have this option
turned on. All other users should have it turned off.

CHECK FOR UPDATES AND SUPPORT REQUESTS
You can use "Check for Updates" button to view the list of new features and fixes.

To facilitate support, please include the Version and Product Updates you are running when report-
ing any issues.

Updates are available to be downloaded from the partner area of the Orchid website Product down-
loads. 

Note:
If you cannot view the Tab you require, check your activation code and which components of the mod-
ule have been purchased.

Depending on the components you are licensed to use, some features described here may not be avail-
able for you to use. Some functionality of EFT Processing is only active if you have purchased the
required module component.

The license screen displays what components of the EFT Processing module are included in the activ-
ation code.

EFT PROCESSING EMAIL TAB
The Email tab lets you define your email server. When you fill in the email option on the EFT Processing
Options, it will email directly to your email server using the selected service. You can email documents
using 2 methods, SMTP with basic authentication or App password or Microsoft Graph (when using
Microsoft Office 365 and SMTP basic authentication is not enabled).

Email Service

SMTP (Simple Mail Transfer Protocol). You can use your own SMTP server, or an SMTP ser-
vice.

Example: SMTP Email Examples on page 128

Microsoft Graph. This service sends email via Microsoft Office 365. It is generally used when
SMTP Basic authentication is not enabled in Office 365.

Refer to Office 365 and Microsoft Graph

Note: Microsoft Graph is available in the latest product updates for Sage 300 versions 2020
and above, since October 2022.

Page 56 of 224 Setup EFT

https://www.orchid.systems/resources/downloads
https://www.orchid.systems/resources/downloads
../../../../../../Content/Shared/ModuleOptions/Office365-MSGraph.htm


Orchid EFT Processing

If you leave the SMTP details blank in EFT Processing> Options Tab, the Sage 300 default way of sending
emails will be used. Refer to Using Sage Company Profile Settings on the next page. However, the pro-
gram cannot verify that the email has been sent and cannot report the number of emails sent. If you
want to use the ability to password protect the PDF attached to emails in EFT Processing, you need to
configure SMTP details in EFT Options.

Email Field details
Select the Service you want to use to email: 

Basic Authentication SMTP:

Email Server : smtp.domain.com:587 Enter the details of the SMTP Server you want to
email from.

Port: There is no specific field for the Port in Orchid modules. You can specify a port number
after filling in the email server details.  After the email server name, enter “:xx” i.e. colon  xx
where xx is the port number required.

Tip: The default port is generally port 587 with TLS.

Example: smtp.office365.com:587

Email User and Email Password: Enter a correct combination of Email user and pass-

word

Note: If using multi-factor authentication and App password, enter the App pass-
word you create in he Email Password field. Refer to Using Orchid Modules with
Office365 App Passwords on page 131

Email Comes From: Enter the email address to be used when sending email.

Example: Orchid.Systems.Modules@gmail.com . You can also enter it in the
format {name} <{address}> e.g. Orchid Systems <Orchid.Sys-
tems.Modules@gmail.com>

Note: Depending on the SMTP server you use, this address may need to
match the one you enter in the Username field, or may not work unless
you set up an email alias. Consult your SMTP server documentation for
details about sending email.

Microsoft Graph:

This service sends email via Microsoft Office 365 where basic authentication is not enabled to use SMTP.

Refer to Office 365 and Microsoft Graph
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Tenant ID. Enter the tenant ID (alternatively called the directory ID) from your Microsoft 365
account.

Client ID. Enter the client ID (alternatively called the application ID) from your Microsoft 365
account.

Client Secret. Enter the client secret from your Microsoft 365 account.

Tip: This is actually the secret value, not the one called Secret ID. It is the one that
you only see once when you first create the client secret.

Tip: The client secret is valid for 2 years maximum. You may need to create a new
client secret if emailing with MS Graph suddenly stops working.

From Email Address. Enter the email address to be used when sending email.

Send Email copy

In EFT Processing, if you are using the SMTP Email option, you can use the cc or bcc option on the EFT
Options > AP and AR email tab if you want a copy of the emailed remittance advice in Outlook.

Examples
Refer to the examples below for detailed settings with commonly used mail providers, such as Office 365
and Gmail.

Example: SMTP Email Examples on page 128

Using Sage Company Profile Settings

Using Sage Company Profile details

If you leave the SMTP details blank in EFT Processing> Options Tab, the Sage 300 default way of sending
emails will be used. However, the program cannot verify that the email has been sent and cannot report
the number of emails sent.

It will use SMTP or Microsoft Graph depending on the option selected on the Company Profile,
If the details are not filled in, it will use Microsoft Outlook if installed on the client machine.

For more details, refer to Emailing from Sage 300 in Sage 300 documentation.
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Important!
If you want to use the ability to password protect the PDF attached to emails in EFT Processing, you
need to use EFT's SMTP options.

Similarly, if you want to save a copy of the Payslip/paystub in the directory configured on the EFT
Setup> Options > Default Advice Tab, you need to fill in the A/P Email or the Payroll Email SMTP
details. If emails are sent using default Sage's configuration through Outlook, a copy of the file will not
be saved.

Limit per Session/Minute
Configure limits when sending emails: (None / Per Minute / Per Session)

If you are getting errors relating to "exceeding limits" when sending email remittance advice, you can
configure the options to Number of emails per minutes or Number of emails per session to match the
requirements of your email server.

Defaults to "None".
Choose Per Minute if your email server has a limit per minute when sending
SMTP emails (e.g. Office 365).
Choose Per Session if your email server has a limit per session.
Enter the number of emails to send per minute or per session.

How does it work?

When printing Advices and if the number of advices is greater than the limit, EFT will send the number
entered in the limit, then pause if "per minute" is selected or Disconnect and start a new session if using
"Per session" is selected.

Example: Limit per minute: If you set the limit to 30 per minute and you email 50 remittance advices,
EFT Processing will send the first 30, pause for a minute, send the next 20, and will then display the res-
ult.

Example: Limit per session: If you set the limit per session to 10 and you select to Print/Email a batch
of 50 remittance advices, EFT Processing will make a connection to the SMTP Server, send 10 emails (1
to 10), disconnect, then reconnect, send the next 10 emails (11 to 20), disconnect, connect again, send
the next 10 emails (21 to 30), disconnect, etc. When all emails are sent, it will display the delivery res-
ults.

Note: If you set the number of emails to 0 (per minute or per session), the emails will be
sent with no limits (the same way as with the "None" option)

Troubleshooting Sending emails
Email Troubleshooting on page 140
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EFT BANKS FORM - OVERVIEW
Use this form to setup EFT details for the banks setup in Sage 300 Bank Services.

Note: The field labels are renamed for different banks depending on the bank formats setup in Format-
s.ini, when the file type is selected on the Payments and Refunds Tab, Receipts Tab or the Payroll Tab

Choose the Bank (using the Finder or the Arrows)
Enter the Bank Details -
Bank/Branch Code, this should be the BIC/Swift bank code, usually 8 to 11 characters.
Account Number and Account Name
IBAN Code, this is the International Banking Account Number – up to 34 characters. (typically
required for payments to Europe)
Additional / configurable fields for the bank: e.g. in Canada: Destination Data Centre
and Short Name.

See Also

If using a clearing bank to facilitate bank reconciliation, refer to Setup and Use EFT Clearing Bank on
page 30.

If you upload the file to a FTP Site (yours or one provided by the bank), Setup SFTP Output Destination
on page 23.

For details on how to use each field, view EFT Banks Setup Screen on page 146

Payments and Refunds Tab
Use this Tab to configure how EFT Processing creates files for Payments and Refunds, including the out-
put destination, the file type, how to name the file

File Sequence Number: the file will be called the File Sequence number on the bank, and after using
the file sequence number, EFT Processing will increase the file sequence number by 1.

Note: If the EFT File format includes the File Sequence Number, you generally select the
"File Sequence Number" option to name the file. If you select Batch Numbering to name the
file, EFT Processing uses the batch number as the [FSN] value.

Batch Number : the file will be called APbbbb.{ext} or ARbbbb.{ext} where bbbb is the batch number
being exported.

Pay Period End Date YYYYMMDD: for EFT Payroll files

Fixed File Name : User defined file name using any characters plus the following variables in the file
name :
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{yyyy} for the year, {mm} for the Month, {dd} for the Day
{bbbb} up to 4 numbers for the batch number
{N} gives you a running number starting from 0 each day. This is often used in conjunction with
batch number to keep track of the number of exports in a calendar day.
{S} gives you a running sequence number for the selected bank- You can use up to 4 numbers for
the file sequence number. You typically use this option instead of batch number for a unique num-
ber per file.
{entry} for the entry number, this works with option that each entry to be generated in a single file.

Example: You can use up to 4 digits for {B}, {S} and {N}
Example for Batch Number 2
{b} for 1 digit, e.g. 2
{bb} for 2 digits, e.g. 02
{bbb} for 3 digits, e.g. 002
{bbbb} for 4 digits, e.g. 0002

Global Sequence 1..10. You are able to share a Global File Sequence number between multiple
banks if required. EFT Processing will increase the global file sequence number used by one after cre-
ating the file.

Note: If the EFT File format includes the Global File Sequence Number, you need to select the "Global
File Sequence Number" option to name the file.

Example: Global File Sequence Example on page 142

Receipts Tab
Use this Tab to configure how EFT Processing creates files for Direct Debit Transactions

Payroll Tab
Use this Tab to configure how EFT Processing creates files for payroll payments.

Important! Before changing any of the settings or other information in the EFT Banks
form, make sure you understand the impact the options have on processing with your
Bank.

EFT VENDORS OVERVIEW

How to use the screen
Use this form to add EFT details for Vendors defined in Sage 300 A/P.
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Field names might be different depending on the Primary Bank set up in EFT Options.

Use the Primary File Type Tab for EFT Processing (A/P and A/R)

Field names also depend on the File Type entered on the EFT Vendor and EFT Customer screens, if
using the multiple account details, one per EFT file type option.

For detailed field description, see EFT Vendors - Setup Screen on page 154

Choose Vendor number from the Finder or type the Vendor code
Remit To (Optional) : Use this when you have A/P Vendors with different bank account details for
different transactions. When creating the A/P Payment, you can select the appropriate Remit-to
code (and therefore the correct bank details. This applies to the Vendor's bank account details.
File Type (Optional):  The “file type” on the EFT Vendor allows you to specify different bank
account details for your EFT vendors/EFT customers depending on the bank or file type you are
using to make EFT Payments.

Note: This field is only available if the "Allow multiple Vendor bank account Details,
one per EFT File type" is ticked in EFT Setup > Options> A/P Tab.

Tip: If you only make EFT transactions from one bank account and only have one EFT File Type
in use, do not select this option and use the default EFT File Type. This simplifies the data entry
and reduces the risks of duplicate account details.

Delivery Method and Email To: Configure how to send remittance advice. Refer to Setup EFT Ven-
dors to email remittance advices for details.

Enter the Vendor's bank details.

Status : select one of Entered, Active or Inactive.

Status needs to be Active to use the record (EFT Vendor, Customer or Employee) in the
Create EFT File process.

Example:
You can control who is allowed to make vendors “active” and “inactive” using the
Approve/View Unencrypted Vendor Bank Details security group.

Refer to tutorial on Approving changes of EFT Vendor/Customer/Employee details on
page 19

Importing EFT Vendors
You can import EFT Vendors. For details refer to Importing EFT Details on page 68
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Tip: When importing EFT Vendors, EFT Customers and EFT Banks, you should not
import the Encrypted Bank Branch and Account number and Credit Card Number
fields (fields containing an "X").
These fields should only be set using the associated views, and set to the cal-
culated encrypted value. - EFT Import functionality prevents such fields to be
imported. Fields starting with X (binary XBSBNO and XACCNO) shouldn't be in the
import file.

EFT CUSTOMERS FORM
Use this form to add EFT details for customers you want to use Direct Debit with:

For details on each field, refer to EFT Customers - Setup Screen on page 158

Choose Customer number from the Finder or type the Customer code
File Type (Optional)

Note: This field is only available if the "Allow multiple Customer bank account
Details, one per EFT File type" is ticked in EFT Setup > Options> A/R Tab

The “file type” on the EFT Customer allows you to specify different bank account details for
your EFT vendors/EFT customers depending on the file type (or Bank File Type) from which
you are depositing for EFT Direct Debits.
For your EFT Direct Debits, if you

a) Only make EFT Direct Debits to one bank account OR
b) Only make EFT Direct Debits from one EFT customer’s bank account
Then you do not need a file in the File Type on the EFT Customer

Enter the Bank Name
Enter the BSB number
Enter the Account number
Enter the Account name (Defaults to the A/R Account name)
Enter a default Payment Reference.
Status : select one of Entered, Active or Inactive.
You can control who is allowed to make customers “active” and “inactive” using the Approve Cus-
tomer Bank Details security group.
Approve Customer/View Unencrypted Bank Details - set a Customer's Bank details to
Active/Inactive and view unencrypted Customers bank account details. Can only update the Active
field, cannot update other Customer bank details.
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Status needs to be Active to use the record (EFT Vendor, Customer or Employee) in the Create
EFT File process.
See Step : Adding Security on page 40

Note: You can use the Credit Card Tab to use Credit card details to generate the Direct
Debit file. The fields are encrypted in the database, but please note that EFT Processing
module is not PCI compliant and that Orchid takes no responsibility for the use of asso-
ciated fields and functionality.

EFT EMPLOYEES
Use this form to add EFT details for Employees defined in Sage 300 Payroll (US or Canada).

Main Fields
For detailed field description, see EFT Employees- Setup Screen on page 161

File Type is Optional . If you leave this field blank, then EFT will use the file type that has been
assigned in EFT Options > Payroll Tab > Primary Bank.
Status : select one of Entered, Active or Inactive. You can only include "Active" Employees when
you create EFT File
You can control who is allowed to make Employees “active” and “inactive” using the Approve
/View Employee Bank Account Details security group. See Step 2, Adding Security on page 40

Tip:
You can import new EFT Employees from the File > Import Menu. You cannot update details of exist-
ing EFT employees through import.

When importing EFT Banks, EFT Vendors, EFT Customers and EFT Employees, you should not import
the Encrypted Bank Branch and Account number and Credit Card Number fields (fields containing an
"X"). These fields should only be set using the associated views, and set to the calculated encrypted
value. EFT Import functionality prevents such fields to be imported. Fields starting with X (binary
XBSBNO and XACCNO) shouldn't be in the import file.

Calculation Type and Percent/Amount
The rules are applied in the order they are entered on the screen.

The rule is applied to the remainder amount after the prior rules have been applied.
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Tip: In most cases, the last rule should be set to Calculation Type "% Net Pay " and Percent = 100.
This means that any amount remaining after the previous rules have been applied will be trans-
ferred to the account set in that line. If the pay is to be paid to a single account, you only need to
enter one line with "% Net Pay" as the Calculation Type and set the Percent to 100

Example:
In the screenshot below, EFT Payroll will create a line in the file for $300 to CIBC and the remainder of
the pay will be transferred to RBC.

If the pay is $250 for the week, only one line will be created. If the pay for the period is $400, it will cre-
ate 2 lines, one for $300 and one for $100.

Note: (*) Field names might be different depending on the Default Bank File Type set up in
EFT Options > Payroll Tab for EFT Processing (Payroll) or File Type entered on the
EFT Employee screen.

EFT SETUP - RECEIPT/REFUND SELECTION CODES
Receipt/Refund selection codes define the criteria for selecting documents, and the parameters to gen-
erate A/R batches automatically. You must create at least one receipt selection code if you want EFT to
generate A/R receipt and refund batches automatically.

EFT Processing can create A/R Receipt batches, A/R zero value receipt batches to apply documents and
A/R Refund Batches.
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How does it work?
Receipt Selection Codes save the configuration default values that EFT Processing uses when you use the
"Create Receipt/Refund Batch" function. Refer to Create Receipt/Refund Batch on page 82

Tip: You can import Receipt Selection Codes.

For more detailed field and controls description, EFT Setup- Receipt/Refund Selection Codes - Field List
on page 179

Select Tab
Use this tab to specify details about the receipt batches to be created:

Choose the method for selecting documents
Select all documents meeting the criteria
Set ranges of
account sets, terms code, billing cycle, interest profile, payment code and customer price list

Criteria Tab
Use this tab to:

Choose the method for selecting documents
Select all documents meeting the criteria
Set ranges of account sets, terms code, billing cycle, interest profile, payment code and customer
price list, etc.

Document Tab
Use this tab to configure the document types to include in the calculation of the receipt amount, and
applied to the receipt created (AR Credit Notes, Prepayments, Unapplied Cash / Receipts, Debit Notes)

Receipt Selection Code: Exclusions Tab
Use this tab to list the customer(s) which are to be excluded from the Receipt selection process and/or
the Customer(s) and Document(s) combinations to be excluded from the Receipt selection process.
Columns to be completed (if required)

EMAIL MESSAGES SETUP
The E-mail Messages form lets you create Email message templates to be sent with e-mailed remittance
advices, refund advices, direct debit advices and payroll remittance advices when using EFT Payroll. You
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can use HTML or Text message templates.

The quick tip video explains how to configure email messages, including HTML options,
in EFT Processing for Sage 300.

EFT Quick Tip video: Setting up email messages

How to use the screen
To create an e-mail message that you can use with remittance advices:

Choose E-mail Messages from the EFT Setup folder.
Complete the fields on the form.
Click Add or Save when you are satisfied with your message.

Email Message variables and sample templates
You can enter variables (field names) from your company database, including vendor, customer,
employee and details of the EFT Transaction.

Use field names, surrounded by {FIELDNAME} or preceded by a dollar sign,  to identify variable inform-
ation that you want to include with the message.

Refer to Email Messages - Variables to include on page 171 for details relating to EFT AP/AR and
EFT Payroll.
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Note:
Email subject can also include variables

For example, Payment from {COMPANY_NAME} will replace {COMPANY_NAME} with the Sage 300
company name defined in Company Profile.

Example:
You can use the following sample e-mail messages for the different types of advices in
EFT Processing. Copy and paste into the Email Message screen.

Refer to Sample EFT Email Messages on page 177

Tip:

To add a logo to the Message templates, you have to use an HTML template and include an image tag
pointing to a logo hosted on your website.

Refer to EFT Payments HTML email - example with image link on page 177

Using Email Messages
When you select Email or Contact's Email as the Delivery Method in the EFT Print advice screen, you can
select the Message ID for the message you want to send with the vendor, customer or employee's
advice.

Refer to EFT Print Advices for details on sending email messages in EFT Processing.

EFT Print Advices on page 86

IMPORTING EFT DETAILS
Use the Import and Export commands on the File menu in the EFT Setup form to import and export EFT
Banks, Customers , Vendors and Employees.

This feature is available for exporting and importing data to and from non-Sage 300 systems.

For details on importing and exporting Sage 300 details, see the chapter on importing and exporting
data in the System Manager User Guide.

The Quick Tip video includes steps for importing Vendor, Customer and Employee bank
details into EFT Processing.

EFT Quick Tip Video: Importing into EFT Processing
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Importing Tips
Tip: As fields for EFT Vendors / Customers / Employees depend on the file format, it is recommended
to setup the Primary Bank in EFT Options, enter details for one record, export it and add details for
other records accordingly.

Tip: When importing EFT Employees, you can only insert new records. You cannot update existing
employees as the records include header and details information.

Tip: When importing EFT Vendors, EFT Customers, EFT Employees and EFT Banks, you should not
import the Encrypted Bank Branch and Account number and Credit Card Number fields (fields con-
taining an "X"). These fields should only be set using the associated views, and set to the calculated
encrypted value. - EFT Import functionality prevents such fields to be imported. Fields starting with X
(binary XBSBNO and XACCNO) shouldn't be in the import file.

Tip: It is recommended to remove credit card details fields when importing bank accounts: , these
fields must be removed from the import file ‘CCNUMBER’, ‘CCECP’, ‘CCNAME’ and ‘XCCNUMBER’.

Exporting EFT data
Use this command to transfer (export) data from EFT Processing to non-Sage 300 programs.

To export data, follow these general steps

Open the appropriate EFT Setup form for the type of data you want to export.

Example: To export EFT Vendors, open the EFT Vendors Setup form.

Choose the Export command from the File menu.
In the form that appears, select the range of records you want to export, and the type of inform-
ation.
Specify the file name and file type for the exported records.

Importing EFT Documents
Use this command to import EFT documents from an external system into EFT Processing.

Create the file you want to import.

Choose the Import command from the File menu.
Specify the file name and file type in the form that appears next.
If you previously created a template for importing, choose the Load Template button.
Choose the fields that you are importing.

Page 70 of 224 Setup EFT



Orchid EFT Processing

Tip: You can save your choices as a template for the next time you import records.

Minimum Import Field Requirements
It is not essential to import data into all the fields in the EFT record.

Tip: For information on the file formats and file layouts that Sage 300 accepts, you can create an
import file template by exporting a few records of the type you want to import.

DESIGNING EFT PROCESSING FORMS
You can print and reprint remittance advices for the individual customers, employees and vendors based
on a range selection.

Orchid EFT Module comes with sample remittance advices for Payroll, Accounts Receivable and Accounts
Payable. You can use the sample form or change it to suit your company's requirements, as described in
the appendix on customizing forms in the System Manager User Guide.

EFT Processing installs with the following A/P remittance advice formats, with different payment for-
mulas:

ELPAY01 – payment date is based on the date when the EFT file was created/generated.
ELPAY02 – payment date is based on the Batch Date.
ELPAY03 – payment date is based on the Batch Entry Date.
ELPAY05 – payment date is based on the effective date selected when the EFT file was cre-
ated/generated. This only applies if the EFT format you use supports effective date.

EFT Processing installs with the following A/R remittance formats:

For A/R Receipts

ELREC01 – payment date is based on the date when the EFT File was created/generated.
ELREC02 - payment date is based on the receipt entry date.

For A/R Refunds

ELREF01 – payment date is based on the date when the EFT File was created/generated.
ELREF02 - payment date is based on the refund entry date.
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EFT Web Screens
Web Screens for EFT Processing are only available if you are running Sage 300 version 2022 and above.

Available screens 72
Install EFT Web Screens 73
Using EFT Web Screens 74

Watch video EFT Web Screens launch

AVAILABLE SCREENS
With the July 2023 release, the following screens are available in the web screens:

EFT Setup

Options
Banks
Customers
Vendors
E-mail Messages

EFT Transactions

Create EFT File

EFT Transaction Reports

Transfer Details
Transfer Created
Print Advices
Audit Log
Receipt Batch Audit Report
Update Invoice Due Date Audit Report

EFT Periodic Processing:

Delete inactive records
Receipt Batch Audit Log (July 2023)

EFT Setup Reports
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Banks
Customers
Vendors

INSTALL EFT WEB SCREENS

Licensing

EFT Processing Subscription License

Check your existing codes on the EFT License screen. If you have a subscription code, you can view the
expiry date. EFT Processing License Screen on page 14

Tip: Contact your Sage 300 business partner if you have a perpetual licence and want to run the web
screens. They can organise a switch to a subscription licence.

Prerequisites

Install Latest PU for Sage 300 System Manager

Note: EFT Processing web screens rely on the Sage 300 web screens being installed and configured.

The web screens require the latest Sage 300 System Manager updates, as they include changes to the
web SDK required for EFT Processing web screens.

Sage 300 Version

Web Screens for EFT Processing are only available if you are running Sage 300 version 2022 and above.

Web Screens Installation
Web screens for Orchid modules rely on Extender for ease of deployment and maintenance. To run the
EFT Processing web screens, you need to install and activate Extender, even if you don't have a license
for Extender.

Key Steps to install

Install Latest EFT Processing update
Install Extender latest product update (PU9.00 and above)
Activate Extender in all companies where you want to use the web screens
Restart IIS
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Note:
No serial number / license required if the customer has not purchased Extender. ADMIN
only has access to the Extender Options and License screens.

If the customer has a license for Extender (Configurator, Developer or Runtime, Perpetual or
Subscription), web screens are enabled.

USING EFT WEB SCREENS
Web screens for EFT Processing support the same features as the Sage 300 core modules. Refer to Sage
300 documentation for using the web screens.

Setup Tips
EFT Options : Default Advice finders - You can use the finder to select the AP Remittance Advice.

For the AR Remittance Advices finders, please type the Advice name or use the classic desktop screens to
use the Finder.

Refer to EFT Options Default Advice Fields and Controls on page 123

EFT Banks - Tips for Web Screens
Refer to EFT Banks Form - Overview on page 60 for details on setup.

Output destination

On the web screens, there is no finder to select a file path. If you choose File as the Output Destin-
ation, you need to copy and paste the file path. The file path needs to be a folder that the network user
has access to.

When using the web screens, the network user is not the user logged in the machine. It is the user con-
figured in IIS Authentication for the Sage 300 site. It can be the default IUSR account, or a configured net-
work user. It can also be configured on the Application Pool Identity.

Note: To use File in EFT Banks, check the user configured in IIS and ensure it has rights to the
folder used in EFT Banks. Use UNC Path and IP Address to ensure that the folder name exists for the
network user configured in IIS.

Example: If you use c:\Temp, is it looking for the C drive of the App server (which users won't have
rights to).

If you want to save the EFT File to a local file, choose “Download” and EFT will use the browser’s down-
load settings to save the file locally.

Depending on your browser settings, the file will be saved in your default Download folder or the
browser will prompt you to select a location.
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Tip: Use SFTP if you don't want to download the file to a local machine or to the server. EFT Processing
will upload the file directly to the configured SFTP Site. When using SFTP with Key file, copy the key file
in the Sage 300 Shared Data folder to ensure the network User configured as the IIS website or Applic-
ation pool Identity has access to it.

EFT Vendors - Tips for Web Screens

Create a new EFT Vendor record

To add a new Vendor to EFT, use the Create New button and use the Vendor Finder or enter the Vendor
Number. Enter the required details. Save.

Select an existing EFT Vendor record

Use the All EFT Vendor Records icon to select a record configured in EFT Processing.
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Refer to EFT Vendors Overview on page 61 for more details on EFT Vendor setup.

EFT Customers Tips for Web Screens

Create a new EFT Customer record

To add a new Customer to EFT, use the Create New button and use the Customer Finder or enter the Cus-
tomer Number. Enter the required details. Save.

Select an existing EFT Customer record

Use the All EFT Customer Records icon to select a record configured in EFT Processing.

Refer to EFT Customers Form on page 63 for more details.

See Also: Install EFT Web Screens on page 73

Page 76 of 224 EFT Web Screens



Orchid EFT Processing

Using EFT Processing - AP/AR
Use EFT Processing Transactions to Create EFT File (A/P Payments, A/R Receipts and A/R Refunds).

If using EFT Processing with A/R Customers, you can also Create Receipt Batch and Update Invoice Due
Date.

Refer to Visual Process Flow for key steps of using EFT Processing. Assigning Visual Process Flows

Create EFT File 77
Create EFT File for AR Refund Batch 80
Recreating an EFT file 80
Create Receipt/Refund Batch 82
Update Invoice Due Date 85
EFT Print Advices 86
Using password to protect Remittance Advices for Vendors 90
Using password to protect Remittance Advices for Customers 91

CREATE EFT FILE
You need to create a batch in A/P or A/R before you can create the EFT File.

BEFORE YOU CREATE THE FILE, MAKE SURE THAT

Your logon profile to the network gives you access rights to the directory where the files have
to be created (as set in EFT Banks setup).
Confirm which Payment , Receipt or Refund batch number you want to use.

Enter Details
Batch Type: Select whether you want to process a Payment , Refund or a Receipt batch.

From Batch: & To Select a batch number or range of batch numbers to be exported (using the Finder).

Tip: Use the drill down icon to open the batch screen and check it if required.

Note: You can only select a range if "Allow EFT File creation from a batch range" is set to
Yes on the EFT Options > A/P Tab.

File Type: defaults to the file type of the bank entered in EFT Bank Setup for the Pay-
ment/Refund/Receipt batch type selected. You can select another file type.

Using EFT Processing - AP/AR Page 77 of 224

../../../../../../Content/Shared/GettingStarted/Assigning-Visual-Process-Flows.htm


Orchid EFT Processing

Example:
A customer in the UK creates standard BACS files as well as occasional Priority Payment files.

In EFT Bank Setup, set the file type to the most common used format: UK_HSBC_
ISO20022BACS.

When the batch is for other payment type eg. Priority Payment, change the file type to UK_
HSBC_ISO20022PP in the Create EFT File screen.

Note: If using a range, the file type will be the bank layout of the first batch selected.

Description: Type a lodgement reference.

Note: Description is saved in the EFT Processing audit logs in the latest product updates for
Sage 300 versions 2021 and above.

Reference: Choose one of the option:

Use description, Use reference from vendor master record, Use Cheque number or
Use invoice number.

Note: Description and Reference appear on the vendor bank statement if a variable ref-
erence is included in the bank's file.

Note: Reference is saved in the EFT Processing audit logs.

If a vendor is not defined: Select Skip the vendor... if you want the file export to continue
without errors and skip the transaction  or
Display an error and abort to generate an error and abort the export if the vendor/customer is
not defined in EFT processing.

Note: You can only select "Skip the vendor and continue the export" if the option is selected
on the EFT Options > A/P Tab.

Include in EFT File: If using Selective payments to select or remove a payment from a posted batch:

Select All entries in the batch to include all entries in the selected batches, or

Entries that I select to include only selected entries.

If selected entries is chosen, click the Selected Entries button and ensure you select (x) all the entries you
wish to include in the EFT file. Only those marked entries (x in the Include in EFT File) column will be trans-
mitted to the bank.

Tip: You can use the Select All and Deselect All buttons to assist in transaction selection.

Tip: When using the web screens, you can use the Space bar or Double Click to toggle the
selected / deselected entries.
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Note:
You can only select entries for A/P Batches if "Allow Selective Payments from an A/P Batch
?" is set to Yes on the EFT Options > A/P Tab.

You can only select entries for A/R Batches if "Allow Selective Payments from an A/R Batch
?" is set to Yes on the EFT Options > A/R Tab.

Effective Date: This field is only available in certain user file formats.

Note: It is usually used in userformats.ini when they want to control when the payment date
should be. In the latest product updates for Sage 300 versions 2021 and above (since Octo-
ber 2023), the effective date is stored in the EFT audit logs.

Create the file
Choose Create to create the file

You can then submit the file via your desktop banking software.
If your bank supports SFTP, EFT Processing can upload the file directly using the bank's SFTP
details configured in EFT Banks Setup Screen on page 146

Note:
The screen displays the EFT file path from the EFT banks setup for the bank associated with
the batch. If you don't have access to the file (drive not mapped on a server, user security
does not have rights to the directory), EFT processing cannot create the file.

Save settings in Create EFT File

To save the settings used regularly, use the standard Sage 300 functionality in the Settings Menu > Save
Settings As Default.

Save Settings saves the following fields: Description, Reference and Skip/Display error for each batch
type.

Example:
In the ACH file format, the Company Entry Description is based on Description field in Create EFT File
screen. If it is the same for all files, you can enter the description in Create EFT File the first time you
use it. Click on Settings – Save Settings as Defaults. The screen will default to the same description next
time you create an EFT File.

Recreating a file
If the file has already been exported, you are prompted to re-create the file.

For details, refer to Recreating an EFT file on the next page
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CREATE EFT FILE FOR AR REFUND BATCH
On an AR Refund, you are able to create multiple bank entries, against multiple banks for different
amounts as shown below.

EFT Processing :

makes a single entry in the EFT File for each AR Refund Entry regardless of the number
of banks entered on the AR refund entry.
assumes all the entries in the batch / file are for the same bank which is derived from
the first AR Refund entry

Because EFT Processing creates only one entry in the EFT File for AR Refunds, the selection of the
amount and the bank to use is based on the following logic :

Use the check amount bank if the check amount is not zero, otherwise
Use the cash amount bank if the cash amount is not zero, otherwise
Use the first c.c. bank if there are cc entries

Tip: It is recommended for processing EFT payments for AR Refunds that you

Create the refund based on one amount only per entry (either Check, Credit Card or Cash)
Use the same bank for all AR Refunds in the same Refund Batch.
If you need to refund some amounts from the Cheque Payment and another amount to the
CC Bank, you will need to create a separate AR refund entry in a new batch.

RECREATING AN EFT FILE
If the file has already been exported, you are prompted to re-create the file.

The user needs have the "Recreate EFT File" security group selected in Administrative Services.

Refer to EFT Security > Recreate EFT Files on page 42

Note: This is a new security option in the latest EFT product updates for Sage 300 versions 2019 and
above (October 2021).
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Depending on the file naming in EFT Bank configuration, recreating the file will overwrite the file or cre-
ate a new file.

Tips:
If using File Sequence Number, you can reset the number in EFT Banks to reuse a sequence.

If using Global Sequence Number, you can reset the number in EFT Options.
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Note:
If you get an error "This EFT File has already been created", the user doesn't have rights
to "recreate EFT File".

Related tasks

CREATE RECEIPT/REFUND BATCH
This form lets you create A/R Receipt or Refund batches from A/R invoices and other documents accord-
ing to the configuration in the EFT Processing Receipt Selection Code setup.

Create Receipt batch can create three types of batches: 

A/R Receipt batches, Zero value A/R Receipt batches to apply documents and A/R Refund batches.

When creating A/R Refund batches, the process only includes Credit Notes and Unapplied Cash and Pre-
payments, in line with how Refund batches work in Sage 300.

Note: You must create at least one receipt selection code in EFT Processing Setup before
you can use this form to create a batch.

Tip: You can update the invoice Due Date if required to ensure the invoice can be selected
in the "Create Receipt Batch" run. Refer to Update Invoice Due Date on page 85

The EFT Spotlight video presents steps to Create A/R Receipt/Refund Batch using
EFT Processing.

EFT Spotlight video: Create A/R Receipt and A/R Refund batches
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How to use
The default values are determined by the Receipt/Refund Selection Code. You can amend the values for
the specific receipt batch you need to create.

See EFT Setup - Receipt/Refund Selection Codes on page 65

Step 1: Enter a Receipt/Refund Batch Date .

Step 2: Update the default batch and entry descriptions if required.

Step 3: Select "Create" to generate the batch.

The process displays a message with the batch number created and the number of entries.

If the process is unable to find documents within the selection criteria, it returns a message "Nothing to
receipt".

Step 4: If the created batch is not auto-posted, you can edit the batches in A/R Transactions. When the
batch is posted, you can use it in Create EFT File as if you had manually created the A/R Receipt or
A/R Refund batch.

Note:
You can create a single receipt per invoice, or group all outstanding invoices in a single receipt per
customer: 

Select Yes if you want separate receipts per outstanding invoice,

Select No to include all invoices in a single receipt per customer.
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A/R Receipt batches

When creating A/R Receipt batches, EFT Processing creates a new receipt and applies all the documents
that meet the criteria selected. Invoices and the documents selected on the "Documents" tab are
included.

A/R Receipt Batches - Zero value

This is used to match documents (invoices and Credit notes) to a receipt.

Note: If the customer's net balance is in credit, you can then use "Create A/R Refund batch" to create a
refund applied to the pending credit transactions.

Tips:
You need to select at least one of Credit Notes, Prepayments or Unapplied Cash on the Documents
Tab.

When creating Zero value A/R Receipt batches, EFT Processing evaluates the credit balance based on
the selection parameters. Invoice and other debit balances are applied to the credit balance until the
balance is zero.

If the credit balance is greater than the Debit balance, the most recent credit transaction will end up
with a pending balance. If the debit balance is greater than the credit balance, the most recent debit
transaction will end up with a pending balance.

A/R Refund batches

When creating A/R Refund batches, EFT Processing includes Credit Notes, Prepayments and Unapplied
Cash as selected on the "Documents" Tab. You need to select at least one of Credit Notes, Prepayments
or Unapplied Cash on the Documents Tab.

As per Sage's rules with A/R Refund, Invoices and Debit Notes cannot be selected.

Tips:
When creating A/R Refund batches, ensure A/R Receipt batches are posted before
running the function.
When creating A/R Refund, if you only want to refund customers with a net credit bal-
ance, set the From Customer Balance to the lowest negative number you want to
select. Set the To Customer Balance to 0.

Payment Type: 

The payment type "CASH or CHECK" configured on the Payment Code in A/R Setup is used to
determine the A/R Refund payment type.
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All details in the refund use the same payment type.
If no payment code is selected, the Refund payment type is set to "Cash".
You can amend the payment types before posting the A/R Refund batch if you don't auto-post
the batch.

UPDATE INVOICE DUE DATE
This form allows you to amend the Due Date for posted A/R invoices.

When to use
You can use the "Update Invoice Due Date" feature if the due date needs to be amended for selection in
the Create Receipt Batch run.

It is also useful if you need to correct the Due Date on an invoice for your AR Aged Trial Balance because
the original document was posted with the incorrect Due Date.

When any document's Due Date is amended, the date, time, user, original due date and amended due
date are logged in the Updated Invoice Due Date Audit log.

Note: You are only able to use this screen if the security group "Update Invoice Due Date" has been
assigned to your Sage 300 Security profile.

Key Steps
Step 1: You can either amend a single customer/document due date on the screen

Single Document Tab
Use this tab to:

• Select single documents for a specific customer.

• Change the due date of an AR invoice or an OE Invoice and associated AR Invoice.

Multiple Documents Tab
Use this tab to change the due date of multiple documents for the same customer

• Select/enter the required customer code : click the “>>” (Go) button to view all documents

• Amend the document due dates as required

Click Process to save the changes, close to abandon the changes and close the screen.

Step 2: View Audit log

You can navigate to EFT Processing > EFT Periodic Processing > Update Invoice Due Date
Audit to view all the changes per customer and document.
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Refer to details : Update Invoice Due Date Audit

EFT PRINT ADVICES
To open this screen, choose the Print Remittance Advices icon from the EFT Reports folder.

This screen is used to print and email Remittance Advices (for AP payment batches) , direct debit advice
(for AR receipt batches) or Remittance Advices for customer refunds (for AR refund batches).

Important! All remittance advices can only be sent (emailed, printed or previewed) if the EFT file has
been created first, as details come from the EFT Audit Logs.

The Quick Tip video details the steps to email remittance advices in EFT Processing for
Sage 300 and explains various available options

BEFORE PRINTING REMITTANCE ADVICES

Check the Delivery method and email address used in EFT Vendor setup ( EFT Customer for
AR Advices). Refer to EFT Vendors - Setup Screen on page 154 for details.
Check Email Message templates. Refer to Email Messages Setup on page 66
Update account information by entering, importing, and posting batches.
Submit the batch via EFT using the EFT Transactions > Create File option

Select details To print and Email Remittance Advices
Delivery method: Select how you want to send the Remittance Advices to your customers and/or
vendors, as follows:

• Print Destination — to send the Remittance Advices to the default print destination you selected
on the company desktop.

• Customer/Vendor—  to send the Remittance Advices via the method specified in your EFT Customer
records or EFT Vendor records.

Refer to EFT Vendor Setup > Delivery Method on page 155 and EFT Customer Setup > Delivery Method
on page 159 for details.

Print: Select which type of batch you want to send Remittance Advices for as follows:

• A/P Payment batch  — to send the Remittance Advices based on a range of A/P Payment batches.

• A/R Receipt batch  — to send the Remittance Advices based on a range of A/R Receipt batches.

• A/R Refund batch  — to send the Remittance Advices based on a range of A/R Refund batches.

Use Report: Select the name of the statement form to use.
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Note: This option is only available if the Sage 300 Security Group includes the Select
Remittance Advice Layout.

Tip: Choose Browse (click the Browse button or press the Alt and B keys together) if you are
not sure of the name of the form, then select the form from the list that appears.

TO REVIEW DETAILS ON THE SAMPLE REMITTANCE ADVICE REPORTS
INCLUDED IN EFT PROCESSING, EXPAND

In the latest product updates, for all reports, the EFT Vendor and Customer bank account
details are taken from the EFT Log Audit table (i.e. the bank account details from the EFT
Vendor and Customer details at the time the EFT file was created).

EFT Processing installs with the following A/P remittance advice formats, with different pay-
ment formulas:

ELPAY01 – payment date is based on the date when the EFT file was cre-
ated/generated.
ELPAY02 – payment date is based on the Batch Date.
ELPAY03 – payment date is based on the Batch Entry Date.
ELPAY05 – payment date is based on the effective date selected when the EFT file
was created/generated. This only applies if the EFT format you use supports effective
date.

EFT Processing installs with the following A/R remittance formats:

For A/R Receipts

ELREC01 – payment date is based on the date when the EFT File was cre-
ated/generated.
ELREC02 - payment date is based on the receipt entry date.

For A/R Refunds

ELREF01 – payment date is based on the date when the EFT File was cre-
ated/generated.
ELREF02 - payment date is based on the refund entry date.

Tips: To set Default Advice Form, use Default Advice Tab in EFT Options Screen
Guide on page 113

Message ID: This field appears when you select Customer/Vendor for the Delivery Method.

Select the code for the e-mail message you want to send with these statements.
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Note: To set up messages for AP remittance advice, AR Direct Debit Advice or AR Refund
Advice, refer to EFT Setup - Messages.

Additional options

Remit-To Address/Details. This field appears when you select Customer/Vendor for the Delivery
Method and you have selected A/P Payment batch from the Print option.

Tip:
Select this option if you want to use the Remittance address / e-mail addresses on the remit-
tance advice.

If Delivery Method in A/P Vendors is set to Email (contact), EFT will use the email address in
the Remit-to contact Tab.

If Delivery Method in A/P Vendors is set to Email (Vendor), EFT will use the email address in
the Remit-to Address Tab.

 If there is no remittance code on an individual payment, the vendor address / e-mail details
will be used as per the A/P Vendor delivery method.

From Batch . to Batch. Select the batch range you wish to print/email.

From Entry … to Entry. If you select only one batch, you can select an entry range within the batch.
 Only the selected entries will be printed/delivered

Tip: If you select more than one batch, you cannot select an individual entry within the
batches, all entries will be printed/delivered.

Check this box if you want to send an email...: Use this to resend an email, for example if you have
updated an email address after sending the first email.

Tip: This option is only enabled if you configure Email details in EFT Options > AP Email. If
you are using Sage Company Profile or Outlook, EFT can't check if the email has already
been sent.

Tip: You get a message "Nothing to print" if you have already printed. If you have already
emailed the remittance advice, and you are using Company Profile Email and not EFT Email
setup, the check box is not available and you cannot reprint.
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Click Print

Tip: If you need additional copies of Remittance Advices, or earlier processing was halted, simply
repeat the process.

After printing/emailing EFT Remittance/Direct Deposit advices, a list of which remittance advices which
were not sent/printed is displayed.

FOR MORE DETAILS ON REASONS:

it is excluded from the selected entries
A/P Payment is reversed
they've already been emailed.
vendor xxx does not exist in A/P.
it hasn't been included by any Create EFT File run.
customer xxx does not exist in A/R.

Note: When printing Advices with number of advices greater than the limit, EFT will send
the selected number, then pause if "per minute" is selected or Disconnect and start a new
session if using "Per session" is selected. This is configured in EFT Options. Limit Sending of
Emails and Email Limit per Minute/Session on page 117

Using Remittance Advice Password
When using EFT Options Email settings, you can configure a password for the PDF file that is attached to
the email.
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The EFT Option “Use Remittance Advice Password” on the AP tab comes into effect when email-
ing Vendor remittance advices. For details, see Using password to protect Remittance Advices for Ven-
dors below

The EFT Option “Use Remittance Advice Password” on the AR tab comes into effect when email-
ing Customer remittance advices. For details, see Using password to protect Remittance Advices for Cus-
tomers on the facing page.

Emailing advices for Miscellaneous receipts
You can use EFT Processing to email advices for AR Miscellaneous Receipts as well as AR Receipts. This
means you don't need one process in AR to email customers a remittance advice for Miscellaneous
Receipts, and a second process in EFT to email customers remittance advices for Direct Debits.

1. Use an EFT File format for Miscellaneous Receipts configured to work without having to enter EFT
details for the AR Customer.

2. Enter and post the AR Receipt Batch
3. Create the EFT File (but you don't upload the AR Receipts EFT File to the bank)
4. Email the Customer a Remittance Advice using the Print Advices screen.

Remittance advice is blank
If the remittance advice is blank, it is likely because the CSCOM.AUDTORG is incorrect. (possibly after a
SQL restore).

The report links the EFT Tables using the [CSCOM.AUDTORG] field and most likely it has a different
value from the Database ID.

You need to check CSCOM.AUDTORG and CSCOM.ORGID in the database using SQL Server Man-
agement Studio.

Check CSCOM.AUDTORG and CSCOM.ORGID in that database

USING PASSWORD TO PROTECT REMITTANCE ADVICES
FOR VENDORS
The EFT Option “Use Remittance Advice Password” on the AP tab comes into effect when emailing
Vendor's remittance advices.

Use of this option will allow for Remittance Advice PDFs to be encrypted before being emailed, with
either one or two passwords: Master and/or User.

Use of the User Password in the EFT Vendor record:
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If a password has been entered in the EFT Vendor’s Remittance Password field, then this password
will be applied to the remittance PDF document.
If a password has not been entered in the EFT Vendor’s Remittance Password field, then the EFT
Options \ AP Password Formula will be used to generate a Vendor-specific password to be applied
to the remittance PDF document.
If no password formula exists for either of those fields, then the PDF document will not be encryp-
ted.

Use of the Master Password in EFT Options \ AP Tab:

The Master Password is an optional password that can be applied during the encryption of a remittance
PDF document, in addition to the User Password (generated as per the rules described above). It not
necessary for the encryption of a PDF document. The rules are:

If a User Password and Master Password both exist, then encryption of the PDF document will take
place using both passwords.
If a User Password exists, but no Master Password exists, then encryption of the PDF document will
still take place, using the User Password only.
If no User Password exists, then no encryption of the PDF document will take place, whether or not
a Master Password exists.

Refer to: 

Password Examples on page 169

Password Formulas on page 165

USING PASSWORD TO PROTECT REMITTANCE ADVICES
FOR CUSTOMERS
The EFT Option “Use Remittance Advice Password” on the AR tab comes into effect when emailing Cus-
tomer remittance advices.

Use of this option will allow for Remittance Advice PDFs to be encrypted before being emailed, with
either one or two passwords: Master and/or User.

Use of the User Password in the EFT Customer record:

If a password has been entered in the EFT Customer’s Remittance Password field, then this pass-
word will be applied to the remittance PDF document.
If a password has not been entered in the EFT Customer’s Remittance Password field, then the EFT
Options \ AR Password Formula will be used to generate a Customer-specific password to be
applied to the remittance PDF document.
If no password formula exists for either of those fields, then the PDF document will not be encryp-
ted.
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Use of the Master Password in EFT Options \ AR Tab:

The Master Password is an optional password that can be applied during the encryption of a remittance
PDF document, in addition to the User Password (generated as per the rules described above). It not
necessary for the encryption of a PDF document. The rules are:

If a User Password and Master Password both exist, then encryption of the PDF document will take
place using both passwords.
If a User Password exists, but no Master Password exists, then encryption of the PDF document will
still take place, using the User Password only.
If no User Password exists, then no encryption of the PDF document will take place, whether or not
a Master Password exists.

Refer to: 

Password Examples on page 169

Password Formulas on page 165
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Using EFT Processing - Payroll
Use EFT Processing > Transactions Icon to Create EFT Payroll File.

Use EFT Processing > Transaction Reports to Print Payroll Advices, Print Paystubs/payslips, Print T4s and
Releve1.

Refer to Visual Process Flow for key steps of using EFT processing - Payroll. Assigning Visual Process
Flows

Create Payroll EFT File - Overview 93
Create EFT Payroll File - Example processes 94
EFT Payroll Print Remittances Advices 96
EFT Print Payroll Stubs/Slips 97
EFT Print Relevé 1s 100
EFT Print T4s 101
Using password to protect Payroll Advices and other Payroll PDF for Employees 103

CREATE PAYROLL EFT FILE - OVERVIEW
Before you create the file, make sure that

Your logon profile to the network gives you access rights to the directory where the files have to
be created (as set in EFT Banks setup).

Use the buttons on the form to:

Select a Pay Period End Date to be exported.
Select an EFT File Type to be created.
Type a description and reference. The lodgment reference defaults to the description, but can be
changed. It appears on the Employee bank statement if a variable reference is included in the
bank's file.
Select whether you want the file export to continue without errors and skip the transaction  or gen-
erate an error and abort the export if the Employee is not defined in EFT processing.

Select the From and To Check/Cheque number: 

From Check/Cheque Number: defaults to 0
To Check/Cheque Number: defaults to 999999999
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Note: Typically, if you only run Generate Payroll once for a Payroll End Date, then these two fields can
be left with the default values. Alternatively, if you run Generate Payroll more than once for a Payroll
End Date, then you should use the From/To Check/Cheque Number fields to separate the transactions
required for each file.

For examples of steps to create EFT Payroll files depending on how you process the payroll, see Create
EFT Payroll File - Example processes below

Choose Create to create the file.

You can then submit the file via your desktop banking software.

Recreating a file
If the file has already been exported, you are prompted to re-create the file.

For details, refer to Recreating an EFT file on page 80

Important!
If you have already created a file for the Bank/Pay Period End Date, you will receive a warning to con-
firm that you really want to re-create the file. If the files include the same employees, the remittance
advice will include details from both files. It is suggested to send the remittance advices from the
"View'Clear Payroll log" in EFT Periodic Processing and select an individual EFT file creation number.

See details in View/Clear Completed EFT Payroll Logs on page 183.

Note: The screen displays the EFT file path from the EFT banks setup for the bank asso-
ciated with the batch. If you don't have access to the file (drive not mapped on a server,
user security does not have rights to the directory), EFT processing cannot create the file.

CREATE EFT PAYROLL FILE - EXAMPLE PROCESSES
Typically, if you only run Generate Payroll once for a Payroll End Date, then the two fields From and To
Check/Cheque Number can be left with the default values.

Multiple payroll for the same payroll period end date
If you run Generate Payroll more than once for a Payroll End Date, then you should use the From/To
Check/Cheque Number fields to separate the transactions required for each file.

Example:

If you run Weekly pays with a Payroll Period End Date of 31st March, you may:

Run your weekly pays
Print the cheques
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Email the Payslips
Post the cheques
Create the EFT File – here you can leave the default From/To Cheque Numbers as
0/9999999, since you want to include all the cheques
Email the Employee’s remittance advice

If you then prepare the Fortnightly pays with a Payroll Period End Date of 31st March, you may

Run your fortnightly pays
Print the cheques
Email the Payslips
Post the cheques
Create the EFT File – here you would want to exclude the Weekly pays from the EFT File,
so you would select From XX (where XX is the first Cheque Number of your Fortnightly
pays), and To 999999
Email the Employee’s remittance advice

And when preparing the Monthly pays with a Payroll Period End Date of 31st March, you may

Run your monthly pays
Print the cheques
Email the Payslips
Post the cheques
Create the EFT File - here you would want to exclude the Weekly and Fortnightly pays
from the EFT File, so you would select From XX (where XX is the first Cheque Number of
your Monthly pays), and To 999999
Email the Employee’s remittance advice

Alternatively, if you want one single EFT file for the Payroll Period End date, then you would do the above
steps “Run your pays” to “Post the cheques” for each individual pay run. 

You would then create a single EFT Payroll File, leaving the defaults for the From and To Cheque num-
bers.
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EFT PAYROLL PRINT REMITTANCES ADVICES
Warning! All remittance advices can only be sent (emailed, printed or previewed) if the
EFT Payroll file has been created first.

This report is used to create Payroll Advices (for EFT Files created from Payroll run). It includes details of
the payment bank accounts, amount and date, but no details about the payroll.

The advices can be printed (if you select Delivery method = Print destination) or emailed (if you select
delivery method Employee).

You can print and reprint Payroll Advices for the individual employee based on a Pay Period End Date
range selection.

Orchid EFT Processing comes with two sample remittance advices for Payroll: 

ELPR01.rpt: The report shows the check date. The report uses a SQL Command.
ELPR02.rpt: This report uses the Payroll period end date (new in July 2023 for versions 2021 and
above).

You can use one of the default reports or change it to suit your company's requirements, as described in
the appendix on customizing forms in the System Manager User Guide.

Tip: To email a payslip/paystub with pay details from Sage 300 payroll, refer to EFT Print Payroll Stub-
s/Slips on the facing page

Before Printing Payroll Advices
•  Update account information by entering, importing, and posting batches.

• Submit the batch via EFT using the EFT Transactions > Create EFT Payroll File option

To print Payroll Advices
1. Choose the Print Payroll Advices icon from the EFT Reports folder.

2. Select the following options:

Delivery Method - Select how you want to send the Advices to employees, as follows:

• Print Destination — to send the Advices to the default print destination you selected on
the company desktop.

• Employees—  to send the Advices via the method specified in the EFT Employee records.

Tips: For details on the Sample Remittance Advice included in EFT Processing, see Default
Advice Tab in EFT Options Screen Guide on page 113
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Tips: For more information, see the appendix on customizing forms in the System Man-
ager User Guide.

Use Report. Select the name of the statement form to use. Choose Browse (click the Browse but-
ton or press the Alt and B keys together) if you are not sure of the name of the form, then select
the form from the list that appears.

Message ID. This field appears when you select Employee for the Delivery Method. Select the
code for the e-mail message you want to send with these statements.

To set up messages for Payroll advice, refer to EFT Setup - Messages.

From Pay Period End Date ... to Pay Period End Date. Select the pay range you wish to
print/deliver.  If you select more than one pay period, you cannot select an individual employee,
all entries will be printed/delivered.

From Employee… to Employee. If you select only one batch, you can select an employee range
within the batch.  Only the selected entries will be printed/delivered

3. Click Print.

If you need additional copies of Advices, or earlier processing was halted, simply repeat the process.

Note: After printing/emailing EFT Payroll advices, a list of which advices were NOT sen-
t/printed and the reason why is displayed.

Tip: When printing Advices with number of advices greater than the limit, EFT will send the
selected number, then pause if "per minute" is selected or Disconnect and start a new ses-
sion if using "Per session" is selected.

Tip:
The EFT Option "Use Remittance Advice Password" on the Payroll Tab comes into effect when emailing
Employee advices and related documents.

For details, see Using password to protect Payroll Advices and other Payroll PDF for Employees on
page 103

EFT PRINT PAYROLL STUBS/SLIPS
This option allows you to email Employees Payroll Stubs/Slips.

The EFT Print Payslips is an email with the Sage 300 Payslip/Paystub attached - with details on the break-
down of the pay, deductions, YTD totals etc. It can be sent after the Generate Payroll and Print Cheques
has been run - but before the Print Cheques have been finalised.
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The process must be run at the time you would typically print the payslips.

The Quick Tip video demonstrates the steps to email and print payslips / paystubs in
EFT Processing:

Print Paystubs/Payslips - Overview
Prior to using this option, you must run the following in the Canadian or US Payroll

1. Calculate Payroll
2. Run Payroll Checks/Cheques process.
3. Most users choose to Print the checks for Payroll to assign a Cheque Number.
4. Do not answer the question "were all cheques printed successfully?" and leave the Payroll Print

Checks screen open
5. Run EFT Print Payroll Stubs/Slips with the Print Checks /Cheques screen still open, before posting

the cheques.

Note: This is required as Create Payroll EFT File requires content from the payroll temporary
tables.

Important! You can only Print/Email Payroll Stubs/Slips if you leave the Print Cheques screen open or
answer "No" to the "Were all checks printed successfully?".
Once you answer YES, the cheques/checks are posted and are not available to be reprinted/emailed.

To email Employee’s Payroll Stubs/Slips:

Step 1: Select Delivery Method: 

Select Employee to email payslips where the employee's Delivery method is set to EFT Email or
Payroll email. It will print payslips if the Employee's delivery method is set to Mail.
Select Print destination to print/print preview all payslips regardless of the delivery
method.

Step 2: Select other options:

Use Report: Select the required C/P or U/P Payroll Stub.

Message ID: Select the email Message ID for the template subject and body of the email to be
sent to the Employee

Payroll Period End Date: Select the required range

Employees: Select the required range
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Select “Check this box if you want to send an email even if an email has already been sent for
this entry” to resend all Payroll Stubs in the selection criteria.

Step 3: Click “Print” to send the emails.

The email address defined on the EFT Employee will be used.

If the Payslip/Paystub Print Directory from EFT Options \ Default Advices tab is filled in, EFT Pro-
cessing will save a copy of the password protected Payslip/Stub in the nominated directory
(EFT will create a sub-directory one per Employee ID if required).

Print Paystubs/Payslips - Password
All employees in the range selected will be emailed their Pay Stub/Slip.  If you have enabled the PDF pass-
word for EFT Remittance Advices on EFT Options \ Payroll Tab, then employees will need the password to
open the payslip/-paystubs.

WHAT PASSWORD IS USED?

If a Remittance Advice Password formula was entered on the EFT Employee, then this password
will be applied to the generated PDF, the PDF will be attached to the email, the body and sub-
ject of the email will be based on the required “Message ID”
If an Employee Master Password was defined on the EFT Options \ Payroll Tab, then the
Employee Master Password will also be applied to the generated PDF.

Configuration references
EFT Options -

Select Report filename - Payroll Payslip/stub report on page 123
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Password protect - Use Remittance Advice Password? on page 126

Email Configuration - Payroll Email Tab field and controls on page 127

EFT Employees -

Configure email addresses - Refer to Delivery Method on page 162

Security group considerations

User needs to be in a EFT Security group that has rights to "Print/Email Payroll Stubs/slips".

User needs to be the same user who is running the Payroll Print Checks function. This means a user can
only Print/Email payslips for employees that they have access to in Canadian/US Payroll.

Improvement in Sage 300 versions 2020 and above

Tip:
The pay stubs are grouped by Delivery Method and then processed per employee.

EFT first processes all employees configured with Mail delivery method option - if you set the
print destination to Printer, then EFT will print all pay stubs in one go.
EFT then processes all employees with Email option. While the emailing is in process, the user
can open any other Sage 300 screen and continue working.

EFT print/email screen can be left open in the background. The screen might flicker when it sends an
email, but it no longer acts as the main focus.

EFT PRINT RELEVÉ 1S
To email Employee’s Payroll Relevé 1s

The Use Report will default to the email Message ID on EFT Options \ Remittance
Advice tab, or the user’s Preferences if used previously
Select the email Message ID for the template subject and body of the email to be sent
to the Employee
Select the required Year
Select the required range for Employees
Click “Print”.

All employees in the range selected will be emailed their Relevé 1s.  The email address from the EFT
Employee will be used.  If you have enabled the PDF password for EFT Remittance Advices on EFT
Options \ Payroll Tab, then
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If a Remittance Advice Password formula was entered on the EFT Employee, then this
password will be applied to the generated PDF, the PDF will be attached to the email,
the body and subject of the email will be based on the required “Message ID”
If an Employee Master Password was defined on EFT Options \ Payroll Tab, then the
Employee Master Password will also be applied to the generated PDF.
The email address defined on the EFT Employee will be used

EFT PRINT T4S
You can use Orchid EFT Processing to email T4s and T4As generated in Canadian Payroll.

Overview

The quick tip video demonstrates how to email Employee’s Payroll T4s and T4As using
EFT Processing in Sage 300

EFT Payroll Quick Tip Video: Email T4, T4A
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How to use
Use Report defaults to the Crystal report selected on EFT Options > Default Advice tab
Select the Email Message ID for the template subject and body of the email to be sent to the
Employee
Select the required Year. If no year is entered, the screen displays an error message and no pro-
cessing takes place.
Select the required range for Employees
Click “Print”.

All employees in the range selected will be emailed the T4s report if there has been activity in the selec-
ted year. 

The email address is the email address from the EFT Employee. 
The PDF will be attached to the email, the body and subject of the email will be based on the
required “Message ID”
If you have enabled the PDF password for EFT Remittance Advices on EFT Options \ Payroll Tab,
then the PDF has a password.

Note: For details on using Password to encrypt PDF, refer to Using password to protect
Payroll Advices and other Payroll PDF for Employees on the facing page
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Troubleshooting and validation
If you have configured the EFT Employee's Delivery Method to "EFT Email" and you do not have an email
address entered on the EFT Employee's record, you will now receive an error message :

"Employee abc does not have an EFT email address. No email will be sent."
If you have configured EFT Employee's Delivery Method to "EFT Email" or "Payroll Email", but there are
no earnings details for the entered pay year, you will now receive a warning message:

"employee abc does not have activity for current year."

USING PASSWORD TO PROTECT PAYROLL ADVICES AND
OTHER PAYROLL PDF FOR EMPLOYEES
The EFT Option “Use Remittance Advice Password” on the Payroll tab comes into effect when emailing
advices to EFT Employees. The option also applies to PDF emailed using Print T4, Print T4As and Relevé
1s when using Canadian Payroll.

When this option is selected, Remittance Advice, payslips/paystubs and other payroll related PDF doc-
uments are encrypted before being emailed, with either one or two passwords: Master and/or User.

Encryption of Payroll Payslips/stubs, Relevé 1s, and T4 documents is performed using the Master Pass-
word and/or User Passwords entered into the EFT Options \ Payroll Tab and the individual Employee
records. The same password precedence rules as outlined below for EFT Payroll Advices apply to these
documents.

Use of the User Password in the EFT Employee record:

If a password has been entered in the EFT Employee’s Remittance Password field, then this pass-
word will be applied to the remittance PDF document.
If a password has not been entered in the EFT Employee’s Remittance Password field, then the EFT
Options \ Payroll Password Formula will be used to generate a Employee-specific password to be
applied to the remittance PDF document.
If no password formula exists for either of those fields, then the PDF document will not be encryp-
ted.

Use of the Master Password in EFT Options \ Payroll Tab:
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The Master Password is an optional password that can be applied during the encryption of a remittance
PDF document, in addition to the User Password (generated as per the rules described above). It not
necessary for the encryption of a PDF document. The rules are:

If a User Password and Master Password both exist, then encryption of the PDF document will take
place using both passwords.
If a User Password exists, but no Master Password exists, then encryption of the PDF document will
still take place, using the User Password only.
If no User Password exists, then no encryption of the PDF document will take place, whether or not
a Master Password exists.

Important!
If you want to use the ability to password protect the PDF attached to emails in EFT Processing, you
need to use EFT's SMTP options.

Similarly, if you want to save a copy of the Payslip/paystub in the directory configured on the EFT
Setup> Options > Default Advice Tab, you need to fill in the A/P Email or the Payroll Email SMTP
details. If emails are sent using default Sage's configuration through Outlook, a copy of the file will not
be saved.

Refer to: 

Password Examples on page 169

Password Formulas on page 165
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EFT Setup reports
Use the icons in the Forms folder to print setup details:

EFT Bank Setup Report - Features 105
EFT Vendor Report - Features 105
EFT Vendor Report Printing 105
Customer Report 106
EFT Employee Report - Features 106

EFT BANK SETUP REPORT - FEATURES
The EFT Bank Setup report lists the EFT processing details setup for each bank.

Information printed on the report

The report lists:

Detail information including Bank, Bank Name, BSB Number, Account number, Account name, Pay-
ment reference
Accounts Payable details including payment reference, file path, file extension, EFT File type

Accounts Receivable details including payment reference, file path, file extension, EFT File type
Payroll details, including payment reference, file path, file extension and EFT File type.

EFT VENDOR REPORT - FEATURES
This report lists the Bank details of vendors setup in EFT Processing.

Information printed on the report
Vendor number, Vendor name, Bank Name, BSB Number, Account Number, Account name, Pay-
ment Reference

EFT VENDOR REPORT PRINTING
Print the EFT Vendor Setup report to list the vendor details entered in your EFT Processing system.

When to print

Print the report when you change vendor EFT/ bank details.
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How to print

1. Choose EFT Vendor in the EFT Setup Reports folder, or choose File, Print from the Ship-Via Codes
form

2. Click Print

CUSTOMER REPORT
This report lists the Bank details of customers setup in EFT Processing.

For instructions on printing the report, see EFT Customer Setup Report — printing.

EFT EMPLOYEE REPORT - FEATURES
This report lists the Bank details of employee setup in EFT Processing (Payroll).

Information printed on the report

Employee number, Employee name, Bank Name, BSB Number, Account Number, Account name,
Payment Reference
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EFT Processing reports
Use the icons in the Forms folder to print EFT Processing transfer, Audit logs, Remittance advice , Direct
Debit and Refund advice.

EFT Transfers Created Report - Features 107
EFT Transfer Details Report - Features 107
EFT Audit Log Report - Features 109
Receipt Batch Audit Report - Features 109
Update Invoice Due Date Report - Features 109
EFT Payroll Transfers Created Report - Features 110
EFT Payroll Transfer Details Report - Features 110

EFT TRANSFERS CREATED REPORT - FEATURES
This report lists the files that have been created with the bank details, the date and time run, the type of
file and the payment / receipt batch number used and the file path and name.

Information printed on the report
The report lists:

Date the EFT File was created
Time the EFT File was created

The Batch type (AP or AR) of the EFT File created
The Batch Number  of the EFT File created

The Entry Number of the EFT File created - if selected entries were exported.  This field will be
blank if the entire batch was exported
The Bank Code of the EFT File created

The Bank Name of the EFT File created
The path and file name of the EFT File created

The user id who created the EFT File

EFT TRANSFER DETAILS REPORT - FEATURES
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The EFT Transfer Details report lists the files that have been created with the bank details, the date and
time run, the type of file and the payment / receipt batch number used and the file path and name, the
associated customer/vendor id, name, bank account details and amount.

Information printed on the report
The report lets you filter by the EFT File creation date and the EFT File creation number.

The report lists:

Date the EFT File was created
Time the EFT File was created

The Batch type (AP or AR) of the EFT File created
The Batch Number  of the EFT File created

The Entry Number of the EFT File created - if selected entries were exported.  This field will be
blank if the entire batch was exported
The Bank Code of the EFT File created

The Bank Name of the EFT File created
The path and file name of the EFT File created

The user id who created the EFT File

FOR A/P PAYMENT FILES

Vendor ID
Vendor name

Vendor Account Name
Vendor Bank Name

Payment Amount

FOR A/R RECEIPT FILES

For A/R Receipt  files
Customer ID

Customer name
Customer Account Name

Customer Bank Name
Receipt Amount

FOR A/R REFUND FILES

Page 108 of 224 EFT Processing reports



Orchid EFT Processing

Customer ID
Customer Name

Customer Account Name
Customer Bank Name

EFT AUDIT LOG REPORT - FEATURES
This report lists the fields that have been changed on the Customer and Vendor bank details, the date
and time the amendments happened and the user id of the user who did the change.

Information printed on the report

The report lists:

Date the amendment was done
Time the amendment was done

User id of the logged on user who did the amendment
ELCUST if the amendment was done to a customer record, ELVEND if the amendment was done to
a vendor record, ELEMP if the amendment was done on an Employee record.

The field name which was changed
The old value (the value of the field prior to the amendment)

The new value (the value of the field after the amendment)

RECEIPT BATCH AUDIT REPORT - FEATURES
This report lists the selection criteria and customer/document exclusions that were set at time of running
the Create Receipt Batch process in EFT Processing.

Information printed on the report
The Report lists:

Date
Time
User
Customer Name and Number
Document Number

UPDATE INVOICE DUE DATE REPORT - FEATURES
This report lists the invoice due dates that have been updated in EFT Processing
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Information printed on the report
The Report lists:

- Date
- Time
- User
- Customer Name and Number
- Original Document Date
- Amended Document Date
- Original Discount Date
- Amended Document Date

EFT PAYROLL TRANSFERS CREATED REPORT - FEATURES
This report lists the files that have been created with the bank details, the date and time run, the type of
file and the payroll number used and the file path and name.

Information printed on the report

The report lists:

Date the EFT File was created
Time the EFT File was created

The Pay Period End Date the EFT File created

The Entry Number of the EFT File created - if selected entries were exported.  This field will be
blank if the entire batch was exported
The Bank Code of the EFT File created

The Bank Name of the EFT File created
The path and file name of the EFT File created

The user id who created the EFT File

EFT PAYROLL TRANSFER DETAILS REPORT - FEATURES
This report lists the files that have been created with the bank details, the date and time run, the type of
file and the Payroll Run number used and the file path and name, the associated employee id, name,
bank account details and amount.

The report now also includes the cheque, payment or EFT reference number.
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How to use with Canadian Payroll: 
The default report (elpayd.rpt) is configured for use with Canadian Payroll (CPxxA).

How to use with US Payroll
If you use US Payroll (UPxxA) , you need to use the elpayd-UP.rpt.

Rename the elpayd.rpt report to elpayd-CP.rpt in the ELXXA>ENG folder.
Rename the elpayd-UP.rpt to elpayd.rpt
You can run the report.

Information printed on the report
The report lists:

Date the EFT File was created
Time the EFT File was created

The Pay Period End Date of the file created

The Entry Number of the EFT File created - if selected entries were exported.  This field will be
blank if the entire batch was exported
The Bank Code of the EFT File created

The Bank Name of the EFT File created
The path and file name of the EFT File created

The user id who created the EFT File

FOR US AND CANADA PAYROLL FILES

Employee ID
Employee name

Employee Account Name
Employee Bank Name

Payment Amount
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EFT Reference Material
This includes detailed description of fields and controls on EFT processing screens.

Important! Some fields and screens may be displayed only if you have an activation code that
includes both EFT Processing (A/P and A/R) and EFT Processing (Payroll).

EFT Options Screen Guide 113
SMTP Email Examples 128
Using Orchid Modules with Office365 App Passwords 131
Office365 and Legacy Authentication 136
Email Troubleshooting 140
Global File Sequence Example 142
EFT Banks Setup Screen 146
EFT Vendors - Setup Screen 154
EFT Customers - Setup Screen 158
EFT Employees- Setup Screen 161
Password Formulas 165
Password Examples 169
Email Messages - Variables to include 171
Sample EFT Email Messages 177
EFT Setup- Receipt/Refund Selection Codes - Field List 179
View/Clear Completed EFT Payroll Logs 183
Orchid Module License Screen 184

EFT OPTIONS SCREEN GUIDE
On the EFT Processing Options screen, you can select options that specify how EFT files are generated
and how documents are emailed.

This includes the option to encrypt bank details displayed in EFT Processing and to password protect
remittance advices.

Tip: Different fields and functionality can be available on the EFT Setup and EFT Transactions screens
depending on the selected options.

TO OPEN THIS SCREEN
Open EFT > EFT Setup > Options
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A/P Tab 
Use the A/P Tab to configure EFT Options to create Payment Files

A/P Tab Fields and Controls

ALLOW EFT FILE CREATION FROM A BATCH RANGE?:
Select this option, to allow or disallow the selection of a range of AP Payment batches from
the EFT Create File form.

If set to "No", you may only select a single AP Payment batch for file creation.
If set to "Yes", you may select a range of AP Payment batches using the finders. One
EFT file will be created for the range of batches selected and the bank will default to
the bank code of the first batch in the range.

ALLOW UNPOSTED BATCHES TO BE SELECTED?
Select this option if you wish both posted and unposted AP Payment batches to be dis-
played by the Finder on the EFT Create File form.

If you select "Yes" both posted and unposted AP Payment  batches will be displayed
via the Finder.
If you select "No", only posted AP Payment batches will be displayed via the Finder.

IF A VENDOR IS NOT DEFINED IN EFT VENDORS
Select this option to control what happens when a vendor is not defined in EFT Vendors.

Skip the vendor and continue the export - selecting this option enables a tick box on the
EFT Create File screen which will allow you to determine whether an error is generated for each
run. EFT Create File will ignore all transactions for AP Vendors  which have not been defined in
EFT Vendors and produce a file for those AP Vendors which have been defined in EFT Vendors.
Display an error and abort the export - selecting this option will generate an error message
for each AP Vendor which is not defined in EFT Vendor and abort the export. The EFT Vendor
can then be added and the file export resumed.

ALLOW SELECTIVE PAYMENTS FROM AN A/P BATCH
Select this option to allow selective records from an A/P Payment batch to be transmitted
via EFT.

ALLOW MULTIPLE VENDOR BANK ACCOUNT DETAILS, ONE PER EFT FILE TYPE
Select this option to allow multiple vendor bank account details, per EFT file type.
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Tip: If you only make EFT transactions from one bank account and only have one
EFT File Type in use, do not select this option and use the default EFT File Type. This sim-
plifies the data entry and reduces the risks of duplicate account details.

DEFAULT VENDOR STATUS
Select "Entered" to enable 2-step approvals of EFT Vendor details.

Only users with Security rights to Approve/View Unencrypted Vendor Bank

Details can set the status to "Active".

Status needs to be Active to create an EFT File.

Tip: Refer to: Approving changes of EFT Vendor/Customer/Employee details on page 19
for details on how to use this option.

DUPLICATE BRANCH / ACCOUNTS
Select the appropriate action for duplicate Branch/Account numbers for EFT Vendors:

Ignore: no validation
Warning: you can enter duplicate details, but users receive a warning message.
Error: you cannot enter duplicate details.

ENCRYPT BANK DETAILS
Select this option to encrypt bank details on the Sage 300 screens. When the Encryption
option is selected:

Users with "View only" security rights will only see the last 4 digits of the Vendor
Bank & Account details.
Any pre-existing records in EFT Vendor will be encrypted.
When generating an EFT File to upload to the bank, the unencrypted values will auto-
matically be inserted into the file.

Note: When you first select the "Encrypt" option, all existing bank details are
encrypted.

Tip: When using the option to Encrypt details, use Sage 300 Security Groups
for EFT and include a limited number of users in a group with rights to
"Approve/View Unencrypted Vendor Bank Account Details".

USE REMITTANCE ADVICE PASSWORD?
Select this option if you wish to password-protect a Remittance Advice when emailing it to
the Vendor.
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Important! The option to add a password to the PDF is only available if send-
ing emails through EFT SMTP. So you need to configure the A/P Email server
details.

PASSWORD FORMULA
Enter the formula for the password the Vendor will use to open their Remittance Advice PDF. 
(See Password Formulas on page 165 for more details.)

Tip: You can view the auto-generated password for each Vendor in EFT Vendors.

VENDOR PDF MASTER PASSWORD
Enter the master password for all Vendors' Remittance Advices, if required.  If used, any
encrypted PDF can be opened using either the Vendor’s password or the Master password.

A/P Email Tab
The Email tab lets you define your email server. When you fill in the email option on the EFT Processing
Options, it will email directly to your email server using the selected service. You can email documents
using 2 methods, SMTP with basic authentication or App password or Microsoft Graph (when using
Microsoft Office 365 and SMTP basic authentication is not enabled).

Email Service

SMTP (Simple Mail Transfer Protocol). You can use your own SMTP server, or an SMTP ser-
vice.

Example: SMTP Email Examples on page 128

Microsoft Graph. This service sends email via Microsoft Office 365. It is generally used when
SMTP Basic authentication is not enabled in Office 365.

Refer to Office 365 and Microsoft Graph

Note: Microsoft Graph is available in the latest product updates for Sage 300 versions 2020
and above, since October 2022.

SMTP FIELD DETAILS:
Email Server : smtp.domain.com:587 Enter the details of the SMTP Server you want to
email from.

Port: There is no specific field for the Port in Orchid modules. You can specify a port num-
ber after filling in the email server details.  After the email server name, enter “:xx” i.e.
colon  xx where xx is the port number required.

Tip: The default port is generally port 587 with TLS.
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Example: smtp.office365.com:587

Email User and Email Password: Enter a correct combination of Email user and

password

Note: If using multi-factor authentication and App password, enter the App
password you create in he Email Password field. Refer to Using Orchid Modules
with Office365 App Passwords on page 131

Email Comes From: Enter the email address to be used when sending email.

Example: Orchid.Systems.Modules@gmail.com . You can also enter it in the
format {name} <{address}> e.g. Orchid Systems <Orchid.Sys-
tems.Modules@gmail.com>

Note: Depending on the SMTP server you use, this address may need
to match the one you enter in the Username field, or may not work
unless you set up an email alias. Consult your SMTP server doc-
umentation for details about sending email.

MICROSOFT GRAPH

Microsoft Graph:

This service sends email via Microsoft Office 365 where basic authentication is not enabled to use
SMTP.

Refer to Office 365 and Microsoft Graph

Tenant ID. Enter the tenant ID (alternatively called the directory ID) from your Microsoft
365 account.

Client ID. Enter the client ID (alternatively called the application ID) from your Microsoft
365 account.

Client Secret. Enter the client secret from your Microsoft 365 account.

Tip: This is actually the secret value, not the one called Secret ID. It is the one
that you only see once when you first create the client secret.

Tip: The client secret is valid for 2 years maximum. You may need to create a
new client secret if emailing with MS Graph suddenly stops working.

From Email Address. Enter the email address to be used when sending email.

LIMIT SENDING OF EMAILS AND EMAIL LIMIT PER MINUTE/SESSION
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Configure limits when sending emails: (None / Per Minute / Per Session)

If you are getting errors relating to "exceeding limits" when sending email remittance
advice, you can configure the options to Number of emails per minutes or Number of
emails per session to match the requirements of your email server.

Defaults to "None".
Choose Per Minute if your email server has a limit per minute when send-
ing SMTP emails (e.g. Office 365).
Choose Per Session if your email server has a limit per session.
Enter the number of emails to send per minute or per session.

How does it work?

When printing Advices and if the number of advices is greater than the limit, EFT will send
the number entered in the limit, then pause if "per minute" is selected or Disconnect and
start a new session if using "Per session" is selected.

Example: Limit per minute: If you set the limit to 30 per minute and you email 50 remit-
tance advices, EFT Processing will send the first 30, pause for a minute, send the next 20,
and will then display the result.

Example: Limit per session: If you set the limit per session to 10 and you select to Print/E-
mail a batch of 50 remittance advices, EFT Processing will make a connection to the
SMTP Server, send 10 emails (1 to 10), disconnect, then reconnect, send the next 10
emails (11 to 20), disconnect, connect again, send the next 10 emails (21 to 30), dis-
connect, etc. When all emails are sent, it will display the delivery results.

Note: If you set the number of emails to 0 (per minute or per session), the
emails will be sent with no limits (the same way as with the "None" option)

-A/R Tab
Use the A/R Tab to specify options to use when creating A/R Files to process Direct debit and
AR Refunds files.

A/R TAB FIELDS AND CONTROLS

Allow EFT file creation from a batch range?

Select this option, to allow or disallow the selection of a range of AR Receipt batches from
the EFT Create File form.
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If set to "No", you may only select a single batch for file creation.
If set to "Yes", you may select a range of AR Receipt batches using the finders. One
EFT file will be created for the range of batches selected and the bank will default to
the bank code of the first batch in the range.

Allow unposted batches to be selected?

Select this option if you wish both posted and unposted AR Receipt batches to be dis-
played by the Finder on the EFT Create File form.

If you select "Yes" both posted and unposted AR Receipt batches will be displayed
via the Finder.
If you select "No", only posted AR Receipt batches will be displayed via the Finder.

If a customer is not defined in EFT Customers

Select this option to control what happens when a customer is not defined in EFT Cus-
tomers.

Skip the customer and continue the export - selecting this option enables a tick
box on the EFT Create File screen which will allow you to determine whether an error
is generated for each run. EFT Create File will ignore all transactions for AR Cus-
tomers which have not been defined in EFT Customers and produce a file for those
AR Customers which have been defined in EFT Customers.
Display an error and abort the export - selecting this option will generate an error
message for each AR Customer which is not defined in EFT customers and abort the
export. The EFT Customer can then be added and the file export resumed.

Allow Selective receipts from an A/R Batch

Select this option to allow selective records from an A/R Receipt or Refund batch to be
transmitted via EFT.

Allow Multiple Customer bank account details, one per EFT File Type

Select this option to allow multiple Customer bank account details, per EFT file type.

When creating the EFT File, EFT will use the bank account details for the specified EFT File
Type if it exists. If there is no entry for the Customer and EFT File Type combination, then it
will use the default bank account details for the Customer (ie where the EFT File Type is
blank).

Tip: If you only make EFT transactions from one bank account and only have one
EFT File Type in use, do not select this option and use the default EFT File Type. This sim-
plifies the data entry and reduces the risks of duplicate account details.

Default Customer Status
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Select "Entered" to enable 2-step approvals of EFT Customer details. Refer to Approving
changes of EFT Vendor/Customer/Employee details on page 19 for details.

Only users with Security rights to Approve/View Unencrypted Customer Bank

Details can set the status to "Active".

Status needs to be Active to use the record (EFT Vendor, Customer or Employee) in the
Create EFT File process.

Duplicate Branch / Accounts

Select the appropriate action for duplicate Branch/Account numbers for EFT Customers:

Ignore: no validation
Warning: you can enter duplicate details, but users receive a warning message.
Error: you cannot enter duplicate details.

Encrypt Bank details

Select this option to encrypt A/R Customers bank details.

Only the last 4 digits are displayed on the screen if your security profile does not
include: Approve/View Unencrypted Customer Bank Account Details

Note: When you first select the "Encrypt" option, all existing Customers' bank
details are encrypted.

Tip: When using the option to Encrypt details, make sure that you use Sage
300 Security Groups for EFT so that only a limited number of Admin users can
change the EFT Options. Refer to Adding Security on page 40.

Use Remittance Advice Password?

Select this option if you wish to password-protect a Remittance Advice when emailing it to
the Customer.

Important! The option to add a password to the PDF is only available if send-
ing emails through EFT SMTP. So you need to configure the A/P Email or
A/R Email server details in EFT Options.

Password Formula

Enter the formula for the password the Customer will use to open their Remittance Advice
PDF.  (See Password Formulas on page 165 for more details.)

Tip: You can view the auto-generated password for each Customer in EFT Customers.

Customer PDF Master Password
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Enter the master password for all Customer Remittance Advices, if required.  If used, any
encrypted PDF can be opened using either the Customer’s password or the Master pass-
word.

A/R Email Tab
The Email tab lets you define your email server. When you fill in the email option on the EFT Processing
Options, it will email directly to your email server using the selected service. You can email documents
using 2 methods, SMTP with basic authentication or App password or Microsoft Graph (when using
Microsoft Office 365 and SMTP basic authentication is not enabled).

Email Service

SMTP (Simple Mail Transfer Protocol). You can use your own SMTP server, or an SMTP ser-
vice.

Example: SMTP Email Examples on page 128

Microsoft Graph. This service sends email via Microsoft Office 365. It is generally used when
SMTP Basic authentication is not enabled in Office 365.

Refer to Office 365 and Microsoft Graph

Note: Microsoft Graph is available in the latest product updates for Sage 300 versions 2020
and above, since October 2022.

Refer to EFT Processing Email Tab on page 56 for details to configure the fields.

Tips:
If left blank, EFT Processing will use the SMTP Details on the A/P Email Tab.

If A/P Email tab SMTP details are also blank, Sage 300's configuration to send emails will be used.

Primary File Type Tab

Primary File Type Tab Fields and Controls

Select the Primary Bank File Type for this company.  It is used to display fields on the EFT Vendor and Cus-
tomer screens. Vendor and Customer fields can be re-labeled and extra fields enabled as defined in the
file format (in the formats.ini or the userformats.ini).

Note: If you can't see certain field labels in EFT Vendors or EFT Customers, it is often because the
EFT Primary Bank field is blank on the Primary File Type

FIELDS WHICH CAN BE RE-LABELED AND VALIDATED ON EFT
VENDORS/CUSTOMERS":

EFT Reference Material Page 121 of 224

../../../../../../Content/Shared/ModuleOptions/Office365-MSGraph.htm


Orchid EFT Processing

BSBNumber
AccountNumber
AccountName
PaymentReference
You can also turn on 50 extra fields (DestExtra1 to DestExtra50), based on the bank's require-
ments.

Note: You can also relabel, validate and add Extra fields to EFT Bank by selecting the bank's file type in
EFT Banks. Refer to details in EFT Banks Setup Screen on page 146

The Primary File Type Tab is also used to enable the Encryption of Bank Details.

ENCRYPT BANK BSB/ACCT.NO
The following applies to the Encryption option on EFT Options A/R, A/P and Primary
Bank.

When the "Encryption" option is ticked, users with "View only" security rights
will only view the last 4 digits of the bank details. The audit log for EFT files gen-
erated when Encryption is ticked will also show only the last 4 digits of the
bank details.
You can setup Users in a security group that includes the right to view "Unen-
crypted Details" (There are separate groups to View Unencrypted Vendor Bank
Details, View Unencrypted Customer Bank Details and View Unencrypted Bank
Account Details). Refer to Adding Security on page 40
When the EFT File is generated, the unencrypted values will automatically be
inserted in the file.
If the Encryption option is selected after you have entered some EFT Cus-
tomers or Vendors Bank Details, the existing records in EFT Vendors and
EFT Customers setup will be encrypted. However, the audit log for files gen-
erated before Encryption was selected will not be encrypted. You will need to
purge the audit log files if you want to remove all unencrypted data.

Tip: When importing EFT Vendors, EFT Customers and EFT Banks, you should not
import the Encrypted Bank Branch and Account number and Credit Card Number
fields (fields containing an "X"). These fields should only be set using the asso-
ciated views, and set to the calculated encrypted value. - EFT Import functionality
prevents such fields to be imported.

Default Advice Tab
This tab lets you define default Crystal reports for advices and reports generated in EFT Processing,
including AP Remittance advice, AR Direct Debit advice, AR Refund Remittance Advice, Payroll
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Remittance advice, Payroll Payslip/Paystub report, Payroll Releve 1 and T 4 reports.

You can also use this Tab to configure a folder to save the payslips/stubs PDF.

How to use: 
If you define default reports on this tab, then when printing remittance advices, the forms will default to
the Crystal report form setup on this tab.

Important! If a user does not have the security to "Select Remittance Advice Layout", then
they will not be able to override this default.

DEFAULT ADVICE FIELDS AND CONTROLS

Default A/P Remittance Advice

To set one of the defaults, click the browse button and browse the network to find the
appropriate Crystal form.

Default A/R Direct Debit Advice

To set one of the defaults, click the browse button and browse the network to find the
appropriate Crystal form.

Default A/R Refund Advice

To set one of the defaults, click the browse button and browse the network to find the
appropriate Crystal form.

Default Payroll Remittance Advice

This form is used when sending Payroll Remittance Advices. To set one of the defaults, click
the browse button and browse the network to find the appropriate Crystal form.

Refer to EFT Payroll Print Remittances Advices on page 96

Payroll Payslip/stub report

Enter or browse to find the relevant Sage 300 CP or UP Payslip/stub report from the rel-
evant CPxxA or UPxxA directory (e.g. CPCHK4A.RPT in the CP68A folder if you run version
2021).

Payroll Relevé 1s report

Enter or browse to find the CTR1BLK.RPT Sage 300 Payroll Relevé 1 report from the rel-
evant CTxxA directory (e.g. CT73A\ENG\CTR1BLK.RPT). This applies only to Canadian
Payroll.

Payroll T4s report
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Enter or browse to find the CTT4BLK2..RPT Sage 300 Payroll T4 report from the relevant
CTxxA directory (e.g. CT73A\ENG\CTT4BLK2.RPT).This applies only to Canadian Payroll .

Payroll T4As report

Enter or browse to find the CTT4A..RPT Sage 300 Payroll T4As report from the relevant
CTxxK directory (e.g. CT73K\ENG\CTT4A.RPT).This applies only to Canadian Payroll .

Payslip / Paystub Print Directory

Enter the UNC path for the parent directory where the Payslip/stub PDF files are to be saved. 
EFT Processing will automatically create a subfolder for each Sage 300 Company and a sub-
folder for each Employee ID.

Note:
If you select "Use Remittance Advice Password" option on the Payroll Tab, the password is
used to save a copy of the PDF payslips.

However, the pdf attached to payroll emails (both payslips and remittance advice) only has a
password if you send emails through EFT SMTP and you have configured A/P Email Server or
Payroll Email server details in EFT Options. Attached PDF files don't have a password when
using Sage SMTP Server or Outlook.

EFT Processing Remittance Advice Report Formats

EFT Processing includes default remittance advice Crystal Reports in the ELxxA>ENG folder.

Note: If you need to amend the reports, you can use Sage 300 Customization Directories.

DETAILS OF EFT PROCESSING ADVICE FORMATS: 

EFT Processing installs with the following A/P remittance advice formats, with different pay-
ment formulas:

ELPAY01 – payment date is based on the date when the EFT file was cre-
ated/generated.
ELPAY02 – payment date is based on the Batch Date.
ELPAY03 – payment date is based on the Batch Entry Date.
ELPAY05 – payment date is based on the effective date selected when the EFT file
was created/generated. This only applies if the EFT format you use supports effective
date.

EFT Processing installs with the following A/R remittance formats:

For A/R Receipts
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ELREC01 – payment date is based on the date when the EFT File was cre-
ated/generated.
ELREC02 - payment date is based on the receipt entry date.

For A/R Refunds

ELREF01 – payment date is based on the date when the EFT File was cre-
ated/generated.
ELREF02 - payment date is based on the refund entry date.

Global FSN
This tab allows you to assign a Global File Sequence Number (FSN) across all EFT banks. The Global FSN
setup is used if you want to issue a single File Sequence Number across multiple banks.

GLOBAL FSN FIELDS AND CONTROLS

You have 10 Global File System Numbers that you can allocate to multiple banks on the EFT Banks
screen. Allocating the same Global File System Number to 3 banks (for example), will result in AP Pay-
ment Batches or AR Receipt batches from all 3 banks being allocated a sequential number from the
same source number. 

Note: If the EFT File format includes the Global File Sequence Number, you need to select the
"Global File Sequence Number" option to name the file.

Global FSN 1 .. 10

Enter a unique FSN.(File Sequence Number) Up to 10 Global FSN can be used.

Refer to Global File Sequence Example on page 142

Payroll Tab
Use the Payroll Tab to configure EFT Options to create Payroll Files.

PAYROLL TAB FIELDS AND CONTROLS

Allow EFT file creation from a payroll pay period end range?

Select this option, to allow or disallow the selection of a range of Payroll pay periods from
the EFT Create Payroll File form.

If set to "No", you may only select a single Payroll pay period for file creation.
If set to "Yes", you may select a range of Payroll pay periods using the finders. One
EFT file will be created for the range of Payroll pay periods selected and the bank will
default to the bank code of the first pay period selected.

If an employee is not defined in EFT Employees
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Select this option to control what happens when an employee is not defined in EFT Employ-
ees.

Skip the employee and continue the export - selecting this option enables a tick
box on the EFT Create Payroll File screen which will allow you to determine whether
an error is generated for each run. EFT Create Payroll File will ignore all transactions
for Employees  which have not been defined in EFT Employees and produce a file for
Employees which have been defined in EFT Employees.
Display an error and abort the export - selecting this option will generate an error
message for each Payroll Employee which is not defined in EFT Employees and abort
the export. The EFT Employee can then be added and the file export resumed.

Allow Selective payments from a Payroll pay period

Select this option to allow selective records from a payroll pay period to be transmitted via
EFT.

Default Employee Status

Select Entered, Active or Inactive as the default employee status. Use security to control
who can make employees active in Payroll.

Encrypt Bank details

Select this option to encrypt Employee's bank details on the Sage 300 screens. When the
Encryption option is selected:

Users with "View only" security rights will only see the last 4 digits of the Employee
Bank & Account details.
Any pre-existing records in EFT Employee will be encrypted.
When generating an EFT File to upload to the bank, the unencrypted values will auto-
matically be inserted into the file.

Note: When you first select the "Encrypt" option, all existing bank details are
encrypted.

Tip: When using the option to Encrypt details, make sure that you use Sage
300 Security Groups for EFT so that only a limited number of Admin users can
change the EFT Options.

Primary Bank

The Primary bank is used as the default file type on the Employee Setup Screens for field
labels.

You can add up to 50 extra fields for Employee.

Use Remittance Advice Password?
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Select this option if you wish to password-protect PDF Files attachments (Remittance
Advice and payslip/stub) when emailing PDF to the Employee.

This option is also used to password protect the Payslip/stub file saved if you configure a
Print folder in the EFT Options > Default Advice Tab.

Important! The option to add a password to the PDF attached to emails is
only available if sending emails through EFT SMTP. So you need to configure
the Payroll Email server or the A/P Email server details.

Password Formula

Enter the formula for the password the Employee will use to open their Remittance Advice
PDF.  (See Password Formulas on page 165 for more details.)

Employee PDF Master Password

Enter the master password for all Employees' Remittance Advices, if required.  If used, any
encrypted PDF can be opened using either the Employee’s password or the Master pass-
word.

Payroll Email Tab
Use the Payroll Email Tab to define the service and related details used to email payroll advices.

PAYROLL EMAIL TAB FIELD AND CONTROLS

The Email tab lets you define your email server. When you fill in the email option on the
EFT Processing Options, it will email directly to your email server using the selected service. You can
email documents using 2 methods, SMTP with basic authentication or App password or Microsoft
Graph (when using Microsoft Office 365 and SMTP basic authentication is not enabled).

Email Service

SMTP (Simple Mail Transfer Protocol). You can use your own SMTP server, or an SMTP
service.

Example: SMTP Email Examples on the next page

Microsoft Graph. This service sends email via Microsoft Office 365. It is generally used when
SMTP Basic authentication is not enabled in Office 365.

Refer to Office 365 and Microsoft Graph

Note: Microsoft Graph is available in the latest product updates for Sage 300 versions
2020 and above, since October 2022.

Refer to EFT Processing Email Tab on page 56 for details to configure the fields.
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Tips:
If details are left blank, EFT Processing will use the SMTP Details on the A/P Email Tab.

If they are both blank, EFT Processing uses the default Sage 300 method of sending e-mail via
Microsoft Outlook client or SMTP Details on Sage 300 Advanced ERP Company Profile.

SMTP EMAIL EXAMPLES

Email with Office 365
You can email from Orchid modules using Office 365. The exact steps depend on your Office 365 con-
figuration. You can choose SMTP with basic authentication, use MFA and App Password, or use Microsoft
Graph.

Using Office 365 and MFA

Although Orchid modules don't support 2-step authentication directly, you don't need to turn off MFA
to use email using SMTP or DML with SharePoint integration. If you enable MFA, you can use it for all
applications that support it.

To use Office 365 to email from Orchid modules and to use Document Management Link and
SharePoint integration, users need to create an APP password for use in the Orchid module, as sup-
ported by Microsoft. 

For details, refer to Using Orchid Modules with Office365 App Passwords on page 131

Configure Email when using Office 365
When using Office 365 to email, basic SMTP authentication is disabled by default and you need to use
Microsoft Graph as the email service.

Refer to Office 365 and Microsoft Graph
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Note:
The details below are left in the documentation if your Office 365 setup supports basic
SMTP Authentication and App Passwords.

Email Server -> smtp.office365.com:587

Email User -> username@samplecompany.com

Email Password -> Enter Password

If using Multi-factor Authentication and App Password, enter the App passwordl.

For details, see Using Orchid Modules with Office365 App Passwords on page 131

Encryption: TLS

TLS Version

You don't select a specific TLS version. Orchid uses the .Net SmtpClient class to send emails.
The SMTP Client uses the protocol configured on the operating system, based on the
.NET version installed.

The email function supports Ssl3, Tls1.0, Tls1.1, Tls1.2 and Tls1.3.

Microsoft has recently stopped support for TLS1.0 and TLS1.1. Support for TLS 1.2 was
added to Orchid modules in April 2020 and applies to Sage 300 versions 2018 and above.

Important! If you have any issues emailing, please ensure you download and install the
latest product update for your Sage 300 version.

Useful Links

Here is a link to Microsoft documentation on how to allow applications to send email via Office365.
http://technet.microsoft.com/en-us/library/dn554323.aspx

Using Gmail
You can configure Orchid modules to email using Gmail.

Since May 2022, you cannot disable 2-step authentication in the Gmail settings and you need to use
App Password.

Email Server: smtp.gmail.com:587

Email User: username@gmail.com

Email Password: App password you create for the user emailing.

Tip: If there are spaces in the App password, remove the spaces before saving. Include only
the characters.

Encryption: TLS
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Note: In some older versions of Orchid modules, for Google mail to be setup in
Outlook/other email application/device (as recipient in CC/BCC), the Google email setting
has to have the option of enable POP/IMAP ticked.

When using any other email that has Transport Layer Security (TLS) encryption along with SMTP, you
can prefix the email server field with “TLS:”.

For e.g.. TLS:securemail.server.net

Using SendGrid
IF USING SENDGRID

Orchid module Email configuration using SendGrid:

Email Server -> smtp:sendgrid.net:587
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Email User -> apikey

Email Password -> Enter Password

Encryption: TLS

E-Email Comes From -> the email address associated with the Sendgrid account

Here is a link to SendGrid documentation on integrating with the SMTP API

Sendgrid: integrating-with-the-smtp-api

Here is a link on How to send email using the SMTP Relay

SendGrid smtp guide

Using Hotmail
CONFIGURE EMAIL WHEN USING HOTMAIL OR MICROSOFT OUTLOOK.COM

Email Server -> smtp.live.com:587

Email User -> username@hotmail.com

Email Password -> Enter Password

Encryption: TLS

USING ORCHID MODULES WITH OFFICE365 APP
PASSWORDS
Note: This applies to Emailing from Orchid modules and to the SharePoint integration in Document
Management Link for users where Multi-Factor Authentication (MFA) is enabled.

Using App Passwords
App passwords provide a way for applications to authenticate in Microsoft 365 when MFA policies are
enforced. It is Microsoft's approach to allow non-interactive login with a user name and complex pass-
word. Within the Microsoft 365 environment, the user creates an app password for the particular
instance when a non-interactive login is required. This password is not the user's regular password, ran-
domly generated and 16 characters long to make it relatively secure.

Refer to the Microsoft website for details on using app passwords: https://support.microsoft.com/en-
us/account-billing/using-app-passwords-with-apps-that-don-t-support-two-step-verification-
5896ed9b-4263-e681-128a-a6f2979a7944
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Key Steps

Generate an App Password in Office 365. 

Refer to the Microsoft Help for details. The exact steps depend on your Office 365 subscription type.
Below is a relevant example:

https://docs.microsoft.com/en-us/azure/active-directory/user-help/multi-factor-authentication-end-
user-app-passwords

Login to your Microsoft Account as the user you want to use
Choose View Account (in the top right of the screen)
Go to Security Info
Select Add a Method or Create and manage app passwords
Select create
Give the password a name e.g. Sage . This is for reference only. You do not use the name in the
Orchid module configuration.
Select next
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Copy the password to the clipboard

You might have to do that manually using CTRL-C

You can't view the password again, if you forget it, you need to create a new one in Step 1.

Enter the password in the module Options > Email screen

The user name is the email address used in Step 1.

You only use the App password in the password field.
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Save and test

Legacy Authentication
If you are getting an error such as "The sign-in name or password does not match one in the Microsoft
account system", and you have checked the basic account details, your site in Office 365 may be blocking
Legacy authentication.

Refer to Office365 and Legacy Authentication on the next page for detailed steps.
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OFFICE365 AND LEGACY AUTHENTICATION
If you are getting an error such as "The sign-in name or password does not match one in the Microsoft
account system", and you have checked the basic account details, your site in Office 365 may be blocking
Legacy authentication.

Refer to Microsoft's documentation on conditional policies.

https://docs.microsoft.com/en-au/azure/active-directory/conditional-access/howto-conditional-access-
policy-block-legacy

https://docs.microsoft.com/en-au/azure/active-directory/conditional-access/troubleshoot-conditional-
access-what-if

To change the settings:
1. Log on to the Office 365 account as a user with Admin Rights
2. In the Admin Settings, navigate to Azure Active Directory > Security
3. View Conditional Access
4. If you have any policy relating to "legacy authentication", exclude the users and groups that need

to use the SharePoint integration.
5. Refresh the tray after updating the policy.
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EMAIL TROUBLESHOOTING

Failure sending mail
If you get the error message “Failure sending mail” – check that you have entered the correct details in

The E-mail server field
The correct combination of email user/password/comes from fields. The combination and number
of these fields that are required depends on the configuration of the email server
The correct encryption method is selected
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Port

If the default port for email (25) is not in use, ensure the port is included in the Email server field
separated by a semi-colon (:). For example smtp.office365.com:587 if port “587” is being used for
e-mail.

Legacy Authentication

If you are using MFA and App password in Office 365, but are still receiving errors when testing the
SMTP email, ensure that Legacy Authentication is not blocked. Refer to Office365 and Legacy Authentic-
ation on page 136.

TLS Version

You don't select a specific TLS version. Orchid uses the .Net SmtpClient class to send emails. The
SMTP Client uses the protocol configured on the operating system, based on the .NET version installed.

The email function supports Ssl3, Tls1.0, Tls1.1, Tls1.2 and Tls1.3.

Microsoft has recently stopped support for TLS1.0 and TLS1.1. Support for TLS 1.2 was added to Orchid
modules in April 2020 and applies to Sage 300 versions 2018 and above.

Important! If you have any issues emailing, please ensure you download and install the latest product
update for your Sage 300 version.

You get the message “E-mail sent”, but no email is received,
In many cases, there is almost no delay the “E-mail sent” message being displayed on the screen after
clicking “Send Test E-mail”

Ensure the virus checker and firewall on all machines where e-mails are to be sent from. They must
be set to exclude “..\EL6xA\sendmail.exe”
If you get a File missing error, check that the anti-virus is not deeming the sendmail.exe a virus
threat.
SMTP Server may include configuration to expect a valid client certificate from the server-
/workstations where Sage is installed. Once the certificate is installed on the client, emails can be
sent.

You are able to send emails to internal email accounts, but not to external email accounts, the most likely
cause is that your email server requires a valid username /password for sending to external addresses
and the details entered are not correct.

Note: Check your email server to see if it requires a username/password.  Some require it to be blank,
for some it does not matter.
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Note: Some email servers will allow you to log on as a certain user and send email as anyone, others
will only allow you to send email as the logged on user. So if you log on as "Joe", but try to send as
admin@testdomain, some email servers won't allow it.

Exceeding email limit error -
This applies to EFT Processing only.

If you are getting errors relating to "exceeding limits" when sending email remittance advice, you can
configure the options to Number of emails per minutes or Number of emails per session to match the
requirements of your email server.

EFT Options Screen Guide on page 113

Process Scheduler emailing tips
When using Process Scheduler with Extender or Report Runner, the Process Scheduler email settings are
only used if the Schedule is configured to send emails on success or failure.

The Run Information Manager Step uses the SMTP Email configured in Information Manager a> Report
Runner and the Run Extender Script action uses the SMTP email configured in Extender.

When using Process Scheduler to email Reports configured in Report Runner, check the email con-
figuration in Information Manager, not just Process Scheduler.

When using Process Scheduler to run Extender scripts that send emails, check the email configuration in
Extender Options, not just Process Scheduler.

GLOBAL FILE SEQUENCE EXAMPLE
The File Sequence will be shared between whichever module/bank codes that use the same Sequence
number.

Refer to Global FSN Fields and Controls on page 125 and EFT Banks Form - Overview on page 60

Case scenario :

You have 2 accounts with RBC, one account (RBC01 bank code) is for trade operational pay-
able/receivable and the other one (RBC bank code) is for administrative expense.

You apply for single Originator ID/ User ID to upload Debit/Credit Transaction files to RBC Portal.

RBC required that each file submitted to the portal has running sequence number.

In EFT Bank Setup for these 2 bank codes, set to use Global Sequence Number.
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The numbering will be then based on Global FSN in the EFT Option.

As below it is stating that the next running number is 9.

When Create EFT file is run for payment batch, it will get the next sequence number as the file name.
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The subsequent file run either from AR Receipt Batch for the same bank code or RBC bank code, it will
share the same Sequence Numbering.
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EFT BANKS SETUP SCREEN
Tip: The field names might be different depending on the Default Bank File Type set up in
EFT Setup > Options > Primary File Type Tab or File Type entered on the EFT Vendor or Cus-
tomer screen.

Use this screen to setup EFT bank details for banks setup in Sage 300 Bank Services and configure how to
generate EFT files for Payments/Refunds, Receipts and Payroll files.

Tip: Use the Finder to select a bank already configured in EFT Banks, use the Zoom button
to select a bank from Bank Services.

Fields and Controls
BANK CODE
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Enter a Bank Code as defined in Bank Services.

BANK NAME

The name of the bank account, up to 60 characters.

BANK TYPE

Select "Regular" for EFT to process the transaction

Select "Clearing Bank" If you want the AP Payment batch to post to Bank Services in total, as a
single entry per EFT Payment.

See Setup and Use EFT Clearing Bank on page 30 for details on how to process your payments using
a clearing bank.

FOR BANK

This field is enabled if the "Clearing Bank" bank type has been selected. By clicking on the search
button, select which bank code is applicable.

CLEARING TRANSFER NUMBER

Select Use Next Bank Transfer Number to let Bank Services generate the transfer number

Select Use AP Batch Number to use the AP Batch Number as the Transfer Number . Use this
option to facilitate bank reconciliation, for example when using OFX import.

This field is enabled if the "Clearing Bank" bank type has been selected.

BSB NUMBER

Type the banking industry code that identifies this bank.

If EFT Processing Options / Primary Bank / Encrypt Bank BSB/Acct. No. is selected, you will only see
the last 4 digits of the details entered.

ACCOUNT NUMBER

Type the number of the bank account (assigned to the account by your bank).  The number can be
up to 22 characters.

ACCOUNT NAME

Type the name of the bank account .

EXTRA FIELDS

Depending on the File Type selected below and the formats.ini file, up to 10 additional fields can be
configured.

Example: in Canada: Destination Data Centre and Short Name.
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TYPE TAG

This applies to ISO20022 file types only, depending on the bank specifications.

if there is an originator ID, update this field with ‘Othr’.

If there isn’t an Originator ID, update this field with ‘BIC' or 'BEI’ and set the OrgID field with the BIC
code.

Payments and Refunds Tab
Output Destination: 

Select where you wan t to save the file :

File : You need to enter the EFT File path where the file will be saved.

Tips:
Use UNC Path

EFT doesn't support uploading to SharePoint directly. To upload an EFT File to
SharePoint, you would need to sync the appropriate SharePoint drive to a network
folder or a local folder. Then setup the EFT File path as the local sync drive

Download: Choose this option to download the file to your local machine before uploading to the
bank.

Tip: This is particularly relevant when using EFT web screens as the user may not have
access to the server.

SFTP: You need to fill in the FTP Host Name and credentials to connect to the FTP site.

When using SFTP, you can select to enter user name and password or SFTP with Key file or both.,

Select SFTP -2FA if your bank uses 2 factor authentication and requires both a username and pass-
word and a key file.

Refer to Setup SFTP Output Destination on page 23 for details on setting up SFTP to send EFT files.

Tip: Use the Test SFTP File Upload button to test before uploading a file.

Key File: 

If you select Key File then you enter the key file filename and (optionally) a password for the file. The
key file should be either on a local drive (eg c:) and will need to be copied to each computer running
the Create EFT function, or on a network share.

The key file can have a password too if required by the bank.

File Naming: 
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File Sequence Number: the file will be called the File Sequence number on the bank, and after
using the file sequence number, EFT Processing will increase the file sequence number by 1.

Note: If the EFT File format includes the File Sequence Number, you generally select the
"File Sequence Number" option to name the file. If you select Batch Numbering to name
the file, EFT Processing uses the batch number as the [FSN] value.

Batch Number : the file will be called APbbbb.{ext} or ARbbbb.{ext} where bbbb is the batch num-
ber being exported.

Pay Period End Date YYYYMMDD: for EFT Payroll files

Fixed File Name : User defined file name using any characters plus the following variables in the
file name :

{yyyy} for the year, {mm} for the Month, {dd} for the Day
{bbbb} up to 4 numbers for the batch number
{N} gives you a running number starting from 0 each day. This is often used in conjunction with
batch number to keep track of the number of exports in a calendar day.
{S} gives you a running sequence number for the selected bank- You can use up to 4 numbers
for the file sequence number. You typically use this option instead of batch number for a
unique number per file.
{entry} for the entry number, this works with option that each entry to be generated in a single
file.

Example: You can use up to 4 digits for {B}, {S} and {N}
Example for Batch Number 2
{b} for 1 digit, e.g. 2
{bb} for 2 digits, e.g. 02
{bbb} for 3 digits, e.g. 002
{bbbb} for 4 digits, e.g. 0002

Global Sequence 1..10. You are able to share a Global File Sequence number between multiple
banks if required. EFT Processing will increase the global file sequence number used by one after cre-
ating the file.

Note: If the EFT File format includes the Global File Sequence Number, you need to select the
"Global File Sequence Number" option to name the file.

Example: Global File Sequence Example on page 142

EFT FILE PATH

Click the Browse button to select the path the files will be exported to. Ensure that you have sufficient
rights to access the folder.
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Tip: Use UNC Path so that all users and workstations can access the folder. If using mapped drive,
there is a risk that some users have a different drive mapping.

EFT FILE EXTENSION

Enter the required file extension.

EFT FILE TYPE

Select the required file type by using the Finder.

See System Formats and User Formats

A/P PAYMENT REFERENCE

Enter a payment reference code.

Note: The field name may be re-labelled based on the EFT format for the selected file type.

FILE SEQUENCE NO

The FSN field on the EFT Bank is next sequence number (the one that is going to be used for the next
EFT Run).

If the file name is set to "File Sequence Number", this number is updated when you create the
EFT file.

Tip: If you need to reexport a file, set the file sequence number back by 1 to generate the file with
the same number.

Receipts Tab
Use the Receipts Tab to configure EFT Files generated for A/R Receipt Batches.

Output Destination: 

SFTP: You need to fill in the FTP Host Name and credentials you want to use. Refer
to Output Destination:  on page 148
File : No additional parameters needed. Enter the File path and extension below.

File Naming: 

Choose Same as Payments to use the settings on the Payments and Refunds Tab

or You can select the file name from the following
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File Sequence Number: this uses the File Sequence Number on the EFT Banks
Payments & Refunds tab or Receipts Tab, and adds 1 to it.
Batch Number: from the Batch number entered
Fixed Name: you can type in the file name at the end of the EFT File Path, and can
include the variables highlighted on the right hand side of the screen. Variables
include the current date and time, the batch number, the file sequence number and
fixed text.
Global Sequence 1..10: this gives you 10 File Sequence Numbers that can be
used across multiple banks.

EFT FILE PATH

Click the Browse button to select the path the files will be exported to. (Ensure that you have suf-
ficient rights to access the folder.

Tip: Use UNC Path so that all users and workstations can access the folder. If using mapped drive,
there is a risk that some users have a different drive mapping.

EFT FILE EXTENSION

Enter the required file extension.

EFT FILE TYPE

Select the required file type by using the Finder. The available file types is derived from all the file
types in the formats.ini file and the userformats.ini file.

See System Formats and User Formats for additional details.

A/R RECEIPT REFERENCE

Enter a receipt reference code.

FILE SEQUENCE NO

The FSN field on the EFT Bank is next sequence number (the one that is going to be used for the next
EFT Run).

If the file name is set to "File Sequence Number", this number is updated when you create the
EFT file.

The File Sequence Number is updated when you generate the EFT file.

Users who Generate the EFT File need to have security rights to update EFT Bank as the FSN is stored
on the EFT Bank record.

If a user doesn't have rights to EFT Banks and uses a file format that requires FSN, they may get an
error message like below: 
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Warning! Permission Denied delete on EFT Bank. Please check with your administrator.

Tip: If you need to reexport a file, set the file sequence number back by 1 to generate the file with
the same number.

Payroll Tab
Output Destination: 

SFTP: You need to fill in the FTP Host Name and credentials you want to use. Refer to
Output Destination:  on page 148
File : Enter the file path below.

File Naming: 

You can select the file name from the following:

File Sequence Number: this uses the File Sequence Number on the EFT Banks Payroll Tab,
and adds 1 to it.
Pay Period End Date YYYYMMDD
Fixed Name: you can type in the file name at the end of the EFT File Path, and can include the
variables highlighted on the right hand side of the screen. Variables include the current date
and time, the batch number, the file sequence number and fixed text.
Global Sequence 1..10: this gives you 10 File Sequence Numbers that can be used across
multiple banks. Global File Sequence Example on page 142

EFT FILE PATH

Click the Browse button to select the path the files will be exported to. Ensure that you have sufficient
rights to access the folder.
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Tip: Use UNC Path so that all users and workstations can access the folder. If using mapped drive,
there is a risk that some users have a different drive mapping.

EFT FILE EXTENSION

Enter the required file extension.

EFT FILE TYPE

Select the required file type by using the Finder.

See System Formats and User Formats

REFERENCE

Enter a payment reference code.

Note: The field name may be re-labelled based on the EFT format for the selected file type.

FILE SEQUENCE NUMBER

The FSN field on the EFT Bank is next sequence number (the one that is going to be used for the next
EFT Run).

If the file name is set to "File Sequence Number", this number is updated when you create the
EFT file.

The File Sequence Number is updated when you generate the EFT file.

Users who Generate the EFT File need to have security rights to update EFT Bank as the FSN is stored
on the EFT Bank record.

If a user doesn't have rights to EFT Banks and uses a file format that requires FSN, they may get an
error message like below: 

Warning! Permission Denied delete on EFT Bank. Please check with your administrator.
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Tip: If you need to reexport a file, set the file sequence number back by 1 to generate the file with
the same number.

EFT VENDORS - SETUP SCREEN
Use this screen to enter the EFT Details for Vendors setup in Sage 300 Accounts Payable. Details include
bank details as well as advice delivery method. You can choose to encrypt the bank details on the screen
in EFT Options.

Fields and Controls
Vendor Number

Identifies the vendor in Accounts Payable.

Select an existing vendor record that has been configured in , type its number or choose it
from the Finder in the Vendor Number field.

Tip:

You can use the Drill-down Icon to open the related A/P Vendor screen. This is useful
to check the Vendor's delivery method for example.
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Remit To

The Remit-to field is optional. If a vendor only has one bank account, you should leave the
Vendor Remit-to code blank in EFT Vendors.

The Remit To gives you the option to record different vendor bank details for each Remit To
location that has been setup in A/P Remit-To Location.

If you have multiple bank account details for the same vendor, then you can set up one EFT
Vendor record per Vendor/Remit-to code combination in addition to the EFT Vendor record
with the blank Remit-to code.

Example:
Detailed example is available: Setup EFT Vendor with multiple bank accounts

Note:
With this setup for your EFT Vendors, if you create an AP Payment entry to a specific Ven-
dor/Remit-to code combination, EFT Processing will apply the following rules to work out
which EFT Vendor record (and therefore bank details) to use when creating the EFT File: 

Search for an EFT Vendor record with the same AP Vendor code and AP Remit-to
code - use this record as a first choice
Search for an EFT Vendor record with the same AP Vendor code and a blank Remit-to
code - use this record as a second choic
Report an error that there is no EFT Vendor record for the AP Payment entry

File Type

The File Type field is optional.  If this option is enabled, you have a Finder to select the EFT Vendor, and
another to select the EFT File Type. You can then select a file type to record different bank account
details for the Vendor according to the file type.

If you leave this field blank, then EFT will use the file type that has been assigned in EFT Options >
Primary Bank Setup to label the fields and enable EFT Vendor extra fields.

Note: The File Type field is only available if you select "Allow multiple Vendor bank account
details one per EFT file type in EFT Setup > Options > AP Tab. Change the option and restart
the screen if you don't see the field.

Example:
Detailed example of setting up EFT Vendor is available: Setup EFT Vendor with multiple file
types

Delivery Method

AP Vendor Delivery Method: EFT will use the setup in Accounts Payable when emailing
remittance advices.
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EFT Vendor E-mail To: Enter the email address to use below in the Email To Field.

When sending remittance advices, if EFT Vendor Email To is selected and the Email To
field is populated, the remittance will be emailed to the E-Mail address entered in EFT. If no
email address is entered, users will receive an error message when printing remittance advices.

Tip:
If you use the AP Vendor Delivery Method, select Email (vendor) or Email (contact) delivery
method in A/P Vendor.

Currently, EFT Processing doesn't support Sage 300 Multiple Contacts. If the AP Vendor's
delivery method is set to "Multiple Contacts", it is recommended to set the EFT Vendor's
delivery method to EFT Vendor Email To and enter the email address in the EFT Vendors
screen.

Remittance Password

If you select to password protect PDF remittance advice in EFT Options Screen Guide on
page 113 >AP Tab , optionally enter the Vendor-specific password the Vendor will use to open
their Remittance Advice PDF. If no password is entered, then the Auto-generated Remittance
Password described below will be used.

Autogen Remittance Password

The auto-generated password, based on the Password Formula on EFT Options \AP Tab, will
be displayed.  (This is for visual verification only and is only available if you have security rights
to edit Vendor remittance advices.)

Email To

Enter the email address to use if the Delivery Method is set to EFT Vendor E-mail To.

The Email To field gives you the option to record a different Email address that has been setup
in A/P Vendor's Email / Contact's email. If left blank, EFT Processing uses the A/P Vendor email
address.

The Email-To field is 250 character long.

Tip: To send to multiple addresses, use a semi-colon (;) to separate the email addresses. For
example ronald@samplecompany.com; ronald.black@samplecompany.com;
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Bank Name

The name of the Vendor's bank name, up to 60 characters.

BSB Number

Type the banking industry code that identifies this Vendor's bank.

If EFT Processing Options / A/P / Encrypt Bank BSB/Acct. No. is ticked, you will only see the last
4 digits of the details entered.

Account Number

Type the number of the bank account (assigned to the Vendor's account by their bank).  The
number can be up to 22 characters.

If EFT Processing Options / A/P / Encrypt Bank BSB/Acct. No. is ticked, you will only see the last
4 digits of the details entered.

Account Name

Type the name of the Vendor's bank account. Defaults to the Vendor's name.

Payment Reference

Enter the bank's payment reference number.
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If you choose Use reference from vendor master record as the payment reference
when you create an EFT File, the reference is saved in the PAYREF field in the EFT Log. Refer to
Reference: Choose one of the option: on page 78

If configured in the file format, the reference is included in the EFT file.

Status

Select the Status to be

Entered
Active
Inactive

Note: Status must be Active before you can perform EFT Transactions

Note: You can setup security to control who can approve EFT Vendors - Refer to Approving
changes of EFT Vendor/Customer/Employee details: on page 44

Tip:
Field names might be different depending on the Primary Bank set up in EFT Options.

Use the Primary File Type Tab for EFT Processing (A/P and A/R)

Field names also depend on the File Type entered on the EFT Vendor and EFT Customer screens, if
using the multiple account details, one per EFT file type option.

EFT CUSTOMERS - SETUP SCREEN
Use this screen to enter and update Customer's Bank details to process direct debit and/or Customer
Refunds through EFT processing.

Main Tab
Customer Number

Identifies the customer in Accounts Receivable.

To open an existing customer record, type its number or choose it from the Finder in the Cus-
tomer Number field.
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Tip:

You can use the Drill-down Icon to open the related A/R Customer screen. This is use-
ful to check the Customer's delivery method for example.

File Type

The File Type field is optional.  If this option is enabled, you have a Finder to select the EFT Cus-
tomer, and another to select the EFT File Type. You can then select a file type to record dif-
ferent bank account details for the Customer according to the file type.

If you leave this field blank, then EFT will use the file type that has been assigned in EFT
Options > Primary Bank Setup to label the fields and enable EFT Customer extra fields.

Note: The File Type field is only available if you select "Allow multiple Customer
bank account details one per EFT file type in EFT Setup > Options > AR Tab.
Change the option and restart the screen if you don't see the field.

Example:
Detailed example of setting up EFT Vendor is available: Setup EFT Vendor with mul-
tiple file types

Delivery Method
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If you select AR Customer Delivery Method, EFT will use the setup in Accounts Receiv-
able when emailing advices.

If you select EFT Customer E-mail To, you can enter the email address to use below in
the Email To Field.

When sending remittance advices, if EFT Customer Email To is selected and the Email To field
is populated, the advice will be emailed to the E-Mail address entered in EFT. If no email
address is entered, users will receive an error message when printing remittance advices.

Remittance Password

If you select to password protect PDF remittance advice in EFT Options Screen Guide on page 113
>AR Tab , optionally enter the Customer-specific password the Customer will use to open their Remit-
tance Advice PDF. If no password is entered, then the Auto-generated Remittance Password described
below will be used.

AUTOGEN REMITTANCE PASSWORD

The auto-generated password, based on the Password Formula on EFT Options \AR Tab, will be
displayed.  (This is for visual verification only and is only available if you have security rights to edit
Customer remittance advices.)

Email To

If this field is populated with an email address, it will be used if you choose delivery method as
“Vendor/Customer” in EFT Reports > Print Advices.

The Email-To field is 250 character long.

Bank Name

The name of the Customers bank account, up to 60 characters.

BSB Number

Type the banking industry code that identifies this Customer's bank.

If EFT Processing Options /A/R / Encrypt Bank BSB/Acct. No. is ticked, you will only see the last
4 digits of the details entered.

Account Number

Type the number of the bank account (assigned to the Customer's account by their bank).
 The number can be up to 22 characters.

If EFT Processing Options /A/R / Encrypt Bank BSB/Acct. No. is ticked, you will only see the last
4 digits of the details entered.

Account Name :  Type the name of the Customer's bank account.

Payment Reference : Enter the bank's payment reference number.

Status

Select the status as:
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Entered - where the details of the customer have been entered
Active - where the details of the customer are approved
Inactive - if you do not want to create EFT files for this customer.  You can
make the customer active again at any time

Tip:
The status needs to be active if to create EFT files.

Refer to tutorial for details on using this feature: Approving changes of EFT Ven-
dor/Customer/Employee details on page 19

Process Single receipt per National Account

Defaults to No. Set to Yes if you want EFT to consolidate receipts by National Account.

Credit Card Tab
Note: You can use the Credit Card Tab to use Credit card details to generate the Direct
Debit file. The fields are encrypted in the database, but please note that EFT Processing
module is not PCI compliant and that Orchid takes no responsibility for the use of asso-
ciated fields and functionality.

Tip:
Field names might be different depending on the Primary Bank set up in EFT Options.

Use the Primary File Type Tab for EFT Processing (A/P and A/R)

Field names also depend on the File Type entered on the EFT Vendor and EFT Customer screens, if
using the multiple account details, one per EFT file type option.

EFT EMPLOYEES- SETUP SCREEN
Use this screen to enter the EFT Details for Employees setup in Sage 300 US and Canada Payroll. Details
include bank details as well as advice delivery method. You can choose to encrypt the bank details on the
screen in EFT Options.

Tip:
Field names might be different depending on the Primary Bank set up in EFT Options.

Tip: use F9 / Detail to see the additional fields for employees and enter the financial institutions that
the pay is paid into.

Fields and Controls

EMPLOYEE ID
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Identifies the Employee in Canada / US Payroll .

Select an existing employee record that has been configured in , type its number or choose it from
the Finder

FILE TYPE

This field is optional.  If you leave this field blank, then EFT will use the file type that has been
assigned in EFT Options > Payroll Tab > Primary Bank.

Select a different file type if the employee's bank requires different details than the Payroll Primary
Bank.

If you leave this field blank, then EFT will use the file type that has been assigned in EFT Options >
Payroll Tab > Primary Bank.

Example: If some employees are paid with in International bank transfer format, you only need to
enter the IAT file type for such employees. You can leave the file type blank for all other employees
paid the default file format.

DELIVERY METHOD

Select Payroll Email Delivery Method if you want to use the Payroll Employee Setup

Select EFT Email and Populate the Email To field if you want separate email details for Payroll and EFT
documents.

Select Mail if you don't want to email.

EMAIL TO

This field is optional.

If using "EFT Email Delivery Method, Enter the Email value you want to use.

If you leave this field blank, then EFT will use the Payroll Email based on the Payroll setup.

REMITTANCE PASSWORD

If you select to password protect PDF remittance advice in EFT Options Screen Guide on page 113
>Payroll Tab , optionally enter the Employee-specific password the Employee will use to open their
Remittance Advice PDF. If no password is entered, then the Auto-generated Remittance Password
described below will be used.

AUTOGEN REMITTANCE PASSWORD

The auto-generated password, based on the Password Formula on EFT Options \Payroll Tab, will be
displayed.  (This is for visual verification only and is only available if you have security rights to edit
Employee remittance advices.)

STATUS
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Select the Status to be

Entered
Active
Inactive

Note: Status must be Active before you can perform EFT Transactions

Note: You can setup security to control who can approve EFT Employees

CALCULATION TYPE AND PERCENT/AMOUNT

The pay component and Percent or Amount that is paid to each financial institution.

Percent / Amount: Enter the percentage of pay or a fixed amount to be paid to this institution

The rules are applied in the order they are entered on the screen.

The rule is applied to the remainder amount after the prior rules have been applied.

Tip: In most cases, the last rule should be set to Calculation Type "% Net Pay " and Per-
cent = 100. This means that any amount remaining after the previous rules have been
applied will be transferred to the account set in that line. If the pay is to be paid to a
single account, you only need to enter one line with "% Net Pay" as the Calculation
Type and set the Percent to 100
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Example:
In the screenshot below, EFT Payroll will create a line in the file for $300 to CIBC and the remainder
of the pay will be transferred to RBC.

If the pay is $250 for the week, only one line will be created. If the pay for the period is $400, it will
create 2 lines, one for $300 and one for $100.

END DATE

Enter the end date if this pay components is only to be paid until the end date.

BANK NAME

The name of the Employee's bank name, up to 60 characters.

FINANCIAL INSTITUTION NUMBER

Type the banking industry code that identifies this Employee's bank.

If EFT Processing Options / Payroll / Encrypt Bank BSB/Acct. No. is ticked, you will only see the last 4
digits of the details entered.

ACCOUNT NUMBER

Type the number of the bank account (assigned to the Vendor's account by their bank).  The number
can be up to 22 characters.

If EFT Processing Options / A/P / Encrypt Bank BSB/Acct. No. is ticked, you will only see the last 4
digits of the details entered.

ACCOUNT NAME

Type the name of the Employee's bank account. Defaults to the Employee's name.
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PAYMENT REFERENCE

Enter the bank's payment reference number.

DETAIL...

Click on the Detail. button to view additional fields that can optionally be configured for different
bank file types.

PASSWORD FORMULAS
Formulae are constructed in segments.
Segments are separated by the plus (+) symbol.
Segments comprise of functions that can be applied to Sage 300 view fields as follows: 

{fieldname}

RIGHT() function

LEFT() function

YYYY() or YY() year function

MMM() or MM() month function

DD() day function

Example:
The following example sets the password to the Customer number, followed by the last 3 characters of
the customer name and the first 5 characters of the customer's postcode.

{IDCUST}+RIGHT({NAMECUST},3)+LEFT({CODEPSTL},5)

Customer: ORC001

Customer Name: Orchid Systems

Zipcode: NSW2060

The resulting password would be ORC001emsNSW20

There are three segments to this formula:

1. {IDCUST} - ORC001 - the customer number

2. RIGHT({NAMECUST},3) - ems - the last 3 characters of the customer name

3. LEFT({CODEPSTL},5) - NSW20 - the first 5 characters of the postcode
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Password Segments
Segment 1:

{IDCUST} - refers to the IDCUST field in AR0024 – AR Customers

- fields are enclosed in curly braces {}

- field names must be written in UPPERCASE.

Tip: See below for Sage 300 Views and Fields that can be included in the password formulae.

Segment 2:

RIGHT({NAMECUST},3)

Right 3 characters of the {NAMECUST} field.

RIGHT() is the function.

Note: the function can be written as: RIGHT, Right, or right.

Segment 3:

LEFT({CODEPSTL},5)

Left 5 characters of the postcode field in ARCUS.

Note: the function can be written as: LEFT, Left, or left.

Sage 300 Views that can be included in the PDF formulas
Customer’s remittance advice AR0024 – AR Customers

Vendor’s remittance advice AP0015 – AP Vendors

Employee’s remittance advice, Pay Stub/Slip, T4 and
Relevé 1s

CP0014 – CP Employees

UP0014 – UP Employees

Tip: You can find the field names to use for each view in the Sage 300 Object Model.

Sage security groups and passwords
In the latest Sage 300 product updates, there is a new security group for Tax Number (in AP) and
SIN Number maintenance (CT7.3M and UT7.3N for Canadian Payroll and US Payroll).
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Users who don't have Sage 300 security clearance to view the Tax Number or SIN Number will not see
the full number. If you use the number to password protect the PDF, the password will not be what you
expect based on the formula. Therefore we suggest that users who generate the PDF have security rights
in Sage 300 to view the fields included in the password formula.

Example:
AP Remittance Advice and Tax Number field

If you use {TAXNBR} in the password for AP Advices, the user emailing the remittance advices needs to
be in a Sage 300 Security Profile where the Tax Number Maintenance security group is selected.

Example:
Payslip and SIN Number

You can use {SSN} in the password for payslips (in EFT Options > Payroll Tab).

For example RIGHT({SSN},4) to get the last 4 digits of the SIN Number.

The user running the payroll and generating the PDF needs to be in a Sage 300 Security Profile where
the SIN Number Maintenance security group is selected. If they don't have rights to view the field, the
password will not be what is expected.
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Formulae and date fields.
Example: Password formula using date fields

RIGHT({LASTNAME},2)+LEFT({EMPLOYEE},3)+LEFT({FIRSTNAME},4)+YYYY
({BIRTHDATE})+mmm({BIRTHDATE})+DD({BIRTHDATE})

Employee code: 23456754

Emplyee Name: Sean Smith

Date of Birth: 1/12/1970

The above formula would result in the following password applied to the PDF:

th234Sean1970DEC01

th: the last 2 characters of the last name

234: the first 3 characters of the employee code

Sean: the first 4 characters of the first name

1970: the year of the DOB

DEC: the month of DB

01: day of birth.

Date fields can be specified as follows:

1. {BIRTHDATE} - returns the date in YYYYMMDD format.
2. Year only:

1. YYYY({datefield}) - returns the year in YYYY format. Can be written as YYYY or yyyy
2. YY({datefield}) - returns the year in YY format. Can be written as YY or yy.

3. Month only:

1. MMM({datefield}) - returns the month in abbreviated format: JAN, FEB, MAR, APR, MAY,
JUN, JUL, AUG, SEP, OCT, NOV, DEC. Month is returned in UPPERCASE.  Can be written
as MMM or mmm

2. MM({datefield}) - returns the month in numeric format with padded left: 01,02,03,...,12. 
Can be written as MM or mm

4. Day only:
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1. DD({datefield}) - returns the day portion of the date: 01,02,03,...,31. Can be written as
DD or dd

Integers and Booleans in Formulae.
Integer and boolean type fields can be included in a formula.

BCD Numbers in Formulae.
BCD numbers are presently not supported.

PASSWORD EXAMPLES
Which remittance advice password will work if you have more than one?

In EFT Processing, you have the option to password-protect PDF sent with Remittance Advices when
emailing to a Vendor, Customer, or Employee. You can use a password formula, a password entered per
record and a master password. This topic describes the order of precedence of each method.

Details specific to the process for each type are available below:

Using password to protect Remittance Advices for Vendors on page 90

Using password to protect Remittance Advices for Customers on page 91

Using password to protect Payroll Advices and other Payroll PDF for Employees on page 103

Scenario 1
If you have a password formula for AP, AR & Payroll remittances in EFT Options

And in EFT Vendors, Customer or Employee, you have manually entered a password for “Remittance
Password” the “Remittance Password” will over-ride the “Autogen Remittance Password”
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Scenario 2
In EFT Options, if you have a PDF Master Password for AP, AR & Payroll remittances And an Autogen
Remittance Password, both passwords will work Both passwords will work

Scenario 3
If you have a PDF Master Password in EFT Options for AP, AR & Payroll remittances And no Password For-
mula/Autogen Remittance Password, And a Remittance Password in EFT Vendors, Customers, Employees
Both passwords will work
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Scenario 4
If you have a PDF Master Password in EFT Options for AP, AR & Payroll remittances, but no other pass-
words (no formula, no manually entered passwords), the remittance advice will not be encrypted.

EMAIL MESSAGES - VARIABLES TO INCLUDE
The E-mail Messages form lets you create email templates to send with e-mailed remittance advices, dir-
ect debit and refund advices.

Tip: When you use {field} or $field , EFT will replace the code by the value of the field when sending
the email. When using HTML Emails, use {field} as it knows where the field ends and is more reliable.
$field is available for backward compatibility purposes.

Tip: Email templates are sent as HTML if they contain "<html>" and "</html> Tags. Only available in
the latest product updates of Sage 300 version 2016 and above.

Tip: To add a line in HTML templates, you must use <BR> or include <p>my text </p> around each
line.

Tip: If copying your existing text email templates and converting them to HTML template, make sure
you add <BR> wherever a new line is required.
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Refer to Sample EFT Email Messages on page 177 that you can copy and paste in the EFT Email Messages
screen.

EXAMPLE VARIABLES FOR E-MAILED REMITTANCE ADVICES:

EFT Vendor Variables:

{VENDOR_ID}

{VENDOR_NAME}

{VENDOR_CONTACT}

{VENDOR_REMITCONTACT}

AP Payment Variables:

{DOCLIST} - Prints a list of AP Invoices that were paid.

{DOCAMTLIST} - Prints a list of A/P documents applied to the payment. Includes Document Number,
Date and Amount.

When you use HTML templates, the list is displayed in a table and alignment is controlled better.

{PAYMENT_DATE_YYYY} - four digit year of the A/P Payment (eg 2020)

{PAYMENT_DATE_YY} - two digit year of the A/P Payment (eg 20)

{PAYMENT_DATE_M} - single digit month of the A/P Payment (eg 4)

{PAYMENT_DATE_MM} - two digit month of the A/P Payment (eg 04)

{PAYMENT_DATE_MMM} - short month name of the A/P Payment (eg Apr)

{PAYMENT_DATE_MONTH} - month name of the A/P Payment (eg April)

{PAYMENT_DATE_D} - single digit day of the A/P Payment (eg 5)

{PAYMENT_DATE_DD} - two digit day of the A/P Payment (eg 19)

Default formatting for a date field is YYYYMMDD.

If you need to format the date, use {PAYMENT_DATE_MM}-{PAYMENT_DATE_DD}- {PAYMENT_DATE_
YYYY}
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Example:
If the transaction date is 10th October 2019, {PAYMENT_DATE} will display as 20191031 in the
email.

{PAYMENT_DATE_MM}-{PAYMENT_DATE_DD}- {PAYMENT_DATE_YYYY} will show as 10-31-2019

{PAYMENT_DATE_DD}-{PAYMENT_DATE_MM}- {PAYMENT_DATE_YYYY} will show as 31-10-2019

{PAYMENT_AMTRMIT} - Total AP Payment Amount

{PAYMENT_FIELDNAME} is any field from the APTCR table.

FOR E-MAILED REFUND ADVICES AND E-MAILED DIRECT DEBIT ADVICES

EFT Customer Variables:

{CUSTOMER_ID}

{CUSTOMER_NAME}

{CUSTOMER_CONTACT}

AR Receipt and AR Refund Variables:

{DOCLIST} - Prints a list of AR Invoices that were paid.

{PAYMENT_DATE_YYYY} - four digit year of the A/R Payment (eg 2020)

{PAYMENT_DATE_YY} - two digit year of the A/R Payment (eg 20)

{PAYMENT_DATE_M} - single digit month of the A/R Payment (eg 4)

{PAYMENT_DATE_MM} - two digit month of the A/R Payment (eg 04)

{PAYMENT_DATE_MMM} - short month name of the A/R Payment (eg Apr)

{PAYMENT_DATE_MONTH} - month name of the A/R Payment (eg April)

{PAYMENT_DATE_D} - single digit day of the A/R Payment (eg 5)

{PAYMENT_DATE_DD} - two digit day of the A/R Payment (eg 19)

Default formatting for a date field is YYYYMMDD.

If you need to format the date, use {PAYMENT_DATE_MM}-{PAYMENT_DATE_DD}- {PAYMENT_DATE_
YYYY}
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Example:
If the transaction date is 10th October 2019, {PAYMENT_DATE} will display as 20191031 in the
email.

{PAYMENT_DATE_MM}-{PAYMENT_DATE_DD}- {PAYMENT_DATE_YYYY} will show as 10-31-2019

{PAYMENT_DATE_DD}-{PAYMENT_DATE_MM}- {PAYMENT_DATE_YYYY} will show as 31-10-2019

FOR E-MAILED PAYROLL ADVICES

EFT Employees Variables:

You can include fields from the Canadian Employee (CPEMPL) or US Employee (UPEMPL) table by
using {EMPLOYEE_FIELDNAME} e.g.

{EMPLOYEE_EMPLOYEE} - Employee ID

{EMPLOYEE_FIRSTNAME}

{EMPLOYEE_LASTNAME}

{EMPLOYEE_COUNTRY}

Payroll Variables:

Any field from the EFT Payroll Audit log (ELPLOGD), surrounded by {fieldname} or with $ in front

{CREATENO} - Creation Number

{LINE}- Line Number

{DATERUN} - Date Run (e.g. 20180103)

{IDEMP} - Employee

{PEREND} - Pay Period End Date (e.g. 20190130)

{EAMOUNT} - Amount -

{BANK} - Bank Code

{FILETYPE} - File Type

{BANKNAME} - Bank

{BSBNO} - Branch Number

{ACCNO} - Account Number 123456789

{ACCNAME} - Account Name 100050acc

{PAYREF} - Payment Reference

{NAME} - Payee Name

{TEXTSTRE1} - Address 1

{TEXTSTRE2} - Address 2
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{TEXTSTRE3} - Address 3

{TEXTSTRE4} - Address 4

{NAMECITY} - City

{CODESTTE}- State/Prov. BC

{CODEPSTL}- Zip/Postal Code

{CODECTRY} - Country

{NAMECTAC} - Contact

{PHONE} - Telephone

{FAX} - Fax

{EMAIL} - E-mail

{WEBSITE} - Web Site

{EXTRA1} to {EXTRA50}

FOR E-MAILED PAYSLIPS/PAYSTUBS

EFT Employees Variables:

You can include fields from the Canadian Employee (CPEMPL) or US Employee (UPEMPL) table by
using {EMPLOYEE_fieldname} , e.g.

{EMPLOYEE_EMPLOYEE} - Employee ID

{EMPLOYEE_FIRSTNAME}

{EMPLOYEE_LASTNAME}

{EMPLOYEE_COUNTRY}

Payroll Cheque/check History Summary Table (CPCHKS or UPCHKS) Variables:

You can include fields from the Payroll Cheque/Check History Summary table (CPCHKS or UPCHKS)
as follows:

{PAYCHECK_fieldname}

For example: {PAYCHECK_EMPLOYEE} for the Pay check/cheque name
{PAYCHECK_PERSTART} - Period Start Date
{PAYCHECK_PEREND} - Period End Date
{PAYCHECK_TRANSDATE}.- Transaction Date

Default formatting for a date field is YYYYMMDD.
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If you need to format the date, use {PAYCHECK_TRANSDATE_MM}-{PAYCHECK_TRANSDATE_DD}-
{PAYCHECK_TRANSDATE_YYYY}

Example:
If the transaction date is 10th October 2019, {PAYCHECK_TRANSDATE} will display as 20191031 in
the email.

{PAYCHECK_TRANSDATE_MM}-{PAYCHECK_TRANSDATE_DD}- {PAYCHECK_TRANSDATE_YYYY}
will show as 10-31-2019

{PAYCHECK_TRANSDATE_DD}-{PAYCHECK_TRANSDATE_MM}- {PAYCHECK_TRANSDATE_YYYY}
will show as 31-10-2019

FOR E-MAILED T4 AND RELEVE1

EFT Employees Variables:

You can include fields from the Canadian Employee (CPEMPL) or US Employee (UPEMPL) table by
adding $EMPLOYEE_ before the field name, e.g.

{EMPLOYEE_EMPLOYEE} - Employee ID

{EMPLOYEE_FIRSTNAME}

{EMPLOYEE_LASTNAME}

{EMPLOYEE_COUNTRY}

VARIABLES AVAILABLE FOR ALL ADVICES

Company Variables:

{COMPANY_PHONE}

{COMPANY_FAX}

{COMPANY_CONTACT}

{COMPANY_NAME}

System Date Variables:

{DATE_YYYY} - four digit year of today (eg 2020)

{DATE_YY} - two digit year of today (eg 20)

{DATE_M} - single digit month of today (eg 4)

{DATE_MM} - two digit month of today (eg 04)

{DATE_MMM} - short month name of today (eg Apr)

{DATE_MONTH} - month name of today (eg April)
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{DATE_D} - single digit day of today (eg 5)

{DATE_DD} - two digit day of today (eg 19)

SAMPLE EFT EMAIL MESSAGES
You can copy the sample below and paste into EFT Email Messages Screen.

EFT Payments Text email

EFT Payments (AP) Text email

Hi {VENDOR_CONTACT}

Please be advised that a payment has been made to your nominated bank account on
{PAYMENT_DATE_YYYY}/{PAYMENT_DATE_MM}/{PAYMENT_DATE_DD}

The applied documents are as follows :
{DOCLIST}

Regards

{COMPANY_NAME}

EFT Payments HTML email

EFT Payments (AP) HTML Email

<html>
<p>Hi {VENDOR_CONTACT}</p>
<p>Please be advised that a payment has been made to your nominated bank account on
{PAYMENT_DATE_YYYY}-{PAYMENT_DATE_MM}-{PAYMENT_DATE_DD}</p>
<p>The applied documents are as follows :</p>
<p>{DOCLIST}</p>
<p>&nbsp;</p>
<p>Regards</p>
<div><strong>{COMPANY_NAME}</strong></div>
<p>&nbsp;</p>
</html>

EFT Payments HTML email - example with image link

To add a logo to the Message templates, you have to use an HTML template and include an image
tag pointing to a logo hosted on your website.
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This is available in the latest update for Sage 300 version 2016 and above.

EFT Payments (AP) HTML Email - with Logo

<html>
<p><img src="https://www.orchid.systems/sites/default/files/styles/large/public/inline-
images/logo-button-EFT.png" alt="Logo"></p>
<p>Hi {VENDOR_CONTACT}</p>
<p>Please be advised that a payment has been made to your nominated bank account on
{PAYMENT_DATE_YYYY}-{PAYMENT_DATE_MM}-{PAYMENT_DATE_DD}</p>
<p>The applied documents are as follows :</p>
<p>{DOCLIST}</p>
<p>&nbsp;</p>
<p>Regards</p>
<div><strong>{COMPANY_NAME}</strong></div>
<p>&nbsp;</p>
</html>

EFT Direct Debit Text

EFT AR Direct Debit - Text example

Hi {CUSTOMER_NAME}

Please be advised, according to our agreement, we have direct debited your nominated
bank account on {PAYMENT_DATE_YYYY}/{PAYMENT_DATE_MM}/{PAYMENT_DATE_DD}
The applied documents are as follows :
{DOCLIST}

Regards
{COMPANY_NAME}

EFT Direct Debit HTML

EFT Direct Debit - AR - HTML Example

<html>
<p>Hi {CUSTOMER_NAME}</p>
<p>Please be advised, according to our agreement, we have direct debited your nominated
bank account on  {PAYMENT_DATE_YYYY}-{PAYMENT_DATE_MM}-{PAYMENT_DATE_DD}</p>
<p>The applied documents are as follows :</p>
<p>{DOCLIST}</p>
<p>&nbsp;</p>
<p>Regards</p>
<div><strong>{COMPANY_NAME}</strong></div>
<p>&nbsp;</p>
</html>

Page 178 of 224 EFT Reference Material



Orchid EFT Processing

EFT Payroll Advice Text

EFT Payroll - Text message

{EMPLOYEE_EMPLOYEE}
{EMPLOYEE_FULLNAME}

Hi {EMPLOYEE_FIRSTNAME}
Please find attached the remittance advice for your pay for Pay Period End {PEREND_
YYYY}/{PEREND_MM}/{PEREND_DD}

Bank: {BANK}  {BANKNAME}
Amount: {EAMOUNT}

EFT Payroll Advice HTML

EFT Payroll advice - HTML Example

<html>
<div>
<p>{EMPLOYEE_EMPLOYEE}</p>
<p>{EMPLOYEE_FULLNAME}</p>
</div>
<div>
<p>&nbsp;</p>
<p>Hi {EMPLOYEE_FIRSTNAME}</p>
</div>
<p>Please find attached the remittance advice for your pay for Pay Period End {PEREND_
MM}-{PEREND_DD}- {PEREND_YYYY}</p>
<p>{BANK}</p>
<p>{BANKNAME}</p>
<p>{EAMOUNT}</p>
<p>&nbsp;</p>
<p>Regards</p>
<div><strong>{COMPANY_NAME}</strong></div>
<p>&nbsp;</p>
</html>

EFT SETUP- RECEIPT/REFUND SELECTION CODES - FIELD
LIST
Use this screen to configure Receipt Selection Codes to create A/R Receipt or Refund batches based on
the criteria configured for each Receipt Selection code.

The values entered in the EFT Setup > Receipt Selection Codes are used as Default Values when using
the Create Receipt Batch function.

See Also Create Receipt/Refund Batch on page 82 for details on how to use.
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Select tab
If you are using EFT Processing to process A/R Receipt or Refund Batches, use this tab to specify details
about the receipt batches to be created by EFT Processing.

FIELDS AND CONTROLS
Document Type: Select the type of batches you want to create: A/R Receipt, A/R Zero value receipt
to apply documents or A/R Refund.

Batch Description: Description of the batch

Entry Description: Entry description on the generated entries

Bank ID: This field will populate the Bank code on the generated batch. This is the bank where the
funds are deposited into.

Payment Code: Specify a payment code to identify the type of payment

Tip:
The payment type "CASH or CHECK" configured on the Payment Code in A/R Setup is used
to determine the A/R Refund payment type.
All details in the refund use the same payment type.
If no payment code is selected, the Refund payment type is set to "Cash".
You can amend the payment types before posting the A/R Refund batch if you don't auto-
post the batch.

IF A CUSTOMER IS NOT DEFINED IN EFT CUSTOMER DO YOU WANT TO :

Skip the customer and continue the export

Selecting this option enables a tick box on the EFT Create File screen which will allow you to determ-
ine whether an error is generated for each run.

EFT Create File ignore all transactions for A/R Customers which have not been defined in EFT Cus-
tomers and produce a file for A/R Customers which have been defined in EFT Customers.

Display Error and Abort

Display an error and abort the export - when you select this option, EFT generates an error message
for each A/R Customer which is not defined in EFT customers and abort the export. The EFT Cus-
tomer can then be added and the file export resumed.

Include the Customer anyway

If you select this option, EFT Processing creates the EFT File including the A/R customer details, where
the EFT customer details are blank.

PROCESS SINGLE RECEIPT PER NATIONAL ACCOUNT

Select “No” if you require one receipt per AR Customer
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Select "Yes" if you want to create one receipt per National Account for those AR Customers assigned
to an AR National Account

Select “Use EFT Customer Setting” if you want to control the number of receipts created for an AR
National Account on a EFT Customer by EFT Customer basis. Depending on the selection “Process
single receipt per National Account” on the EFT Customer, Create Receipt Batch will either create one
receipt per AR Customer or one receipt per AR National Account (to which the AR Customers have
been assigned).

Note: This option does not apply when creating A/R Refund in line with Sage's rules for
A/R Refund.

POST RECEIPT BATCH

Post Receipt Batch will Create the Receipt Batch AND Post the receipt batch after it has been created.

ONE RECEIPT PER INVOICE

Select Yes if you want separate receipts per outstanding invoice,

Select No to include all invoices in a single receipt per customer.

You can set the default value in the Receipt Select Codes Setup screen and change it at runtime when
you use the "Create Receipt/Refund" process.

Criteria tab
Use this Tab to select the Documents to include in the Receipt Batches.

The values setup on the specified receipt selection code appear as the default in the Create Receipt
Batch form, but you can change the values before creating the batch.

You can:

Choose the method for selecting documents
Select all documents meeting the criteria
Set ranges of account sets, terms code, billing cycle, interest profile, payment code and customer
price list, etc.

FIELDS AND CONTROLS
Customer: Select the customer range

Batch: Select the batch range

Invoice Date: Enter the Invoice date range

Due From: Enter the Due From date range

Customer Balance: Enter a range for the Customer's Balance (this is the total amount outstanding)
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Tip: When creating A/R Refund, if you only want to refund customers with a net credit balance, set
the From Customer Balance to the lowest negative number you want to select. Set the To Cus-
tomer Balance to 0.

Invoice Balance: Enter a range for the Invoice Balance (optional)

Account Set: Specify the range of account sets that you want included in the A/R Receipt/Refund
Batch, or leave the To field blank and specify ZZZZZZ in the To field to select from customers with
any account sets.

Customer Terms Code : Specify the range of Customer terms code that you want included in the
A/R Receipt/Refund Batch.

Invoice Terms Code: Specify the range of Invoice terms code that you want included in the A/R
Receipt Batch. This doesn't apply to A/R Refund batches

Billing Cycle: Specify the Customer billing cycle range that you want included in the A/R Receipt/Re-
fund Batch.

Interest Profile: Specify the Customer interest profile range that you want included in the A/R
Receipt/Refund Batch.

Payment Code: Specify the range of payment codes that you want included in the A/R Receipt/Re-
fund Batch.

Customer Price List: Specify the customer price list range that you want included in the A/R
Receipt/Refund Batch.

Group Code: Specify the Customer Group Code range that you want included in the A/R Receipt/Re-
fund Batch.

CUSTOMER OPTIONAL FIELDS

This field appears if you use Sage 300 Optional Fields

You can use the Customer Optional Fields box to specify a customer  optional field as a criteria
for selecting customers for a receipt batch. If you specify an optional field, you can then select
which optional field values to include in the Receipt batch.

Tip: Select All to select All optional field values and Double click on the Yes field in
the Selected column to remove the values to exclude from the batch.

INVOICE HEADER OPTIONAL FIELDS

This field appears if you use Sage 300 Optional Fields.

You can use the A/R Invoice Header Optional Fields box to specify an invoice optional field as a
criteria for selecting documents for a receipt batch. If you specify an optional field, use the Inform-
ation icon to select which Optional field values to include.

Tip: When creating A/R Refund, this criteria doesn't apply.
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Documents Tab
Use this tab to configure the document types to include in the calculation of the receipt amount, and
applied to the receipt created (AR Credit Notes, Prepayments, Unapplied Cash / Receipts, Debit Notes)

FIELDS AND CONTROLS
Include Credit Notes

Select “Yes” if you want to include any open Credit Notes in the calculation of the document value.

Include Prepayments

Select “Yes” if you want to include any open Prepayments in the calculation of the document value.

Include Unapplied Cash / Receipts

Select “Yes” if you want to include any open Unapplied Cash or Receipt Transactions in the cal-
culation of the document value.

Include Debit Notes

Select "Yes" if you want to include any open Debit Notes in the calculation of the document value.

Include Interest Invoices

Select "Yes" if you want to include any open Interest Invoices in the calculation of the document
value.

Exclusions Tab
Use this tab to list the customer(s) which are to be excluded from the document selection process and/or
the Customer(s) and Document(s) combinations to be excluded from the document selection process.

Note: If you enter a National Account Customer Number, then all child accounts are also
excluded.

Note: When you create the AR Batch, excluded customers and documents are included in
the Receipt Batch Audit Log. Refer to EFT Receipt Batch Audit Log

VIEW/CLEAR COMPLETED EFT PAYROLL LOGS
To Clear EFT Payroll Completed Logs

1. Ensure that your security profile allows you to do so.
2. Enter the Creation Number you want to clear up to.
3. Select Clear to clear the records or Close if you don't want to clear.
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4. Select "Reprint" to print/email remittance advices for a single EFT File creation. This is
useful when you have re-created a file multiple times after updating employee bank
details, but only send one of the files to the bank.

If you have already created a file for the Bank/Pay Period End Date, you will receive a warning to confirm
that you really want to re-create the file. If the files include the same employees, the remittance advice
will include details from both files. It is suggested to send the remittance advices from the "View'Clear
Payroll log" in EFT Periodic Processing and select an individual EFT file creation number.

Tip: To see details of what was exported double click on a row

ORCHID MODULE LICENSE SCREEN
To start using Orchid Module, you need a valid serial number and license file.

If you don't have a valid license for Orchid Module, you only see the License screen.

License screen
You use the Orchid Module license screen to enter serial number and activation code.

When to use: 
After a new installation or an upgrade to a newer version of Sage 300.
After a subscription renewal, enter the activation code with the new expiry date.
View the components of the Orchid module you are licensed for.

How to use: 
Enter the license details, click the Add button to create the license file.
Restart the Sage desktop to enable the new license.

Note: If you have multiple Sage 300 databases, you only need to enter the activation code details in
one company. When the licence details are entered on the first company, Orchid Module creates the
OR69A.lic file, which can then be read by all other companies configured on the same server.

30-day Trial License

If you don't have an activation code for Orchid Module, you can create a 30-day trial license.

In the License screen, enter a serial number for the module, Sage 300 version and edition you are run-
ning.

Click the Add button. This create a 30-day trial license.
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Tip: If you install a 30-day trial, enter a valid activation code before the trial expiry date to continue
using the application.

Subscription Licenses Expiry Date

You can check the subscription expiry date and enter a new activation code after a subscription renewal
is processed.

Subscription licenses have an expiry date. To continue using Orchid Module, you will need to renew the
subscription and enter a new Activation code in the module License screen before the expiry date.

Contact your Sage 300 Business Partner for details.

Note: In the four weeks before the expiry date, users receive a warning message when logging into
Sage 300 (weekly for the first three weeks and daily in the last week). If you don't renew before the
expiry date, the software will become read-only.

Troubleshooting Activation Code
When saving the license information, the following problems may be encountered:

Activation code Invalid – verify the registered company name (displayed during installation) and serial
number entered match the details supplied to Orchid Systems when an activation code was requested.

Invalid serial number – the entered serial number is not valid for this product, Sage 300 version and edi-
tion.

Important! If the Sage 300 Version or Edition change, a new Serial Number and activation
code must be requested from Orchid Systems.

If the company name registered with Sage changes, a new Activation Code must be requested from
Orchid Systems.

Serial Number and Sage 300 Version and Edition

The serial number must match the Sage 300 version and edition.

Go to About > System Information to get the Sage 300 System Manager Version and Edition if you need
to confirm the details.
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Activation Code and System Manager Company Name

In the Activation Code, the customer name must match exactly with the company name as registered
under the Sage 300 System Manager (including all punctuation and capitalization). To verify this inform-
ation when requesting an Activation code, please email Orchid Systems a screenshot of your System
Manager license details.

Go to Help > Licenses > License Information to get the Company that Sage 300 System Manager is
licensed to.
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Activation code and available functionality
Depending on the components you are licensed to use, some features described here may not be avail-
able for you to use. Some functionality of Orchid Module is only active if you have purchased the
required module component.

The license screen displays what components of the Orchid Module module are included in the activ-
ation code.
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EFT Formats Technical Info

Watch the Spotlight video on EFT Processing File Formats in Sage 300.

Watch the Spotlight video on using EFT File Formats in Sage Intacct

Spotlight Video: EFT File formats in Sage Intacct

BANK FORMATS - OVERVIEW
EFT Processing installs with a number of system defined file formats.  These formats are contained in a
file formats.ini which is found in the ..\Sage\ELxxA directory.

Additional bank formats are added on demand by the Orchid support team for supported versions of
EFT Processing.

Amending File Formats
The formats.ini file should never be changed on site. In the latest product updates, the formats.ini file
includes a hash calculation to ensure the file is not tampered with. If the file is amended in anyway, it can-
not be used in Create EFT File and you will receive an error message.

To change an existing bank format (or create a new one), copy the original bank format from the format-
s.ini file to the userformats.ini file and make the required changes.
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Note: If you change the default formats.ini file, you get a "File Hash" Error when using the file in Create
EFT File function.

When upgrading
If upgrading from a prior version with customisations done in the formats.ini file, you need to copy the
changes to the formats.ini to the userformats.ini. Refer to details in Upgrading EFT Processing Key Steps
on page 49

Sections in the ini file
The formats.ini file include multiple sections.

Refer to EFT Processing online help for more details.

EFT Help: https://help.orchid.systems/sage300addons/Content/Product-Home/EFT-Processing.htm

Each bank is a section in the ini file.  A section is denoted by Square Brackets for example :

[USA_WF] for the Wells Fargo bank layout.

Within each section, you can define the following

[Format] - Unique ID of the File format in Square brackets

Name - description of the bank layout

Note: Render=API - Do not change this line

File Format

File format includes several sections: 

1. Extra field declaration, including validations, label and help tips

BSB or sort code name - customised for the bank layout
BSB or sort code size - customised for the bank layout
Account name - customised for the bank layout
Account size - customised for the bank layout
Up to 10 extra fields on the Bank file
Up to 50 extra fields on the Vendor file
Up to 50 extra fields on the Customer file

2. Row Declaration

Each row type can have multiple lines with a number at the end to indicate the sequence. DetailAP1 and
DetailAP2

The definition of the header row(s) - general header for all transactions or an A/P specific header
or an A/R specific header
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The definition of the detail  row(s) - general detail for all transactions or an A/P specific detail or an
A/R specific detail
The definition of the footer row(s) - general footer for all transactions or an A/P specific detail or
an A/R specific footer
Rows can include fields from the Company, Bank, Vendor/Customer, Payment and Applied
Invoices records. For details, refer to Field Names

Example:
HeaderAP="A000000001[OriginatorIdNumber:%10C][FileCreationNumber:%04D]..”

DetailAP = "C[RecordCount:%09D][OriginatorIdNumber:%-10C]460.”

FooterAP = "Z[RecordCount:%09D][[TransactionTotalInCents:%014D] ..”

Example: Bank Setup Validation and renaming.

[USA_WF]

Name="USA Wells Fargo ACH"

BSBSize=9

AccountSize=9:17

BSBNumber="R/T Number"

AccountNumber="Account Number"

AccountName="Account Name"

SourceExtra1="Application ID"

SourceExtra2="Remote ID (RID)"

SourceExtra3="File ID"

SourceExtra4="Company ID"

Header=

BatchHeader=

DetailAR=

DetailAP=

BatchFooter=

Footer=
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Validation examples:
Example: Bank Setup Validation and renaming.
BSBSize=9 BSB Number will be validated to 9 in length

AccountSize=9:17
Account Number will be validated to be between 9 and 17
in length

BSBNumber="R/T Number" BSB Number will be re-labeled R/T Number
AccountNumber="Account
Number"

Account Number will be Account Number

AccountName="Account
Name"

Account Name will be labeled Account Name

SourceExtra1="Application ID"
one extra field on the Bank will be enabled called "Applic-
ation ID"

SourceExtra2="Remote ID
(RID)"

second extra field on the Bank will be enabled called
"Remote ID (RID)

SourceExtra3="File ID"
Third extra field on the Bank will be enabled called "File
ID"

SourceExtra4="Company ID"
Fourth extra field on the Bank will be enabled called "Com-
pany ID"

BSBSize is the size of the BSB field. This can either be one number, which means the BSB is a fixed size,
or two numbers in the format min:max.

AccountSize is the size of the Account Number field. This can either be one number, which means the
Account Number is a fixed size, or two numbers in the format min:max.

Note: The Size is used for data validation.

Making a field required
Use ! in front of a field name. EFT will check if the field has a value.

Example: [!DestAccountNumber] means that the Vendor Bank Account field cannot be
blank when creating the EFT File.

RENDER=API
Since the latest product update for Sage 300 version 2019, EFT Processing includes two dll engines to
generate the EFT Files: 
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The original dll ELEFT.dll works only with Sage 300. It includes support for optional fields on
AP Payments and AR Receipts headers. However, it doesn't support LUA functions for conditional
formulas in the file. While this dll is supported, enhancements are not added to it.
EFT.dll works with various ERP Applications. It includes standard predefined fields and includes sup-
port for LUA statements to write conditional statements in the file format. Any enhancements to
EFT Processing are done in the EFT.dll only. To use the newer dll, the file format must include the
line RENDER=API.

Note: If the RENDER=API is deleted or omitted, EFT Processing will use the ELEFT.dll.

Tips when converting from an older format to render=API

With the latest dll, you can't include the Sage 300 table names directly into the formats.ini or user-
formats.ini. You need to use the pre-defined field names.

Example:
For example, you need replace the fields below:

Fields [CSCOM.*] in Company Profile, change to [Company.*]

Field [ELCUS.EMAIL] for email address, change to [DestAdviceEmail].

Field [APTCR.IDRMIT] for cheque number, change to [FirstCheque]

Field [APTCR.DOCNBR] for Document Number, change to [DocNum]

Field [APTCR.CODECURN] for Vendor Currency Code, change to [Dest.ccy]

USER FORMATS - UPDATING EFT BANK FORMATS
EFT Processing installs with a number of system defined file formats.  These formats are contained in a
file formats.ini which is found in the ..\Sage\ELxxA directory. The formats.ini file cannot be changed on
site.  Only Orchid can amend the formats.ini file.

To change an existing bank format (or create a new one), copy the original bank format from the format-
s.ini file to the userformats.ini file and make the required changes.

For a list of row types, field names and validations in EFT Processing file formats, refer to Bank Formats -
Overview on page 189

User formats and Default formats
When processing a file layout, EFT Create File first checks the userformats.ini file for the
bank selected.  If found, it uses the layout from the userformats.ini.  If not found, it uses the format
from the system formats.ini file.
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Note:
 The userformats.ini can be copied to the customization directory to use standard Sage 300 func-
tionality of database and user control.

When processing a file layout, EFT Create File first checks the customization directory for
userformats.ini.  If not found, it checks the ELXXA (e.g. EL73A for version 2026) folder of the Sage 300
install for userformats.ini and if not found it uses formats.ini in the ELXXA folder.

Editing EFT Processing File formats

You generally update the userformats.ini file in a Text Editor. If you have saved the file in the correct
folder as described above, but you get an error message that the file type doesn't exist, check that the
file is saved with UTF-8 encoding.

File Encoding.

Userformats.ini file needs to be encoding in the UTF-8 format.

If not, you may get a "File format does not exist in ini file" error message although the file exists in the
folder.

You need to change the File encoding in Notepad ++ or other text editor.

In some cases, you need to encode file in ANSI format, for example to support German Characters. This
assumes that all formats in the userformats.ini file work with ANSI format.

Using *.EFT Files in the customization directory

You can create *.EFT Files in the customization directory. The *.EFT File can include one or more file
formats.

If you have some file formats that require ANSI encoding and others that require UTF-8 format, you can
use .EFT Files, each with different encoding.
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Troubleshooting custom format

EFT File includes invoice details twice per payment

After an upgrade, a user reported that the invoice details were included twice per payment. This is
because the APINVOICE variable is declared twice.

Solution is to remove the duplicate APINVOICE variable declaration.

ROW TYPES

Overview
Within each section, there are 5 types of rows:

HEADER File Header is row at the beginning of export file.

BATCHHEADER Batch Header is row for the export file at the beginning of a batch, repeated
per batch number.

DETAIL Detail is row in the export file for eachpayment/receipt/refund being made.

BATCHFOOTER Batch footer is row in the export file at the end of a batch, repeated per batch
number.

FOOTER File Footer is row at the end of export file.

The row types are not case sensitive.  DETAIL or Detail or detail is interpreted in the same way.
Each row type is optional.
Some banks have the same format for AR and AP, some banks have different formats.
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Example: For Example, CAN_CPA has the same header and footer format for AR and AP,
but different detail formats:

[CAN_CPA]

Name="Canadian CPA"

Render=API

BSBSize=8

AccountSize=3:12

Header="A[RecordCount:%09D][SourceReference:%10C][BatchNumber:%04D]0[BatchDateJulian]
[SourceBankName:%-5C] [Blank:%-1409C][CR][LF]"

DetailAP = "C[RecordCount:%09D][SourceReference:%-10C][BatchNumber:%04D]460[Amoun-
tInCents:%010D]0[EntryDateJulian][DestBSB:%-9D][DestAccount:%-
12C]0000000000000000000000000[SourceAccountName:%-15C][DestAccountName:%-30C]
[SourceAccountName:%-30C][SourceReference:%-10C][DestId:%-19C]000000000 [Reference:%-
15C][Blank:%-22C][Blank:%-2C][Blank:%-11C][CRLF]"

DetailAR = "D[RecordCount:%09D][SourceReference:%-10C][BatchNumber:%04D]460[Amoun-
tInCents:%010D]0[EntryDateJulian][DestBSB:%-9D][DestAccount:%-
12C]0000000000000000000000000[SourceAccountName:%-15C][DestAccountName:%-30C]
[SourceAccountName:%-30C][SourceReference:%-10C][DestId:%-19C]000000000 [Reference:%-
15C][Blank:%-22C][Blank:%-2C][Blank:%-11C][CRLF]"

Footer = "Z[RecordCount:%09D][SourceReference:%-10c][BatchNum-
ber:%04D]0000000000000000000000[TransactionTotalInCents:%014D][NumberOfEntries:%08D]
[Blank:%-01396C][CRLF]"

Row type by transaction type
Each row type can have an optional AR /AP /RF at the end of the row type for a specific format definition
for that transaction type.  A row type on its own implies a shared format for all transaction types.

EFT first checks for xxAP or xxAR. If it doesn't find it, it uses xx.

(eg HEADERAP or HEADERAR, HEADER) So CAN_CPA has a shared header and footer, but a different
DETAIL for AR and AP.

Example: DetailAR is specific for AR Receipt transaction type, DetailRF is for refund trans-
action and DetailAP is for AP Payment transaction.  Detail applies to all transaction types.

Row Sequence
Each row type also can have multiple lines with a number at the end to indicate the sequence.

For example: Header1, Header2 or DetailAR1, DetailAR2, DetailAR3.
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Additional Row Types
There are additional row types that can be used for the bank format and work in conjunction with the
DETAIL row type to show associated records applied to the original payment entry.  To display it in the
DETAIL regardless of the row types below, use

DETAIL = “[APINVOICES]”

APINVOICE works for any type (Payment or Receipt).

If the format requires a different definition for A/R Receipts A/R Payments, then it can be configured as
APINVOICES_ARRECEIPT

APINVOICE Row for applied AP Documents (Invoice/ CreditNote/ DebitNote/ Prepayment) in
payment entry, repeated for each document.

APINVOICES_
MISCPAYMENT Row of detail of AP Miscellaneous Payment. Only applies to Sage 300

APINVOICES_
ARRECEIPT

Row for applied AR Document in A/R Receipts A/R Payments entry, repeated for
each document.

APINVOICES_
ARREFUND

Row for applied AR Document in refund entry, repeated for each document. Only
applies to Sage 300.

Note: References to Refund or RF is included in some format definition. However, it is not applicable
to Sage Intacct.
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Example: Following is sample of a bank format using variation of row types.

[AUS_OCH]

Name="Australia Orchid Sample Bank"

BSBSize=0:12

AccountSize=0:20

BSBNumber="Bank Swift Code"

AccountNumber="Bank Account Number"

AccountName="Account Name"

BankAPPaymentReference="Payment Reference"

BankARPaymentReference="Receipt Reference "

CustomerPaymentReference="Customer Receipt Reference "

VendorPaymentReference="Vendor Payment Reference"

APINVOICE=”I,[InvoiceNumber:%-12C],[InvoiceDate:DDMMYY],[InvoiceDescription:%-75C],
[InvoiceNetAmount:%15D],[CRLF]"

HeaderAP="H,P[CRLF]"

DetailAP1="P,ACH,[BatchNumber:%08D][EntryNumber:%08D],[BankAccountNumber:%-34C],
[EntryDate:DD/MM/YYYY], [DestRemitName:%-35C],[DestBSB:%-11C],[DestAccountNumber:%-34C],
[Amount:%15D][CRLF]"

DetailAP2="[APINVOICES]"

FooterAP="T,[NumberOfEntries:%05D],[TransactionTotal:%14D]"

FORMAT OF ROW DETAILS
Anything is [brackets] is a field. Anything else is plain text.

Important! A field can start with ! indicating it cannot be blank. During the Create EFT file,
if the particular field doesn’t have value, it will trigger an error.

The Common syntax of a field is:  [fieldname:format]
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The following format is available for conditional format-
ting/checking :

[!field]
Indicates e a value is mandatory for the field.

During Create EFT file, if the particular field doesn’t have value, it will trigger an error.
[#field] if this field is blank then suppress the whole row and the row count is not increased.

^
In the first position of a row

If after including all fields the row is blank, the row will be suppressed and the row count
is not increased.

^r
To remove a special character in the field.

[Field:^r.-35P]. This means any special character to be replace with ‘.’

35P means total number of characters after all replacements is 35 printable.

Field Formatting
The Value of a field can be formatted to be displayed in specific structure.

A format mask is made up of multiple sections.

You can have any number of sections.

There are two types of sections:

1.    Format

       A format section starts with a %

       If the section is left justified then the next character in the mask is a -

       If the section is padded with 0 then the next character in the mask is a 0

       Then comes the size of the field.

       Then comes the type of the field:

A upper case alpha
a mixed case alpha
N upper case alpha-

numeric
n mixed case alpha-

numeric
D numeric
C upper case print-

able
c mixed case print-
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able

   Plain text

       This is just plain text. For example A - then the letter A would be written to the file

Different masks are available for different field types.
ALPHA NUMERIC FORMAT

To format an Alpha or a Numeric field you can apply different masks.

The following masks are available:

1 Indicator Always use %
2 Alignment or

order of value
If the value to be left justified use – character. R to indicate the size of the
value to be evaluated from the right.

3 Zero Padded For numeric value and value that is lesser than the size, it can be pad-
ded with zero.

4 Size Number of characters to be displayed.
5 Type Here are the

A upper case alpha

a mixed case alpha

N upper case alpha-numeric

n mixed case alpha

D numeric

C upper case printable

c mixed case printable
6 Numeric decimal

places and
formats

For type D, it can be formatted with one the following :
• D - numeric (same as D0)
• D0 - numeric (sign, pad, value) only writes sign if it is negative
• D1 - numeric (pad, value, sign) always writes sign
• D2 - numeric (pad, sign, value) only writes sign if it is negative

• For Dx you can add another number to indicate  number of
decimal places. (e.g. D0.2 indicate 2 decimal places with period
as decimal separator)
 - if you omit the period (e.g. D02 vs D0.2) then no decimal point

will be printed
- after D you can have a comma (e.g. D,0) if you want a comma

instead of a period               
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FOR DATE FIELDS, THE FORMAT CAN CONSIST OF:

YYYY The four digit year (eg 2006, 2007)
YY The two digit year (eg 06, 07)
MM The one or two digit month (eg 1, 2, 11, 12,

etc)
DD The two digit day (eg 01, 02, 11, 12, etc)
D The one or two digit day (eg 1, 2, 11, 12, etc)
HH The two digit 24 hour time
H The one or two digit 24 hour time
h The one or two digit 12 hour time
mm The two digit minute
m The one or two digit minute

Example: for January 16 2026:

        YYYYMMDD would be 20260116

        YY/M/D   would be invalid since / is not recognized

[Batchdate:YYYYMMDD][Today:YYMMDD][Today:HHmm]

NUMERIC FORMATTING
            D - numeric (same as D0)

            D0 - numeric (sign, pad, value) only writes sign if it is negative

            D1 - numeric (pad, value, sign) always writes sign

            D2 - numeric (pad, sign, value) only writes sign if it is negative

               - for Dx you can add another number (eg D0.2) which is number of decimal places

               - if you omit the period (eg D02 vs D0.2) then no decimal point will be printed

               - after D you can have a comma (eg D,0) if you want a comma instead of a period

EFT Formats Technical Info Page 201 of 224



Orchid EFT Processing

Example: Sample masks:

%05D Zero-padded, right-
justified, 5 numeric
characters

%24N Right-justified, 24
uppercase alpha-
numeric characters

%-35c Left-justified, 35
mixed case print-
able characters

%3D-%3D Formatted Aus-
tralian BSB ie 999-
999

VALIDATION FUNCTIONS IN EFT FORMATS
For capital letters only: %-10C would convert to uppercase.

For Swift only, ^S-10C would replace illegal characters with a space, and uppercase the rest.

Note: When using ^, the next character can either be a character to replace illegal characters with, 'r'
to remove illegals, 'S' to replace illegal swift characters with a space.

Examples:
Here are some more examples:

"%-10N" + "12345._890" --> NULL

"^ -10N" + "12345._890" --> "12345 890" - replace illegal with space

"^.-10N" + "12345._890" --> "12345..890" - replace illegal with .

"^r-10N" + "12345._890" --> "12345890 " - remove illegals

"^.3D-^.3D" + "123456" --> "123-456" - replace illegal with .

"^.3D-^.3D" + "12A456" --> "12.-456" - replace illegal with .

"^.3D-^.3D" + "12AZZZ" --> "12.-..." - replace illegal with .

"^.3D-^.3D" + "12A4C6" --> "12.-4.6" - replace illegal with .

"^Sc" + "INV[10]" --> "INV 10" - replace illegal swift characters with space

"^Sc" + "INV120111" --> "INV120111" - replace illegal swift characters with space
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FIELDS AVAILABLE IN FILE FORMATS
The following fields are available for inclusion in the formats.

Note: References to Refund or RF is included in some format definition. However, it is not applicable
to Sage Intacct.

Batch information
This applies to the A/P Payment, A/R Refund and A/R Receipt batches. A/P , A/R and Employee Expenses
Payments.

From the batch header:

From the payment:

[BatchNumber]
Batch Number

EFT File ID

[BatchDesc] Batch Description

[BatchCurrency] Currency code selected in batch
header

[BatchDate] The batch date, or the system date,
whichever is later.

[BatchDateJulian] The batch date as a julian number.  Use
for most Canadian banks.

[TrueBatchDate] The real batch date

From the batch entry:

From the payment detail:

[EntryNumber] Entry number.

[EntryDate] Payment date

[EntryDateJulian] Payment date in Julian Format

[Amount] Payment amount in bank's cur-
rency (eg $100.52 is 100.52)

[AmountInCents] Payment amount in bank's cur-
rency in cents (eg $100.52 is
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10052)

[sourceamount] Payment amount in
vendor's/customer's currency

[sourceamountincents]
Payment amount in
vendor's/customer's currency in
cents

[entry.desc]
Batch Entry Number

Payment Memo (Sage Intacct)

[ereference]
Entry Reference

A/P Bill Invoice Reference

Source account information

From EFT Banks:

[BankID] The Bank Code from the Bank Setup
screen.

[BankName] The Bank Name from the Bank Setup
screen.

[BankBSB] The BSB / Branch / Routing number
from the Bank Setup screen.

[BankAccount] The Account Number from the Bank
Setup screen.

[BankAccountName] The Account Name from the Bank
Setup screen.

[BankReference]

A/P Payment Reference from the
EFT Bank screen for A/P Payments
batches or

A/R Receipt Reference from the Bank
Setup screen if an AR batch is being
exported

EFT Bank – Payment Reference field. (It
may have a different label based on the
formats).

[BankExtra1] An extra field which can be turned on
for banks.
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If enabled, you will see a
line: "Extra1=abc" in the formats.ini file

abc will be the field label on the
EFT Bank screen.

[BankExtra2] to
[BankExtra10]

The same method applies to the other
nine extra fields.

From Sage 300 Common Services > Bank Services > Bank

From Cash Management > Account Information

[bank.ccy] The statement currency of the bank code

[bank.transit] Transit Number

[bank.address1]
[bank.address2]
[bank.address3]
[bank.address4]
[bank.city]
[bank.state]
[bank.zip]
[bank.country]

Bank Address details

From Sage 300 Common Services > Company Profile

From Cash Management > Account Information

The field names are self-explanatory: 

[Company.name]
[Company.taxnumber]
[company.brn]
[Company.address1], [Company.address2], [Company.address3], [Company.address4]
[Company.city]
[Company.state]
[Company.zip]
[Company.country]
[Company.phone]
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[Company.fax]
[Company.contactname]
[Company.branch]
[Company.taxnumber]
[Company.brn]
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Destination account information

From EFT Customers or EFT Vendors:

[DestId] Vendor or Customer ID field from the EFT Customers or EFT Vendor screen

[DestShortName] The A/P Vendor short name (APVEN.SHORTNAME) or A/R Customer short
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name (ARCUS.TEXTSNAM)

[DestBankName] The bank name field from the EFT Customers or EFT Vendor screen

[DestBSB] The BSB field from the EFT Customers or EFT Vendor screen

[DestAccount ] The account number field from the EFT Customers or EFT Vendor screen

[DestAccountName] The account name field from the EFT Customers or EFT Vendor screen

[DestIBAN] IBAN from the EFT Vendor or EFT Customer screen

[DestBIC] BIC Code from the EFT Vendor or EFT Customer screen

[DestReference] The reference field from the EFT Customers or EFT Vendor screen

[DestExtra1]

Extra field on EFT Customers or EFT Vendors Setup screen.

If enabled, there is a line in the formats.ini: 

VendorExtra1="abc" or CustomerExtra1="abc"

“abc” is the field name to be displayed in the EFT Customer or EFT Vendor
setup screen.

If writing a custom format, include the lines in the userformats.ini file.

[DestExtra2 ]to
[DestExtra50 ] Same as above

Destination account From A/P Vendor or A/R Customer

[DestName] The A/R Customer Name or A/P Vendor Name

[DestAddress1 ]to [DestAd-
dress4]

The A/R Customer Address lines 1 to 4 or A/P Vendor Address lines
1 to 4

[DestCity] The A/R Customer City or A/P Vendor City

[DestState] The A/R Customer State or A/P Vendor State

[DestPostcode] The A/R Customer Postcode or A/P Vendor Postcode

[DestCountry] The A/R Customer Country or A/P Vendor Country

[DestPhone] The A/R Customer Phone or A/P Vendor Phone

[DestFax] The A/R Customer Fax or A/P Vendor Fax

[DestEmail] The A/R Customer E-mail or A/P Vendor E-mail

[DestContact] The A/R Customer Contact Name or A/P Vendor Contact Name

[DestContactPhone] The A/R Customer Contact Phone or A/P Vendor Contact Phone

[DestContactFax] The A/R Customer Contact Fax or A/P Vendor Contact Fax

[DestContactEmail] The A/R Customer E-Mail or A/P Vendor Contact E-mail
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[Dest.ccy] A/P Vendor or A/R Customer currency code

Destination account information (from Vendor Remit To on the batch
entry):

[DestRemitName] The A/P Vendor Remit-To Name

[DestRemitAddress1]to
[DestRemitAddress4]

The A/P Vendor Remit-To Address lines 1 to 4

[DestRemitCity] The A/P Vendor Remit-To City

[DestRemitState] The A/P Vendor Remit-To State

[DestRemitPostcode] The A/P Vendor Remit-To Postcode

[DestRemitCountry] The A/P Vendor Remit-To Country

[DestRemitPhone] The A/P Vendor Remit-To Phone

[DestRemitFax] The A/P Vendor Remit-To Fax

[DestRemitEmail] The A/P Vendor Remit-To E-mail

[DestRemitContact] The A/P Vendor Remit-To Contact Name

[DestRemitContactPhone] The A/P Vendor Remit-To Contact's phone

[DestRemitContactFax] The A/P Vendor Remit-To Contact's fax

[DestRemitContactEmail] The A/P Vendor Remit-To Contact's e-mail

Applied Document Information:
[InvoiceDate] Applied Document Date

[InvoiceDateDue] Applied Document Invoice Due Date

[InvoiceNumber] Applied Document Number

[InvoiceDescription] Applied Document Description

[InvoiceGrossAmount] Applied Document Gross Amount (prior Discount)

[InvoiceDiscountAmount] Applied Document Discount Amount

[InvoiceNetAmount] Applied Document Net Amount (after discount / payable amount)

[FirstInvoiceNumber] The first applied document number

Miscellaneous:
[Today] The run date
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[Reference] The reference field from Create EFT File screen

[Description ] The description field from Create EFT File screen

[Trans-
actionTotalInCents] The total amount in cents (eg $100.52 is 10052)

[TransactionTotal] The total amount (eg $100.52 is 100.52)

[NumberOfEntries] Number of detail lines so far. This is counted from 1.

[RecordCount] Number of lines so far. This is counted from 1.

[CR] The A/P Vendor Remit-To Fax

[LF] A line feed character

[CRLF] A carriage return / line feed

[Blank] A blank field. Useful for when there are large runs of spaces or 0. Set
the pad length field to the size of the run.

[Today] The run date

[+xD] or  [-xD]
To add or minus number of days to the date field.

Example: [Today+3D] [BatchDate-1D]

[Reference] Reference field from the Create EFT File screen

[Description] Description field from the Create EFT File screen

[Trans-
actionTotalInCents] The total amount in cents (eg $100.52 is 10052)

[TransactionTotal] The total amount (eg $100.52 is 100.52)

[NumberOfEntries] Number of detail lines so far. This is counted from 1.

[RecordCount] Number of lines so far. This is counted from 1.

[CR] A carriage return

[LF] A line feed character

[CRLF] A carriage return / line feed

[Blank] A blank field. Useful for when there are large runs of spaces or 0. Set
the pad length field to the size of the run.

[BCRLF]

A carriage return / line feed will only be inserted if there is already a
record /value in the file.

For formats without a footer row and where the last record must not
have a carriage return, use BCRLF at the beginning of each detail row
instead of placing CRLF at the end of the row.

[FieldIDModifier] Alphabet from A to Z. To indicate a particular batch has been run for
Create EFT file process for the number of time. The first run will have
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‘A’ as indicator, subsequent run ‘B’, ‘C’ and so on.

[InitRecord1Count]..
[InitRecord5Count] To reset record counter to zero. There are 5 record counters available.

[IncRecord1Count ].
[IncRecord5Count]

To include a record count. When a [IncRecordxCount] field is placed
on a row, it will increment by one. 

[GetRecord1Count]..
[GetRecord5Count]

To print the record count number.

[InitAmount1] .. [InitA-
mount5]

To reset amount summary field to zero. There are 5 amount summary
fields available.

[AddAmount1] to [AddA-
mount5]

Use to add the amount to a summary field.

In order to do the summary, the [Amountx]field has to be defined. 

Example:
Amount1="[BankAmount]"

DetailAP="[AddAmount1],[BankAccountNumber],[BatchCurrency],

[Amount],[EntryDate:YYYYMMDD],[DestBankName:%-35C], [DestAc-
countNumber], [DestAccountName:%-35C] [CRLF]”

[GetAmount1] to [GetA-
mount5]

To display or print the Amount summary.

Eg:

Example: Footer="99,[NumberofEntries],[GetAmount1:%D0.2][CRLF]"

[AddAmountY=X]
Eg:

[AddAmount2=1]

To add amount of a “Y” field to the summary of “X”.

Eg. A requirement to add Payor / Account Number with the bene-
ficiary Account Number and display it at the footer as the check digit
for the transfer file.

In the format, declare field Y as an amount field, add it to the sum-
mary and display at the footer.

Amount1="[DestAccount:%010D]"

Amount2="[BankAccountNumber:%010D]"

Detail1="[AddAmount1][AddAmount2=1]01[AmountInCents:%012D]
[BankAccountNumber:%010D][DestAccount:%010D][ CRLF]"

Footer1="99[TransactionTotalInCents:%018D][GetAmount1:%R10C]
[CRLF]"

[EffectiveDate] This date field can be used as active payment date. When the Effect-
iveDate field is used in the format, it will display a date field on Create
EFT screen.
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EffectiveDate entered on the EFT File List.

[SessionDate]
Sage 300 sign on date.

[FILENAME] The actual generated EFT File name

FIELD LABELS ON SETUP SCREENS AND HELPFUL HINTS
Field labels can be renamed in the formats.ini or the userformats.ini file. See EFT Banks Form - Overview
on page 60

Field labels on setup screens

On the formats.ini, the following standard fields can be re-labelled on the screen to use terminology that
is familiar to the users. The standard field names are in bold, and the new label is given in quotes.

BSBNumber="Financial Institution ID/Transit Number"

AccountNumber="Account Number"

AccountName="Account Name"

BankAPPaymentReference="Payment ID"

BankARPaymentReference="Receipt ID"

VendorPaymentReference="Payment Reference"

CustomerPaymentReference="Receipt Reference"

USER DEFINED FIELDS AND FIELD TIPS
User Defined Fields can be configured to include additional information in the file based on the Bank
format specification. Fields are activated in the formats.ini / userformats.ini files.

Tip: Tips can be added to provide information about the field on the Sage 300 EFT Setup
screens where the field values are updated.
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For user defined fields, there are up to 9 extra fields available in the Bank Setup and up to 50 extra fields
available in the EFT Customers Setup or EFT Vendors Setup.

To activate the display on setup screen, declare the field and give it a name.

The syntax for extra field is:  UserDefinedFieldName = "[fieldname:format]"

Eg.

BankExtra1="UserName"

BankExtra2="Password"

VendorExtra1="AccountType (1=Checking, 2=Savings, 3=Transmission)"

CustomerExtra1="AccountType (1=Checking, 2=Savings, 3=Transmission)"

To give a field extra information, we can use a tip.

When a tip is declared on the formats, on screen it will show as hyperlink.

Example: VendorExtra1="Payment"

VendorExtra1Tip="For USA : CCD=Corporate, PPD=Personal, leave blank for CAN"

BankExtra1="Account Qualifier"

BankExtra1Tip="02 - US Settlement Account domiciled in US\r\n04 - Canadian Settlement Account
domiciled in Canada"

BankExtra2="Payment Method Code"

BankExtra2Tip="This can be:\r\n\t01 = Cheque\r\n\t02 = EFT/ACH\r\n\t03 = EDI\r\n\t04 = ERA (Email
or Fax Advice)"

Note: On the Tip there are few predefined keys:

\r\n    To insert a new row for the remaining text after this key. 

\t         To insert a tab for the remaining text after this key.

Example: For example, in a situation where a beneficiary name is allowed for up to 35 char-
acters (on entry screen is up to 60 characters) and no trailing spaces allowed if it is less
than 35 characters, a user defined field can be created to retrieve the 35 characters of
beneficiary name and then used in the row with left aligned and exact length format.

AccName="[DestAccountName:%-35C]"

Header1=""[BankExtra1:%-C]","[BankExtra2:%-C]","[BankExtra3:%-C]","D","1","1"[CRLF]"

Header2=""Batch[BatchNumber:%06D]","[BatchDate:YYYY/MM/DD]"[CRLF]"

Detail1=""[DestID:%-C]","[AccName:%-C]","[DestExtra1:%-C]","[DestBSB:%06D]", "[DestAc-
count:%011D]","[AmountInCents:%-C]"[CRLF]"
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CUSTOM FUNCTIONS

Special Fields
The following special fields can be included in a format.

[CPA005MultiBank] Displays the account number of the source bank from the selected batch range. If
the same bank is used in multiple batches, it will only appear once. Use in the header of the CPA005
format as the settlement account.

[CPA005MultiBankIndex] Displays the Index of the bank  of the source bank from the selected range
of batch. This information to show on detail line and to indicate which settlement account to be used for
the payment.

Switch options
The following codes provide additional options to control how EFT Processing creates the file.

OneFilePerEntry=1 Use this switch to indicate that each entry must go to an individual file.

{entry}Entry Number: Use in conjunction with OneFilePerEntry=1 option.

IsEFT=0 This switch indicates to skip checking whether the vendors/customers are setup in
EFT Processing. This is mainly used for formats that deal with Miscellaneous Receipt/Payment entry that
don’t have Vendor/Customer code.

UTF8=1: Use to indicate characters have to be printed in UTF8. 

AllowMiscellaneousPayments=1: Use this switch to indicate that a vendor with no record in
EFT vendor is allowed in the EFT file (mainly for positive pay)

AllowMiscellaneousRefunds=1 : This switch indicates that a customer that has no record in
EFT customer is allowed in the EFT file (mainly for positive pay)

AllowMiscellaneousReceipts=1 : This switch indicates that a customer that has no record in
EFT customer is allowed in the EFT file.

File naming
Custom field for file naming in EFT Bank Setup:
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Eval fields
There are two functions (Eval and EvalAtEnd) to manipulate the fields read from the database.

EvalAtEnd is done after all the detail records are written.

Within Eval and EvalAtEnd, there are several functions available:

Available functions:

Trim(str) - trims trailing spaces

Join(str, ...) - joins multiple strings together

Left(str, n) - returns the left-most n characters of a string

Right(str, n) - returns the right-most n characters of a string

Space(n) - returns a string of n spaces

Space(n, char) - same as Space but you can specify the character, eg Space(5, "0")

AsciiAdd(str) - adds the ascii value of each character and returns the sum

NumberAdd(str) - adds the numeric value of each character and returns the sum

AddAmount(n, amt) - adds amt to Amountn, returns new amount

GetAmount(n) - returns Amountn

GetAmount(n, prec) - returns Amountn, formatted with prec decimal places

SetAmount(n, amt) - set Amountn to amt, returns amt

GetField(str) - get a field, eg "BankAccountName"

Mul(x,y) – multiplication of x and y

Add(x,y) – Add x and y. The add function adds 2 absolute numbers.

To add negative amount or subtraction, use Lua. See Using Lua in Custom Functions
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Div(x,y) - Divide x with y, DIV(6,2) -> 3 - This function no longer works as part of Eval. Use a
LUA function to divide. Using Lua in Custom Functions

Replace(str,findStr,replaceWith) - eg:Replace("hello world", "world", "Stacy") --> "hello
Stacy"

ReplaceAccents – to replace accent character to latin character.

Example:
DExtra4="[Eval(ReplaceAccents(getfield("DestExtra4"))] "

If the value of DestExtra4 is MARCHé, DExtra4 = MARCHe

Replace(strFind, strValue) – eg. as below :

DetailAP1="[InitRecord3Count]622[DestBSB:%9D][DestAccount:%17C] {TOTALRECORDCOUNT} [CRLF]”

DetailAP2-----23

DetailAP24=”Eval(Replace("{TOTALRECORDCOUNT}",GetField("AddCount")))][CRLF]"

Including a large number of applied invoices in the file

APINVOICES has a limit of 1000 invoices.

If you want to include applied invoices in the file and the number of invoices applied in the payment
entry is more than 1000, use EVAL to bypass the limit.

EVAL(Documents(9999,APINVOICE”)), where 9999 is maximum number of invoices to be
included.

Calculating hash code
To calculate the hash code you could use the following to add the sum into Amount1. The final "" makes
it output nothing.:

Detail1="[Eval(

AddAmount(1,AsciiAdd(Trim(Left(GetField("BankAccountName"), 70))));

AddAmount(1,AsciiAdd(Trim(Left(GetField("BankAccountName"), 70))));

AddAmount(1,NumberAdd(Trim(GetField("BankAccountNumber"))));

AddAmount(1,AsciiAdd(Trim(Left(GetField("BatchCurrency"), 70))));

AddAmount(1,NumberAdd(GetField("Amount")));

"")]"

Note: It would all be one line - separated into multiple lines for readability.

To add the hash into the file you could use:
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Detail2="[EvalAtEnd(SetAmount(2,0);AddAmount(2,GetAmount(1));AddAmount(2,GetField("Num-
berOfEntries"));GetAmount(2, 0))]"

That adds Amount1 and NumberOfEntries together, then prints it with no decimal places.

Special hash code calculations

UOBFieldCheckSummary(hashIndex, value)

Example: Eval(UOBFieldCheckSummary(18, "000000000000120000"))]  produces "8249".

UOBSetPaymentCode(paymentType). paymentType can be 'P', 'R', or 'C'.

This does the same as the first if. It sets amount8 to 20/22/30 (eg 'Eval(GetAmount(8))')

There's also UOBSetHashCode(), which sets amount 9 (eg 'Eval(GetAmount(9))'), and does the same
as the second if.

Encryption formulas
MD5 – returns encryption in MD5 calculation – version 62 onwards

sha256- encryption in SHA256 calculation  - Version 63 onwards

Examples:
[Eval(toBase64(MD5(Trim(GetField("DestExtra1")))))]

[Eval(sha256(Trim(GetField("PayLine"))))]

Nachanines
This is used as the last field in the footer section of the file when a file format needs to be in block of 10
lines.

[NachaNines] is adding lines filled with the character "9" at the end of the file to keep the file in the
block of 10 lines.

For example, If the total number of lines in the file is 8 lines,[ NachaNines] will insert 2 lines of 94 bytes
of ‘9’ characters.
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Example:
This file has 5 lines, the bank requires 10 lines.

NachaNines field adds 5 lines of '9'

FooterAP3="9000001[ACHBlockCount10Div10:%06D][GetRecordCount:%08D][HashTotal:%R010D]
[TransactionTotalInCents:%012D][TransactionTotalInCents:%012D] [CRLF][NachaNines]"

101 026013576113064019 1904151152B094101BANK FOOD INC

5220FOOD INC 1113064019CCD 190415200101 1026013570000001

622987165681210987654348 00000113007200 LEON'S CATERING 0026013570000002

822000000100987165680000000000000000000113001113064019 026013570000001

9000001000001000000010098716568000000000000000000011300

9999999999999999999999999999999999999999999999999999999999999999999999999999999999-
999999999999

9999999999999999999999999999999999999999999999999999999999999999999999999999999999-
999999999999

9999999999999999999999999999999999999999999999999999999999999999999999999999999999-
999999999999

9999999999999999999999999999999999999999999999999999999999999999999999999999999999-
999999999999

9999999999999999999999999999999999999999999999999999999999999999999999999999999999-
999999999999

LUA Functions
In the latest product updates in version 2019 and above, you can use LUA functions if the format uses
RENDER=API.

Refer to Using Lua in Custom Functions
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EFT Format Examples

EFT Format Example 219
EFT Payroll Format Example 221

EFT FORMAT EXAMPLE
The format below includes examples of multiple row types, different row types for different transaction
types as well as various usage of the field formatting masks.
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Example: Format Example : for the USA JP Morgan Chase bank

[USA_JPMC]

Name="JP Morgan Chase"

BSBSize=9

AccountSize=9:17

BSBNumber="R/T Number"

BSBNumberTip="Enter the 9 Digit R/T Number"

AccountNumber="Account Number"

AccountName="Account Name"

BankExtra1="Application ID"

BankExtra2="Remote ID (RID)"

BankExtra3="File ID"

BankExtra4="Company ID"

BankAPPaymentReference="A/P Payment Reference"

BankARPaymentReference="A/R Receipt Reference"

CustomerPaymentReference="Payment Reference"

CustomerPaymentReferenceTip="Enter the Payment Reference to be sent to the customer"

VendorPaymentReference="Payment Reference"

VendorPaymentReferenceTip="Enter the Payment Reference to be sent to the vendor"

HeaderAR1="LOGDX2010270388TB1TX00317*CH04000000000CTXC3173C0000000000000000[CRLF]"

HeaderAR2="101 [SourceBSB:%9D][SourceExtra3:%010D][Today:YYMMDD]
[Today:HHMM]1094101JPMORGAN CHASE [SourceAccountName:%-23C] [CRLF]"

HeaderAR3="5225[SourceAccountName:%-16C] [SourceExtra4:%-10C]PPD[Description:%-
10C] [BatchDate:YYMMDD]   1[SourceBSB:%8D]0000001[CRLF]"

HeaderAP1="LOGDX2010270388TB1TX00317*CH04000000000CTXC3173C0000000000000000[CRLF]"

HeaderAP2="101 [SourceBSB:%9D][SourceExtra3:%010D][Today:YYMMDD]
[Today:HHMM]1094101JPMORGAN CHASE [SourceAccountName:%-23C] [CRLF]"

HeaderAP3="5200[SourceAccountName:%-16C] [SourceExtra4:%-10C]PPD[Description:%-
10C] [BatchDate:YYMMDD]   1[SourceBSB:%8D]0000001[CRLF]"

Detail="6[DestReference:%2D][DestBSB:%9D][DestAccount:%-17C][AmountInCents:%010D][DestId:%-
15C][DestAccountName:%-22C]  0[SourceBSB:%8D][BatchNumber:%07D][CRLF]"

FooterAR1="8225[NumberOfEntries:%06D][WellsFargoHashTotal:%010D]000000000000[Trans-
actionTotalInCents:%012D][SourceExtra4:%-10C] [SourceBSB:%8D]0000001[CRLF]"
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FooterAR2="9000001000001[NumberOfEntries:%08D][WellsFargoHashTotal:%010D]000000000000
[TransactionTotalInCents:%012D] [CRLF]"

FooterAP1="8200[NumberOfEntries:%06D][WellsFargoHashTotal:%010D]000000000000[Trans-
actionTotalInCents:%012D][SourceExtra4:%-10C] [SourceBSB:%8D]0000001[CRLF]"

FooterAP2="9000001000001[NumberOfEntries:%08D][WellsFargoHashTotal:%010D]000000000000
[TransactionTotalInCents:%012D] [CRLF]"

EFT PAYROLL FORMAT EXAMPLE
The format below includes examples of variables to be used in EFT Payroll formats.

XPEMPL: Either CPEMPL if using Canadian Payroll or UPEMPL if using US Payroll.

CHK: Either CPCHKH if using Canadian Payroll or UPCHKH if using US Payroll

ELEMPH: EFT Employees header fields.

ELEMPD: EFT Employee detail file.

Example:
XPEMPL.LASTNAME to add theEmployee surname

ELEMPH.IDEMP for the employee ID

ELEMPD.PAYREF for payment reference
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